
Read the instruction manual thoroughly before you use the product.

Keep this instruction manual for future reference.

292-28464D
NOV. 2008

Microchip Electrophoresis System

for DNA/RNA Analysis

MCE-202 MultiNA 

Instruction Manual
- Operating Procedure -



This page is intentionally left blank.



Operating Procedure   i

MultiNA® and MCE® are registered trademarks of Shimadzu Corporation.

SYBR® is a registered trademark of Invitrogen Corporation.

pGEM® is a registered trademark of Promega Corporation.

MicroAmp® and RNaseZAP® are registered trademarks of Applied Biosystems Inc.

Thermo-Fast® is a registered trademark of Advanced Biotechnologies Ltd.

Intel® and Pentium® are registered trademarks of Intel Corporation.

BEMCOT® is a registered trademark of Asahi Kasei Fibers Corporation.

Windows is the registered trademark of Microsoft Corporation USA, (USA) and in all other countries.

Adobe, Acrobat and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation.

All brand names and product names are trademarks or registered trademarks of their respective companies

Microsoft® Windows®XP Professional operating system is written as Windows XP.

© 2007-2008 Shimadzu Corporation. All rights reserved.

< Notice>
Copyright of this manual is owned by Shimadzu Corporation. Reproduction or duplication of the content, in whole or part, 
without permission of the company is strictly prohibited.
For the sake of improvement, the content of this manual is subject to modifications without notice.
Every effort has been made to ensure that the content of this manual was correct at the time of creation. However, in the 
event that any mistakes or omissions are discovered, it may not be possible to correct them immediately.
The contents of the hard disk in a PC can be lost due to an accident. Backup your data, to protect your important data from 
accidents.

To ensure the safe use of this product:
Follow all procedures described in these instruction manuals.

Follow all WARNING and CAUTION instructions.

Do NOT disassemble or modify this product without permission from Shimadzu 
Corporation.

Please contact your Shimadzu representative for product service and repairs.
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Thank you for purchasing the MCE-202 MultiNA microchip electrophoresis system for DNA/RNA analysis (hereafter 
“MultiNA”).

Important:
• Read this manual thoroughly prior to operating this product.
• Keep this manual near the product in a safe location for future reference.
• Operate this product in accordance with the instructions given in this manual.
• Follow all WARNING and CAUTION instructions.
• For information on the basic operation of the Windows® operating system, please refer to that product's 

Instruction Manuals. 
• Do NOT disassemble or modify this product without permission from Shimadzu Corporation.
• Ensure that these instruction manuals are transferred if the user or site of use changes.
• Contact your Shimadzu representative if the following is required:

- Replacement of this manual, or any WARNING or CAUTION labels
- Product installation, adjustment, or re-installation after product movement, or for service and repairs

This product's Instruction Manual is provided in two separate volumes. Each volume contains the following sections:
Instruction Manual, Instrument and System

• Equipment Overview
• Parts Specifications
• Names and Functions of Each Part
• Operating Principles
• Installation Procedures
• Instrument Maintenance
• Moving and Storing the Instrument
• Specifications
• Error Diagnosis and Corrective Measures
• Maintenance Parts

Instruction Manual, Operating Procedure
• Outline of operation
• MultiNA Instrument Control Software Functions
• MultiNA Viewer Data Analysis Software Functions

Introduction
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Shimadzu provides the following warranty for this product.

* If there is a document such as a warranty provided with the product, or there is a separate contract agreed upon that includes warranty 
conditions, the provisions of those documents shall apply.

* Warranty periods for products with special specifications and systems are provided separately.

Warranty

1. Period: Please contact your Shimadzu representative for information about the period of this 
warranty.

2. Description: If a product/part failure occurs for reasons attributable to Shimadzu during the warranty 
period, Shimadzu will repair or replace the product/part free of charge. However, in the case 
of products which are usually available on the market only for a short time, such as personal 
computers and their peripherals/parts, Shimadzu may not be able to provide identical 
replacement products.

3. Exceptions: Failures caused by the following are excluded from the warranty, even if they occur during 
the warranty period.

1) Improper product handling

2) Repairs or modifications performed by parties other than Shimadzu or Shimadzu designated 
companies

3) Product use in combination with hardware or software other than that designated by 
Shimadzu

4) Computer viruses leading to device failures and damage to data and software, including the 
product's basic software

5) Power failures, including power outages and sudden voltage drops, leading to device failures 
and damage to data and software, including the product's basic software

6) Turning OFF the product without following the proper shutdown procedure leading to device 
failures and damage to data and software, including the product's basic software

7) Reasons unrelated to the product itself

8) Product use in harsh environments, such as those subject to high temperature or humidity 
levels, corrosive gases, or strong vibrations

9) Fires, earthquakes, or any other act of nature, contamination by radioactive or hazardous 
substances, or any other force majeure event, including wars, riots, and crimes

10)Product movement or transportation after installation

11) Consumable items
Note: Recording media such as floppy disks and CD-ROMs are considered consumable items.

4. Non-Research 
Applications:

This instrument should be used only for research applications. It should NOT be used for 
diagnosis or examination purposes. If this instrument is used for non-research applications, 
Shimadzu Corporation is in no way responsible for any problems related to the instrument, 
its data, claims from third parties, or any other problems that occur.
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After-Sales Service
If a problem arises, inspect the product and take the appropriate corrective action described in -Instrument and 
System- "6 Instrument Maintenance" and "9 Error Diagnosis and Corrective Measures". If the problem persists or the 
symptoms are not covered in these chapters, contact your Shimadzu representative.

Replacement Parts Availability
Replacement parts for this product will be available for a period of seven (7) years after the product is discontinued. 
Thereafter, such parts may cease to be available. Note, however, that the availability of parts not manufactured by 
Shimadzu shall be determined by the relevant manufacturers.

After-Sales Service and Availability of Replacement Parts
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PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THE SOFTWARE. 

SHIMADZU Corporation (“SMZ”) is willing to license the SMZ software provided herein, together with accompanying documentation (collectively “SOFTWARE”) to you only upon the 
condition that you accept all of the terms and conditions contained in this License Agreement. By using the SOFTWARE, you agree to be bound by the terms of this Agreement. If you do 
NOT agree to all these terms of this Agreement, promptly return the unused SOFTWARE to the party (either SMZ or its reseller) from whom you acquired it to receive a refund of the 
amount you paid.

1. LICENSE
SMZ grants you a non-exclusive and nontransferable license to use the SOFTWARE subject to the following terms and conditions.

2. LIMITATION OF USE
Except as specifically authorized by SMZ, you may NOT:

a.Use the SOFTWARE, or permit the SOFTWARE to be used, on the computer authorized by SMZ.

b.Copy the SOFTWARE except one (1) archival copy of the SOFTWARE.

c.Modify, reverse engineer, decompile, disassemble, or create derivative works based upon the SOFTWARE.

d.Transfer, rent, lease or grant any rights in the SOFTWARE in any form to anyone else.

3. TITLE AND OWNERSHIP
This license is not for sale and it may not be assigned or sublicensed to anyone else. Title and all associated intellectual property rights to the SOFTWARE shall remain in SMZ and/or its 
licensor.

4. UPGRADES
You are entitled to receive all official software upgrades for the SOFTWARE that SMZ will release as deemed necessary by SMZ. An upgrade means certain supplemental program 
modules and/or information for bug fixing and/or updates to the defects and/or failures of the SOFTWARE that are acknowledged or confirmed by SMZ. An upgrade excludes hardware, 
network, consulting services, third party products, operation and general computer system maintenance. All supplemental program module for upgrades and enhancements furnished to 
you shall be deemed to be part of the SOFTWARE and subject to the terms and conditions set forth in this Agreement.

5. LIMITED WARRANTY
SMZ warrants that for a period of one (1) year from the date of purchase, as evidenced by a copy of the receipt, the media on which SOFTWARE is furnished will be free of defects in 
materials and workmanship under normal use. 

Except for the foregoing, SOFTWARE is provided AS IS. Your exclusive remedy and the entire liability of SMZ and its suppliers under this limited warranty will be, at SMZ's option, repair, 
replacement, or refund of the Software if reported (or, upon request, returned) to the party supplying the SOFTWARE to you. In no event does SMZ warrant that the Software is error free 
or that you will be able to operate the SOFTWARE without problems or interruptions.

EXCEPT AS SPECIFIED IN THIS WARRANTY, ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS, AND WARRANTIES INCLUDING, WITHOUT LIMITATION, ANY 
IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT, ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE 
PRACTICE, ARE HEREBY EXCLUDED TO THE EXTENT ALLOWED BY APPLICABLE LAW. 

6. LIMITATION OF LIABILITY
IN NO EVENT WILL SMZ BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTIAL OR PUNITIVE DAMAGES, 
HOWEVER CAUSED REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF OR RELATED TO THE USE OF OR INABILITY TO USE SOFTWARE, EVEN IF SMZ HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. IN NO EVENT WILL SMZ'S LIABILITY TO YOU, WHETHER IN CONTRACT, TORT (INCLUDING NEGRIGENCE), OR 
OTHERWISE, EXCEED THE AMOUNT YOU PAID FOR SOFTWARE.

7. TERMINATION
This License is effective until terminated. You may terminate this License at any time by destroying all copies of SOFTWARE including any documentation. This License will terminate 
immediately without notice from SMZ if you fail to comply with any provision of this License. Upon termination, you must destroy all copies of SOFTWARE.

8. GENERAL
a.This Agreement is the entire agreement. If any provision of this agreement is held invalid, the remainder of this agreement shall continue in full force and effect.

b.This Agreement shall be construed and governed in accordance with the laws of Japan, excluding its conflict of law rules.

c.The exclusive jurisdiction for any disputes arising out of or in connection with this Agreement shall be Kyoto District Court of Japan.

d.The invalidity or unenforceability of any provision of this Agreement shall not affect the validity or enforceability of any other provision.

Software License Agreement
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The following manuals are provided.

The following symbols are used in this manual.

Instruction Manuals

List of Instruction Manuals

Name Media Description

Instrument and System Booklet + PDF Describes the complete MultiNA system, including handling, 
operation, maintenance, and troubleshooting.

Operating Procedure Booklet + PDF Describes data acquisition and analysis procedures, including 
preparation of reagents and samples, software operation 
procedures, and others.

Help Online Help Click [Help] on the menu bar to access Online Help data (PDF 
versions of manuals).

Manual Notation

Symbol Meaning

! DANGER Indicates an imminently hazardous situation which, if not avoided, will result in serious injury or death.

! WARNING Indicates a potentially hazardous situation which, if not avoided, could result in serious injury or possibly 
death.

! CAUTION Indicates a potentially hazardous situation which, if not avoided, can result in minor to moderate injury or 
equipment damage.

@ NOTE Provides additional information to ensure proper use of this product.

^ Reference Indicates location of related information.

[ ] Indicates text displayed on the screen, such as the names of buttons, menu items, settings, screens, and 
icons.
Example: Click [OK] (where “OK” is the name of a button in a dialog box)

[V1.05] Indicates a function added or changed in the software V.1.05 or later.
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To ensure safe product operation, read these important safety instructions carefully before use and follow all 
WARNING and CAUTION instructions given in this section.

Product Applications

Installation Site

Safety Instructions

! WARNING

• This is a microchip electrophoresis system for DNA/RNA analysis. Do NOT use it for any other 
application.
Doing so may result in accidents.

• This instrument should be used only for research applications. 
It should NOT be used for diagnosis or examination purposes. If this instrument is used for non-research 
applications, Shimadzu Corporation is in no way responsible for any problems related to the instrument, its data, 
claims from third parties, or any other problems that occur.

! WARNING

• Fire is prohibited in the vicinity of the instrument.
Fire must not be used at the site where the instrument is installed. In addition, avoid installation in the same 
room with equipment that generates sparks. Do not use flammable sprays (such as hairsprays or aerosol 
insecticides) or flammable solvents in the vicinity of this instrument. Provide fire extinguishers in case of an 
emergency.

• Install a sink in the vicinity of this instrument.
If reagent chemicals come in contact with the eyes or skin during operation, flush them away immediately with a 
large quantity of water. A sink should be installed in the vicinity of this equipment if at all possible.
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! CAUTION

• Installation of the instrument is prohibited at sites exposed to corrosive gases, or to significant debris 
and dust.
To ensure the life of the instrument and to maintain proper operation, avoid installation sites that are exposed to 
corrosive gases or to significant dust or debris.

• Do NOT install the instrument near equipment that generates strong magnetic fields.
To ensure normal operation of this instrument, avoid installation sites that are subject to strong magnetic fields. 
Add noise filters if there is significant noise on the power lines.

• To maintain performance, observe the following site conditions.
• Rooms with an ambient temperature between 18°C and 28°C, and minimal daily temperature fluctuations

(If the ambient temperature exceeds 28°C, a temperature control error can occur and instrument operation 
may stop.)

• Sites where the instrument is protected from direct exposure to drafts from coolers, heaters or air 
conditioners

• Sites protected from exposure to direct sunlight
• Sites not exposed to vibrations
• Sites where humidity is maintained between 40% and 80%
• Sites where condensation does not occur

• During analysis, ensure that the drain tubing ports and the gap between the top cover and the 
instrument are not exposed to direct light sources (such as desktop fluorescent lamps, flashlights, 
and camera flashes).
This may result in noise.

• Prior to installing and/or using the product in an industrial location:
• Install the product away from devices generating strong electromagnetic fields.
• Supply power from a separate power source.
• Take countermeasures to prevent static electricity buildup.
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Installation

! WARNING

• For safe instrument operation, after the instrument is moved to a different location, contact your 
Shimadzu representative for instrument installation, adjustment, or reinstallation.

• The instrument’s power supply voltage and power consumption are as follows. The power supply 
voltage is indicated on the label on the power connector on the back of the instrument. Connect the 
instrument to a suitable power source.
Connecting it to an improper power source may result in fires or shocks.
The intended performance may not be obtained if the power supply voltage is unstable or the power capacity is 
insufficient. Check the power requirements for the entire system before arranging a suitable power source.

• Ground the instrument.
If malfunctions or leakages occur, shocks may result if the equipment is not properly grounded. Grounding is 
also important to ensure stable instrument operations.

• Do NOT insert or touch the adaptor ground lead to the power outlet. 
This may result in fires or electric shocks.

•  Handle the power cable carefully.
If the following cautions are not observed, the cable may be damaged, resulting in fires, electric shocks, or 
malfunctions. If the cord does become damaged, contact your Shimadzu service representative immediately.

• Do NOT place it under heavy objects.
• Do NOT place it near heating equipment.
• Do NOT modify the cord.
• Do NOT forcibly bend or stretch the cord.
• Hold the plug when inserting and removing the cord.

Part No. Voltage (indicated on the instrument 
faceplate)

Power 
Consumption Frequency

292-28000-31 100-120/220-240 V 300 VA 50/60 Hz
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Operation

! CAUTION

• This instrument weighs 43 kg. When installing the system, consider the total system weight including 
the PC and other system components.
Install the instrument on a flat, stable desk or stand, capable of supporting the total system weight.

• Install on a flat desk or stand.
If the instrument is significantly inclined, the analysis performance will be adversely affected.

• Installation space for the instrument, PC, and glass rinse water bottle must be at least 1,015 mm to 
1,165 mm W (if a desktop PC is used) by 600 mm D by 980 mm H.
(See -Instrument and System- " Example Installation 1: Waste container positioned in front of the instrument".)
This does not include the waste container which is placed on the floor. The size displays the maximum height 
with the cover open.

•  When installing the instrument against a wall, leave a gap of at least 50 mm between the rear of the 
instrument and the wall.
If this condition is not met, fan-driven air cooling will not be sufficient and the instrument may overheat and 
reduce performance. Also the top cover will not fully open.

• Install the instrument at a site where the rear of the instrument can be accessed easily.
The syringe cover on the rear of the instrument must be opened when replacing the syringe or plunger.

• Allow at least a 100 mm of space in front of the instrument.
The front cover must be opened to replace the pump cartridges.

• When installing the instrument, leave enough space to operate the power switch on the bottom right 
side of the instrument near the rear. 
The power must be turned OFF quickly in the event of an instrument or other emergencies.The power must be 
turned OFF quickly in the event of a problem with the instrument or other emergency.

• Place the waste fluid container on the floor.
Waste fluid is conveyed to the waste container by gravity. Place the container at a position lower than the 
instrument.

• Note the following cautions regarding the waste tubing. Cut the tubing as necessary to suit the 
installation site.

• The tubing should not be bent.
• The tubing should not be elevated.
• The tip of the tubing should not be immersed in the waste fluid inside the waste container.

• If necessary, install safety fasteners and other earthquake measures.
Recommended product: Part No. 037-62401-03, FASTENER, RT-400 GRAY (set of two)

! WARNING

• Wear protective glasses and gloves and a lab coat or work clothes.
Use of this instrument involves the handling of reagents that contain irritating or hazardous chemical 
substances. If a chemical substance, such as a reagent, gets into eyes or contacts skin, immediately wash the 
area with a large amount of water and consult a medical professional.
If a chemical substance is accidentally swallowed or chemical vapors are inhaled, immediately consult a medical 
professional.
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Top Cover Usage

Drive Unit

Replacing Parts and Daily Maintenance

! WARNING

• Do NOT forcibly open the top cover during instrument operation (blinking green LED on front 
indicator).
During operation the top cover is locked and cannot be opened.

• Do NOT apply lateral force to the top cover when opening or closing.
This may deform the top cover and result in damage.

• Do NOT remove the top cover.
Injuries or accidents may occur.

• If the top cover does not open or close properly, contact your Shimadzu service representative 
immediately.
A technician from Shimadzu will perform repairs.

! WARNING

• Do NOT touch any parts other than those specified in these manuals.
 

! WARNING

• Turn the instrument OFF before maintenance or parts replacement.
Shocks or accidents may occur.

• Internal repairs are performed by certified Shimadzu technicians.
Contact your Shimadzu service representative.

• Do NOT perform any disassembly or modification procedures that are not described in these 
manuals.
Injuries or accidents may occur.
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Emergency Measures

! CAUTION

• Use only the parts described in -Instrument and System- "2 Parts Specifications" or "10 Maintenance 
Parts".
Normal operations are not ensured if other parts are used.

• Do NOT leave the instrument wet.
This may result in rust or discoloration. To clean the instrument, wipe it with a soft cloth moistened slightly with 
water. Then remove any moisture with a soft dry cloth.

• Do NOT wipe it with alcohol, paint thinner or other organic solvents.
These solvents may damage the paint on the instrument cover.

• Dispose of the waste fluid in accordance with guidelines from the applicable management 
departments.
In addition to rinse water, the waste liquid contains separation buffer, marker solution, and dyes. It will also 
contain formamide from RNA analysis.

! WARNING

• If a strange noise or smell emanates from the instrument, or some other irregularity is noticed, stop 
instrument operation using the following procedure, and contact your Shimadzu service 
representative.

• Switch OFF the power switch on the lower right side of the product.
• Detach the power cable.

Power switch

Front
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During a Power Outage

Microchip Use

! CAUTION

• If an electric power outage occurs during analysis, the instrument stops. If separation buffer is left 
remaining in a microchip or sample probe when the instrument stops it may dry out and obstruct the 
microchip or sample probe. To avoid such a condition, take the action described below.  
1. Turn OFF the power of the instrument.
2. When the electric power comes back on, turn ON the instrument. If the power of the PC is OFF, turn it ON. 
3. Rinse the microchip with water according to the procedure described in -Instrument and System- "6.2.7 

Microchip Reservoirs" and reinstall it in the instrument.  
4. Rinse the sample probe according to the procedure described in -Instrument and System- "6.2.2 Sample 

Probe".
5. Check if the sample probe is obstructed according to the procedure described in -Instrument and System- 

"6.4.4 Plunger Replacement Inspection".
6. Rinse all microchips installed in the instrument according to the procedure described in "All Chip Washing" in 

"2.5.8 Wash" P.126.

Carrying out the procedure above enables regular operation. In case of any abnormal condition, see -Instrument 
and System- "9 Error Diagnosis and Corrective Measures" and take actions accordingly.   
In MultiNA, results of analysis for each sample are saved in data files during analysis of multiple samples. 
Therefore, even if analysis is stopped due to a power outage during analysis, results of analyses up to right 
before the power outage are saved in files.

@ NOTE
• Files may not be normally created on rare occasions, for example, when the PC stops during a process to 

save data in a file.

! CAUTION

• Do NOT scrub the reservoir on the microchip when wiping away moisture.
Lint may clog the microchip channels.

• Do NOT touch the surfaces of the microchip with your bare hands.

• Do NOT scratch the microchip electrodes during handling.
If salt or other material has hardened on the electrodes, apply water to dissolve the salt and then gently wipe it 
away.

• Do NOT clean the microchip using an ultrasonic cleaner.
This will damage the microchip.
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Reagent Kit Use

Relocating the Product

If MultiNA is idle in a cold environment for an extended period

! WARNING

• The reagent kit provided with this instrument is only for experimental and research purposes.
It is not authorized for the diagnosis and treatment of human or animal illnesses. Do NOT use it for any 
applications that directly affect human or animal bodies, such as with medical products, cosmetics, or foods.

• If reagent gets into the eyes or contacts the skin, immediately wash the applicable area with copious 
amounts of water and consult a medical professional. If reagent is accidentally swallowed or the 
vapor is inhaled, immediately consult a medical professional.
Refer to the MSDS for details.

• Use only the reagents specified in these instruction manuals.

! CAUTION

• Before moving the instrument, the drives must be fastened with the transportation fixtures.
Contact your Shimadzu service representative.

• Unplug the LAN cable connected to the PC.

• Do NOT lift the instrument by the top cover.

• Do NOT pinch fingers or hands in gaps inside the product.

• Do NOT bump the instrument or subject it to excessive vibrations.

! CAUTION

• If this instrument is idle for an extended period of time in a cold environment, a robotics drive-system 
error may occur (home position detection error).
This error can be prevented by first warming the robotics drive-system before starting operation.
Follow the procedures described below if the instrument has been idle in a cold environment. If the error 
continues, contact your Shimadzu service representative.

• Warm procedure
1. Turn ON the instrument.
2. Start the control software, and confirm that the instrument and PC are connected.
3. Select [Move All Axes to Home Position] on the [Instrument] pull-down menu.
4. Wait for 30 minutes, with the top cover closed.
5. After 30 minutes, operate the instrument as usual.
If the error continues, wait another 30 minutes before starting the instrument.
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For safety, warning labels are attached in locations where special attention is required.
Should any of these labels peel off or become damaged, contact your Shimadzu representative immediately for a 
replacement.

Warning Labels

• Indicates a high temperature area.

• Refer to the Instruction Manual before performing operations in this area.

• Fuses
Before fuse replacement, refer to -Instrument and System- "6.4 Part Replacement and Inspection".
Warning label: Part No. 228-42603
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• Autosampler Motor Unit
CAUTION: HOT! Touching while hot can result in burn.
Warning label: Part No. 037-72999-12

• Chip Stage
The chip stage is kept at 37°C. During microchip replacement, prolonged contact with chip stage 
can result in a low-temperature burn.
Warning label: Part No. 037-72123-00 (Japanese)/037-72126-02 (English)
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• Class 1 LED Product
This is a Class 1 LED Product.
Warning label: Part No. 292-27990

• Autosampler Cover
Do NOT remove or disassemble any part of the cover, except where specified in the Instruction 
Manual.
Warning label: Part No. 037-72999-02, 292-27778-07
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Descriptions in this section apply only to the following models: 
• 292-28000-38 MULTINA SYSTEM ASSY (230VAC, English)

This product complies with European standard EN61326: 1997 + amendment 1: 1998 + amendment 2: 2001 + 
amendment 3: 2003, class B for electromagnetic interference (Emissions) and minimum requirement for 
electromagnetic susceptibility (Immunity).

EN61326-1 Immunity (Electromagnetic Susceptibility)
Test conditions are as follows.

• IEC 61000-4-2 Electrostatic Discharge: 
Air: 2/ 4/ 8 kV, Contact: 2/ 4 kV

• IEC 61000-4-3 Radiated, Radio-Frequency, Electromagnetic Field: 
3 V/m 

• IEC 61000-4-4 Transient/Burst (Electrical Fast Transients): 
2 kV on AC Power Port, 0.5/ 1 kV on Signal and Control Lines

• IEC 61000-4-5 Voltage Surge: 
0.5/ 1 kV line to line, 0.5/ 1/ 2 kV line to ground

• IEC 61000-4-6 Conducted RF Immunity: 
3 V on AC Power Port, 3 V on Signal and Control Lines

• IEC 61000-4-8 Power Frequency Magnetic Field: 
30 A/m, 50 Hz

• IEC 61000-4-11 Voltage Variations/Dips/Interrupts: 
100% drop for 0.5/ 1 cycle

Compliance with these standards does not ensure that the product can operate at a level of electromagnetic 
interference that is stronger than the level tested. Interference stronger than the values specified above may cause 
the product to malfunction.

When installing or using this product, especially in an industrial location:
Locate the product away from any device emitting strong levels of electromagnetic noise.
Use a power source that is separated from the power source of any device emitting strong levels of 
electromagnetic noise.

To prevent static electricity:
Prior to touching the product, the operator should be sure to discharge the static electricity stored in their body by 
first touching a grounded metallic structure.
Do not touch any terminals or connectors that are not connected to cables while the product is turned ON.

Electromagnetic Compatibility
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For Europe:
The product complies with the following requirements.

EMC Directive 89/336/EEC
Low Voltage Directive 2006/95/EC

Product Name Microchip Electrophoresis System for DNA/RNA Analysis

Model Name MCE-202 MultiNA

Manufacturer SHIMADZU CORPORATION
ANALYTICAL & MEASURING INSTRUMENTS DIVISION

Address 1 NISHINOKYO-KUWABARACHO
NAKAGYO-KU KYOTO 604-8511 JAPAN

Authorized 
Representative in EU Shimadzu Europa GmbH
Address Albert-Hahn-Strasse 6-10, 47269 Duisburg, F.R. Germany

Regulatory Information
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To all users of Shimadzu equipment in the European Union:
Equipment marked with this symbol was sold on or after 13th August 2005, and should not be 
disposed of with general household waste.
Our equipment is for industrial/professional use only.

        WEEE Mark

Contact a Shimadzu service representative when the equipment is ready for disposal. They will advise you 
regarding the equipment take-back procedures.

With your co-operation we are aiming to reduce contamination from electronic waste and preserve natural 
resources through re-use and recycling.
Do not hesitate to ask a Shimadzu service representative, if you require further information.

Action for Environment
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1Outline of Operation

1.1 Operations Flow
This section describes the normal analysis operation flow. See the corresponding pages in this manual for 
details of each operations step. 

Use the Analysis Operation Flow (P.2) as a “quick manual”. We recommend copying it to both sides of a 
sheet of paper.
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Analysis Operation Flow (For details, see the MultiNA Instruction Manual, Operating Procedure pages.)

Determine the marker mixing method.
("1.4 Mixing the Marker Solution" P.8)

Start up the instrument, PC, and software. 
("1.3 Instrument Startup and Shutdown" P.4)

Set the rinse water in the glass rinse water bottle. 
("1.5.1 Filling the Rinse Water" P.9)

[1. Starting Up the Instrument and PC]

[2. Registering the Analysis Schedule]

Check that the microchip is set. If not set, set it as per "1.5.4 
Microchip Registration" P.13. Next, select the microchip to be used.

Check that the waste fluid container is empty, and set the instrument's waste fluid tube.
("1.5.2 Setting the Waste Fluid Container" P.10)

No

Prepare the reagent kit, ladder, and dye, etc., for the sample to be analyzed. 
• DNA (25 bp to 500 bp): DNA-500 kit "1.6.1 Requirements" P.32
• DNA (100 bp to 1000 bp):DNA-1000 kit "1.7.1 Requirements" P.40
• DNA (100 bp to 2500 bp):DNA-2500 kit "1.8.1 Requirements" P.48
• RNA: RNA kit "1.9.1 Requirements" P.56

Has the method for mixing the marker solution been determined, between “On-
chip mix” or “Premix”? (Note: RNA analysis is “Premix” only.)

Has the project to be used already been prepared? 
("1.5.7 Project Creation" P.21)

Prepare the project.
("1.5.7 Project Creation" P.21)

Yes

No

Yes

Select the project. ("1.5.9 Creating a Sample Sheet and 
Entering It into an Analysis Schedule" P.26)

Prepare a sample sheet. ("1.5.9 Creating a Sample Sheet and 
Entering It into an Analysis Schedule" P.26)

By repeating the procedure, you can register multiple 
sample sheets in a single analysis schedule (up to 120 
analyses). ("2.2.2 Add" P.101)

Register the sample sheet in the analysis schedule. The required 
reagent amount is displayed in [Reagent information]. ("1.5.9 Creating 
a Sample Sheet and Entering It into an Analysis Schedule" P.26)
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[3. Preparing the Reagent]

Prepare the diluted dye solution.
DNA-500: "1.6.3 Diluted Dye Solution Preparation" P.34
DNA-1000: "1.7.3 Diluted Dye Solution Preparation" P.43
DNA-2500: "1.8.3 Diluted Dye Solution Preparation" P.51
RNA: "1.9.3 Diluted Dye Solution Preparation" P.59

Prepare the ladder solution.
DNA-500: "1.6.4 Ladder Solution Preparation" P.35
DNA-1000: "1.7.4 Ladder Solution Preparation" P.43
DNA-2500: "1.8.4 Ladder Solution Preparation" P.51
RNA: "1.9.4 Ladder Solution Preparation" P.59

Dispense the separation buffer into the bottle, mix in the diluted dye solution, and set the container in the reagent holder. 
DNA-500: "1.6.5 Separation Buffer Preparation" P.36
DNA-1000: "1.7.5 Separation Buffer Preparation" P.44
DNA-2500: "1.8.5 Separation Buffer Preparation" P.52
RNA: "1.9.5 Separation Buffer Preparation" P.60

[4. Setting the Reagent and Sample]

Set the ladder or sample, and marker solution. The setting method will vary depending on the method used for mixing 
the marker solution (premix or on-chip mix). 
DNA-500: "1.6.6 Ladder, Sample and Marker Solution Usage" P.38
DNA-1000: "1.7.6 Ladder, Sample, and Marker Solution Usage" P.46
DNA-2500: "1.8.6 Ladder, Sample and Marker Solution Usage" P.54
RNA: "1.9.6 Ladder, Sample and Marker Solution Usage" P.62

Set the tube (or sample plate) containing the ladder or sample into the instrument. 
Set the sample holder from above, and then close the top cover.
("1.10.1 Sample Holder Installation" P.64)

[5. Starting the Analysis]
Start the analysis. ("1.10.2 
Starting the Analysis" P.66)

[6. Data Analysis]
Has the analysis been completed normally? 

Yes If an error message is displayed, follow 
the procedures in -Instrument and 
System- "9.2 Error Messages".

No

Run the data analysis software MultiNA Viewer and display the data. 
("1.11.1 Displaying the Data" P.71)

Does the detected peak show the size prediction and 
quantitation? ("1.11.2 Data Examination and Reanalysis" P.73)

No

Perform the post-analysis processing. ("1.10.5 
Treatment after Analysis End" P.69)

If the data is not acceptable, see -Instrument 
and System- "9.1 Troubleshooting". 
For reanalysis of the data, see "1.11.2 Data 
Examination and Reanalysis" P.73.

Yes
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1.2 Software Related to MultiNA
PCs prepared as shown in -Instrument and System- "5.5 Software Installation" will have two kinds of 
MultiNA-related software installed.

“MultiNA Control Software” is used to control the instrument. For details about using this software, 
see "2 MultiNA Control Software Functions" P.83.

“MultiNA Viewer” is used to view, print, and reanalyze the acquired data. For details about using this 
software, see "3 MultiNA Viewer Functions" P.131.

1.3 Instrument Startup and Shutdown

1.3.1 Instrument and PC Startup
Follow these steps to turn on the instrument and PC.

1 Verify that the instrument and PC are properly connected using a LAN cable before 
turning ON the power.

^ Reference
-Instrument and System- "5.4 Connecting the Instrument to a Computer (PC)"

2 Turn ON the instrument, and wait for initialization to complete.
During initialization the green LED blinks. When initialization ends, the green LED stops blinking and is 
steady lit and a buzzer sounds.

3 Turn ON the PC.

4 Enter your user ID and password to log into Windows. 

@NOTE
Use the same user ID as when the MultiNA software was installed.

5 Click the  [MultiNA Control Software] icon on the desktop to open the instrument 
control software.
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6 Verify that the instrument name at the left end of the toolbar is shown in light blue.
It will be shown in light blue if the instrument and PC are connected. It will be shown in light orange if they 
are disconnected.

In the default setting, the PC automatically connects with the instrument at startup and the name appears 
as light blue.

^ Reference
"2.5.2 Options" P.114

If the automatic connection fails, the following message is displayed. Proceed to 7.

7 7If the instrument and PC are not connected after step 6, select [Connect] on the 
[Instrument] pull-down menu.
Verify that the instrument name on the toolbar has changed to light blue.

1.3.2 Instrument Startup (PC Already Running)
Follow the procedures below to start the instrument if the PC has already been started, and the instrument 
was OFF.

1 Verify that the instrument and PC are properly connected using a LAN cable before 
turning ON the power.

^ Reference
-Instrument and System- "5.4 Connecting the Instrument to a Computer (PC)"

2 Turn ON the instrument, and wait for initialization to complete.
During initialization the green LED blinks. When initialization ends, the green LED stops blinking and is 
steady lit and a buzzer sounds.
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3 Select [Connect] on the MultiNA Control Software [Instrument] pull-down menu.
The instrument name on the toolbar will change from light orange (instrument and PC disconnected) to 
light blue (connected).

^ Reference
"2.5.1 Connect" P.113

1.3.3 Instrument and PC Shutdown

1 Click the  [Close] button at the top right corner of the MultiNA Control Software 
window to close the program. Alternatively, select [Exit] on the [Sample Entry] pull-
down menu.
This procedure is not required if the control software MultiNA was not started.

@NOTE
The program cannot be closed if the instrument is in the middle of analysis, rinsing, or other 
operations.

2 Click the  [Close] button at the top right corner of the data analysis software MultiNA 
Viewer window to close the program. Alternatively, select [Exit] on the [File] pull-down 
menu.
This procedure is not required if MultiNA Viewer was not started.

3 Turn the instrument OFF.

4 Close all open programs on the PC, shut down Windows and turn OFF the PC.
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1.3.4 Instrument Shutdown (Leave the PC Running)
Follow the procedures below to turn the instrument OFF, leaving the PC ON.

1 Select [Connect] on the control software MultiNA [Instrument] pull-down menu.

2 The message in the figure below will be displayed. Click [Yes].

Check that the instrument name on the toolbar changes to light orange (disconnected).

3 Turn the instrument OFF.

1.3.5 Precaution for Stable PC Operation
Depending on the PC operating environment, memory leaks or memory fragmentation may occur if the 
system is run continuously for long periods of time, resulting in unstable PC operation. To avoid this kind of 
unexpected Windows-derived problem, either turn OFF the PC or restart the PC at regular intervals (about 
once a week) to ensure use in a clean state.
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1.4 Mixing the Marker Solution
In this instrument, the marker solution which contains an internal standard substance is mixed with a ladder 
or sample and analyzed. The peak of the marker is detected and corrected, for the purpose of enhancing 
the accuracy of size prediction and concentration quantitation. The marker solution in the DNA analysis kit 
includes two types of markers, a lower marker and an upper marker. The marker solution in the RNA 
analysis kit includes only the lower marker. 

There are two methods for mixing the marker solution into the ladder or sample. 
• In “on-chip mix mode,” the ladder or sample is placed into a sample tube (or sample plate) and the marker 

solution is placed into a dedicated vial, then they are placed into the instrument and automatically mixed in a 
microchip reservoir.

• In “premix mode,” the sample and marker solution are manually mixed then placed into the instrument.
Characteristics of the two modes are shown below. As the procedures and amounts required for the 
samples and marker solutions to be prepared differ between the two methods, select the one that is most 
appropriate for the sample to be analyzed, and create the project ("1.5.7 Project Creation" P.21).

@NOTE
In RNA analysis only the premix mode is used.

Fig.1-1 On-Chip Mix (Left) and Premix (Right)

Mixing mode On-chip Mix Premix

Mixing method Automatic (Mixed inside microchip reservoir 
No.1)

Manual mixing

Minimum required 
sample or ladder 
solution volume

5 µL to 30 µL (sample/ladder solution only) DNA: 2 µL to 10 µL (after mixing in marker 
solution: 6 µL to 30 µL)
RNA: 4 µL to 20 µL (after mixing in marker 
solution: 6 µL to 30 µL)

Sample or ladder 
preparation

Only the sample or ladder solution is added to 
the sample tube or sample plate, and then it is 
placed in the instrument.

Marker solution is added to the sample tube 
or sample plate that contains the sample or 
ladder solution. Use a micro pipette to mix, 
and then place it in the instrument.

Marker solution 
preparation

Only the marker solution is added to a 
dedicated vial (0.6 mL tube), and then it is 
placed in the instrument reagent holder.

-

Features After a PCR reaction has ended, the sample 
tube or sample plate can be placed directly 
into the instrument and analyzed.

Can perform analysis with a small amount of 
sample.

Separation Buffer
Marker solution

Sample

Separation Buffer

Sample Marker solution 

Mix and set
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1.5 Preparation Before Analyses
This section describes preparation of the instrument before analysis. For preparation of reagents and other 
items required for analysis, refer to the type of kit and the corresponding pages.

• "1.6 Preparation for Analysis with the DNA-500 Kit" P.32
• "1.7 Preparation for Analysis with the DNA-1000 Kit" P.40
• "1.8 Preparation for Analysis with the DNA-2500 Kit" P.48
• "1.9 Preparation for Analysis with the RNA Kit" P.56

1.5.1 Filling the Rinse Water
Put Milli-Q ultrapure water into the glass bottle for the rinse water. Normally 1000 mL of rinse water is 
required for 120 analyses, however, variations that occur from analysis to analysis may result in use of 
more than 1000 mL. Therefore, use of a 2 L rinse water bottle is recommended. 

As shown in "Fig.1-2 Glass Rinse Water Bottle" P.9, confirm that the 2 suction filters have sunk to the 
bottom of the glass bottle, and that they do not float up again.

Fig.1-2 Glass Rinse Water Bottle

! WARNING

• Remove the cap from the rinse bottle and fill the bottle away from the instrument.
Spilled water on the instrument risks electrical leaks or electrical shocks.

! CAUTION

• Before starting analysis, replenish the rinse water bottle with Milli Q ultrapure water and 
verify that the amount of rinse water is sufficient.
Insufficient rinse water during analysis could disable the migration result, clog the microchip so that it 
becomes unusable, or cause other problems.

! CAUTION

• Do NOT use anything other than Milli-Q ultrapure water for the rinse water.
Use of other types of water could result in defective rinsing or equipment malfunction.
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1.5.2 Setting the Waste Fluid Container

1 Insert the waste tubing into the drain hook provided as a standard accessory.

Fig.1-3 Drain Hook (Left) and Drain Hook with Waste Fluid Tube Attached (Right)

2 Use the drain hook to attach the waste tubing to the waste container.

Fig.1-4 Attaching the Drain Hook to the Waste Fluid Container.

! CAUTION

• Before starting analysis, verify that the tip of the waste tubing is not immersed in the waste 
fluid inside the waste container, and verify that there is a sufficient empty space inside the 
container.

• Check that the waste tubing is not bent, or elevated.
If the waste tubing becomes clogged, waste fluid may leak from inside the instrument.
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1.5.3 Drive Positions

1 Turn the instrument ON. 
When initialization is completed, the green LED on the instrument indicator lights up. If the instrument or 
PC is not turned ON, refer to "1.3.1 Instrument and PC Startup" P.4 or "1.3.2 Instrument Startup (PC 
Already Running)" P.5.

2 Open the top cover. 
Grip the front of the top cover and lift it.

Fig.1-5 Opening the Top Cover (Left: Gripped, Right: Lifted)

• The top cover uses a "auto-stop" mechanism, to stops the cover when it reaches an opening angle of 
approximately 60°.

• When the top cover is fully open, the instrument height is 98 cm.
• The top cover cannot be opened while the instrument is initializing or operating. It can be opened during 

normal standby status or when an error occurs.

! WARNING

• Do NOT forcibly open the top cover during instrument operation (blinking green LED on 
front indicator).
During operation the top cover is locked and cannot be opened.

• Do Not apply lateral force to the top cover when opening or closing.
This may deform the top cover and result in damage.

• Do NOT remove the top cover.
Injuries or accidents may occur.

• If the top cover does not open or close properly, contact your Shimadzu service 
representative immediately.
A technician from Shimadzu will perform repairs.



Outline of Operation

12   MultiNA Instruction Manual

Fig.1-6 Top Cover Stop Position

3 Ensure that the drives (autosampler and pneumatic unit) are at the back of the 
instrument (home position) as shown in the figure below.

Fig.1-7 Home Positions of the Drives

@NOTE
Usually, the drives will be left in the home position when analysis ends normally. However, if a power 
outage or error during analysis causes the instrument to stop, the drives may not have returned to 
the home position. In this case, see "2.5.5 Move All Axes to Home Position" P.119, and return the 
drives to the home position. The drives will not move to the home position during initialization after 
the instrument is turned ON.
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1.5.4 Microchip Registration
• Up to four microchips can be inserted into this instrument.
• A record of the number of runs is managed by the serial number (chip ID) in the software.
• The chip ID is stamped on the surface of the microchip, and is also listed in the instruction manual that 

comes with the microchip (indicated on the right side of S/N. In the figure below, the chip ID is NA0001.) 
• The microchip is composed of a quartz microchip and a plastic protective frame (chip frame).
• In this manual and in the software, it is sometimes expressed as “chip” (Ex.: Chip ID, chip position).

Fig.1-8 Cover of Microchip Manual (Left) and Microchip with Chip Frame Removed (Right)

@NOTE
It is recommended that separate microchips be used for DNA and RNA analysis,

• Since the dye used in DNA analysis and RNA analysis differs, use of a microchip for DNA analysis 
followed immediately RNA analysis (or for RNA analysis followed immediately by DNA analysis) could 
have an adverse effect on the results.

• If the same microchip must be used for both types of analysis, use one of the procedures below to rinse 
the microchip between analyses.

Microchip used for DNA analysis and then used for RNA analysis: 
"4.8 Using a Chip for RNA Analysis after Using It for DNA Analysis" P.203

Microchip used for RNA analysis and then used for DNA analysis: 
"4.9 Using a Chip for DNA Analysis after Using It for RNA Analysis" P.204

When using a new microchip, use the following procedure to register it. If the microchip is already installed, 
proceed to "7" P.16.

Following Procedures

Using a new microchip Proceed to "1" P.14.

Using an installed microchip Proceed to "7" P.16.
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1 Start the MultiNA Control Software. Verify that the instrument and PC are connected.

2 Select [Chip Management] on the [Instrument] pull-down menu.

The [Chip Management] window below is displayed. 

3 Click the  [Change] button corresponding to the position of the chip to be inserted 
(chips 1 to 4).

^ Reference
For details, see "2.5.3 Chip Management" P.115.
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@NOTE
The chip positions are arranged in 1, 2, 3 order from the back, with the front-most position being 
No.4.

Fig.1-9 Chip Stage (Number Shows Chip Position No., and Arrow Shows Direction to Front of Instrument)

4  Enter the chip ID (Ex,: ND060-1) into the chip ID column.

5 Click the [Change] button. The microchip is registered.
A check mark appears next to the chip to be used.

6 Repeat steps 3 to 5 for all of the microchips that will be used.

4 3 2 1
Front
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7 Select the microchips to be used in analysis.
In the [Chip Management] window, verify that all of the microchips to be used have been selected.

@NOTE
A microchip without a check mark will not be used in analysis even if it is installed in the instrument. 

1.5.5 Microchip Installation

1 Loosen the knurled screws (2) on the chip cover.
 

Fig.1-10 Opening the Chip Cover

All four microchips are in use

Only chips at positions 1 and 2, are in use
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2 Lift the chip cover and place it to the side as shown in the figure below.
 

Fig.1-11 Placement of the Chip Cover

3 Insert the microchip on the chip stage by pressing lightly on the upper surface of the 
microchip with both hands. 
Push the upper edge of the microchip onto the surface indicated by the arrows in the figure below.

Fig.1-12 Inserting the Microchip into the Chip Stage

! CAUTION

• Do NOT touch the electrode pins in the back of the chip cover.
Deformed electrode pins may cause defective contact with electrodes on the microchip surface and 
result in improper voltage application.

! CAUTION

• Verify that the chip ID matches the installed chip position.
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4 Align the chip cover with the guide pins and close the cover. Use both hands to hold the 
chip cover in place and tighten the knurled screws.

Fig.1-13 Closing the Chip Cover
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1.5.6 Work Flow from Project Creation to Data Acquisition

Fig.1-14 Work Flow from Project Creation to Data Acquisition
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Project
The project is the user environment containing information required for analysis, including the reagent kit 
(separation buffer), marker solution mixture method (on-chip, premix), default data file name, and graphic 
display scale. A sample sheet is created based on the project information, and registered in the analysis 
schedule.

^ Reference
"1.5.7 Project Creation" P.21

Sample Sheet
The sample sheet is where information related to the targeted ladder or sample (well name, sample name, 
comment, and type) is entered. A sample sheet can be created in the [Sample Entry] window and saved in 
a file for each project (“.SSH” is used for the file extension).

^ Reference
"1.5.8 Rules for Sample Sheet Creation and Entering into an Analysis Schedule" P.24

Analysis Schedule
The analysis schedule displays the order for ladder or sample analysis. When the sample sheet is created 
and entered in the analysis schedule, the schedule is displayed in the main window.

^ Reference
"1.5.9 Creating a Sample Sheet and Entering It into an Analysis Schedule" P.26

Multiple sample sheets can be entered into a single analysis schedule.

^ Reference
"2.2.2 Add" P.101
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Data file
The data file saves the data obtained in the analysis, including both raw data and analysis data.

One data file is created for each sample sheet in the analysis schedule, and is saved in the project folder.

^ Reference
"1.11.1 Displaying the Data" P.71

1.5.7 Project Creation
A project must be created before a sample sheet can be entered into an analysis schedule.

^ Reference
"1.5.9 Creating a Sample Sheet and Entering It into an Analysis Schedule" P.26

The method for creating a new project is as shown below.

1 Select [Edit] on the [Project Settings] pull-down menu.
The [Project List] window is displayed. 

2 Click the [New] button.
The [Project Setting] window is displayed.
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3 Enter the following items.

 

Item Maximum number 
of characters Explanation

Project name 30 Enter the project name (required).
/\<>:”|?* and space cannot be used.

Operator name 20 Enter the operator name (required).
/\<>:”|?* and space cannot be used.

Comment 50 Enter a comment about the project.
Default data 
file name

258 (Including path) When the [Sample Entry] window is opened, specify the data file name 
to be automatically set. /\<>:”|?* and space cannot be used.
In addition to normal characters, the following format characters can be 
used. 
 %I: Instrument name (The name set in [Instrument] - [Option])
 %J: Project name
 %O: Operator name
 %B: Separation buffer
 %Y: Year, %M: Month, %D: Day, %h: Hour, %m: Minute, %s: Sec.
 %Q: Sequential number (Reset in 3 digits at midnight)

Click the  button to select and enter a format.

Ex. In %Y%M%D-%Q, for analyses performed on January 30, 2007, 
the first data file name is 20070130-001 and the next one is 20070130-
002.

Default sample 
name

30 In the sample entry window, select the sample name to be 
automatically entered.
In addition to normal characters, the following format characters can be 
used.
  %W: Well name (A1, B1,...)
  %N: Well No. (1 to 108)
  %Y: Year, %M: Month, %D: Day

Click the  button to select and enter a format.
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4 Click the [Sample] tab, and select the items below. 

@NOTE
Ladder analysis is essential for size prediction, quantitation, and other data analysis (see-Instrument and 
System- "4.2 Actual Analysis and Data Analysis").

It is recommended that [Auto ladder entry] be selected for well positions X1 to X12.

• The ladder is analyzed once at the start of the sample sheet for all microchips used in the analysis.

• Set the ladder into the appropriate well position (X1 to X12) on the extra sample stand.

[V1.05] 
The basic performance specifications for this instrument (-Instrument and System- "8 Specifications") are 
based on using a standard ladder. Performance may differ from the specifications if an optional ladder is 
selected. 

Item Explanation
Sample (Separation Buffer) Select the separation buffer to be used in the project.
Total RNA/mRNA Select RNA (RNA separation buffer) for RNA analysis. (The content of data 

analysis differs between Total RNA and mRNA. When calculating the ratio 
between 28S rRNA and 18S rRNA, select Total RNA.)

Marker mixing mode Select on-chip or premix. For details about each mode, see "1.4 Mixing the 
Marker Solution" P.8.

Load default sample sheet 
while starting up

If this is selected, the default sample sheet (file name: default.ssh) is 
automatically read when the [Sample Entry] window is opened ("2.2.1 New" P.89).

Auto ladder entry / 
Well name

If the ladder is selected, the ladder is automatically registered when the sample 
entry window is opened. A well position (one from X1 to X12) for setting the 
ladder is specified at the same time.

[V1.05]
Ladder type

Select the standard ladder [Standard (STD)] normally. The optional ladder 
[Ladder1 (LD1)] may also be selected.

Analysis order Select the analysis order (A1-B1-C1…, or A1-A2-A3…) for a sample sheet 
created from the wells selected in the sample entry window.
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5 To set the [Display] tab items, see "2.3.1 Project Settings", step "3" P.104.

6 Click [OK] to save the setting.

7 In the [Project List] window, click [Close].

1.5.8 Rules for Sample Sheet Creation and Entering into an Analysis 
Schedule
Create a sample sheet and enter it into the analysis schedule using the [Sample Entry] window.

Rules for Creating a Sample Sheet

1 Create a sample sheet based on the selected project.
2 Enter the well name, sample name, comments, and type (ladder or sample).
3 A sample or ladder set in the sample stand (well position from A1 to H12) is analyzed only once. If it 

is set in the extra sample stand (well position from X1 to X12), analysis can be performed multiple 
times (assuming it is registered multiple times in the sample sheet).

4 A maximum of 120 ladders and sample analyses can be entered on a single sample sheet. 
5 Ensure that the ladder is analyzed first for each of the microchips that is used.

@NOTE
• For each microchip to be used, a size calibration curve is created based on the results of the first 

ladder analysis (see "3.4.8 Size Calibration Curve" P.171). All of the samples analyzed after the 
ladder are analyzed by using the size calibration curve.

• While analysis can be performed in sample sheets that do not include a ladder, analyzing a ladder 
first is recommended for obtaining analysis data with the highest accuracy.

6  Enter the created sample sheet into the analysis schedule.
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The left side of Fig.1-15 shows the case when four microchips are used, and the right side shows use of 
two microchips. For example, when four microchips are used, analysis is first performed on the four 
ladders (one analysis for each microchip) and then the samples are analyzed. When two microchips are 
used, analysis is first performed on the two ladders and then the samples are analyzed. 

For the case of eight samples, the total number of analyses, including ladders, for four microchips is 
“4 + 8 = 12", and for two microchips is “2 + 8 = 10".

Fig.1-15 Relationship between Ladder and Sample Analysis (Left: Four Microchips Used, Right: Two Microchips Used)

Fig.1-16 Sample Sheet Example (Left: Four Microchips Used, Right: Two Used)

Rules for Entry into an Analysis Schedule

1 A maximum of 120 analyses can be entered into a single schedule.
2 Analyses are performed in the order shown in the analysis schedule.
3 All registered microchips are used to execute the analysis schedule.

@NOTE
An automatic check performed before analysis detects clogged microchips, and excludes any 
microchips judged to be unsuitable for analysis. The remaining microchips are then used to complete 
the analysis schedule.

Sample is analyzed based on the size calibration curve created in the ladder analysis.
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1.5.9 Creating a Sample Sheet and Entering It into an Analysis Schedule
The method for specifying the ladder and sample positions using the well display window is described 
below.

Other methods are also available, including direct entry of the well position, entry of only the sample 
number, and capture from Excel or CSV files. A sample sheet can also be created from the default sample 
sheet saved for each project.

^ Reference
"2.2.1 New" P.89

1 Select [New] on the [Sample Entry] pull-down menu or click the  [New Entry] button 
on the upper left side of the toolbar.
The [Sample Entry - New] window below is displayed.

! CAUTION

• Insert a blank analysis at the beginning of each RNA sequence on each microchip.
This is necessary for obtaining stable analysis results.

• For the blank analysis sample, use THE RNA Storage Solution.

! CAUTION

• Use the table below as a guide for determining the number of samples that can be entered 
into a single RNA analysis.
The sample stand does not have a cooling function. To maintain the denatured state of the RNA 
samples, use the table below as a guide for determining the number of samples in a single analysis, 
according to the number of microchips used.

Number of 
microchips used Sample number Ladder analysis Blank analysis Total number of 

analyses

1 1 to 6 1 1 8 max

2 2 to 12 2 2 16 max

3 3 to 16 3 3 22 max

4 4 to 14 4 4 22 max



 Operating Procedure   27

1.5  Preparation Before Analyses

1

2 Select the project created in "1.5.7 Project Creation" P.21, and click [OK]. 
The [Sample Entry] window is displayed.
Four microchips are used in the example below, [Auto ladder entry] is selected (P.23), and the ladder well 
is X1.
In this case, for the first four analyses (four lines), the well name is X1 and “Ladder” is automatically 
displayed for [Type]. 

• In the [Data file name] column, the file name format is displayed in accordance with the project [default 
data file name]. For %Y%M%D-%Q, for example, the file name is automatically the year-month-day 
sequential number (Ex.: 20070130-001, first data file for January 30, 2007) (see "1.5.7 Project 
Creation" P.21). 

[V1.05] 
• The file name shown below the [Data File Name] column is the file name actually created. 

(Clicking the [Enter] button confirms the file name.) 

3 Specify the ladder or sample wells in the upper left area of the well display window.
• To select the wells, either click the wells one by one, or drag the mouse over multiple wells.

@NOTE
Only one analysis can be performed from a single well in the A1 to H12 positions. Multiple analyses 
can be performed from the X1 to X12 positions in the extra sample stand. Choose the appropriate 
well positions according to the sample and number of analyses.

Extra Sample Stand
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4 After specifying the wells, click the  button.
The [Well name] and [Type] are automatically entered in the column on the right side. The [Type] is 
always “Sample”.

5  Enter the sample name and comment, and change the type.
• Clicking the [Type] cell displays a drop-down list. The type can be changed to [Ladder].

• Use either of the methods below to create multiple lines to perform multiple analyses from the X1 to 
X12 positions.

• In the well display, re-select the wells in X1 to X12, and click the  button.

• Right-click the X1 to X12 lines that you want to copy, go to the pull-down menu to select [Copy], 
right-click the line in the vacant column, and select [Paste].

• Enter X1 to X12 lines directly into the sample sheet.
• The sample name can be a maximum of 30 characters, and a comment can be up to 50 characters.

^ Reference
"2.2.1 New" P.89
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6 Repeat steps 4 to 5 as often as necessary to enter information for all of the ladders and 
samples to be analyzed.

@NOTE
 

Enter a blank analysis for each microchip before starting the RNA ladder analysis.

Select [Ladder] as the [Type] for the blank analysis.
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7 To save the created sample sheet, click the [Save] button.
At this time, selecting [Save it as a default sample sheet] and then clicking the [Save] button will save it as 
a [Default sample sheet].

[Default sample sheet]
If [Loading default sample sheet while starting up] was selected in the project settings, the default sample 
sheet will automatically be displayed when a new [Sample Entry] window is opened.

^ Reference
"2.2.1 New" P.89

8 Click the [Enter] button.
The created sample sheet is entered in the main analysis schedule window.

@NOTE
If ladder analysis is not included in the sample sheet, the following message is displayed.

Select [Yes] to enter the sample sheet without a ladder analysis into the analysis schedule. In this 
case, you cannot automatically obtain size prediction and quantitation results in the analysis data. 
However, you can import a ladder file created for other analysis data to perform a reanalysis and 
obtain the size prediction and quantitation.
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^Reference
"3.7.3 Change Ladder and Analyze" P.189

Selecting [No] stops registration in the analysis schedule, and the [Sample Entry] window remains 
open.

@NOTE
If a sample sheet is created during analysis, it can be saved but not entered into the analysis 
schedule. Click [Save] the [Enter] button is not displayed in the [Sample Entry] window.

9 The separation buffer and marker solution volumes required for analysis are displayed 
in [Reagent Information].
The example below is for DNA-500 premix mode. In premix mode, the amount of marker solution is not 
displayed.

^ Reference
"2.5.4 Detect Remaining Reagent Amount" P.118

@NOTE
Separation buffer and marker solution placement is described in sections 1.6 to 1.9, for each reagent 
kit.

10 Select [Add] on the [Sample Entry] pull-down menu to enter a different sample sheet 
into the analysis schedule.
For details, see "2.2.2 Add" P.101.
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1.6 Preparation for Analysis with the DNA-500 Kit

1.6.1 Requirements

@NOTE
*1) In this manual, the 0.2-mL PCR tube listed in the above table is called the sample tube, 

and the 96-well PCR plate is called the sample plate.

*2) One buffer bottle and two vials (marker solution bottles) are provided for each reagent kit. 
If more are required, order the recommended items separately. 

Part Name Sales origin Part No. 
(Catalog No.) Remarks

Microchip Type DR-C Shimadzu Corporation 292-27900-91 -
Reagent kit DNA-500 Shimadzu Corporation 292-27910-91 -

SYBR® Gold Invitrogen S-11494 Diluted to 1/100

25 bp DNA ladder Invitrogen 10597-011 Diluted to 1/50
TE buffer 10 MM Tris-HCl - - pH 8.0
Micro tube - - Volume from 200 µL to 1.5 mL

For diluted dye solution and ladder 
solution

Sample tube or sample plate (recommended product) Sample and ladder solution vessel 
(Note *1)

MicroAmp® reaction tubes Applied Biosystems N801-0533 1 tube

MicroAmp® strip tubes
(without cap, 8 tubes/strip)

N801-0580 8-strip tubes

MicroAmp® Optical 96-well 
Reaction Plate

N801-0560 96-well PCR plate

Strips of 8 Thermo-Tubes ABgene AB-0452 8-strip tubes
Strips of 12 Thermo-Tubes AB-1112 12-strip tubes
8 Low profile Thermo-strip AB-0771 8-strip/12-strip tubes

<Note> Since there are tabs on both 
ends of the tube, they cannot be 
used on the extra sample stand.

12 Low profile Thermo-
strip

AB-0847

Termo-Fast® 96 PCR Plate 
Non-Skirted

AB-0600 96-well PCR plate

Adhesive PCR Foil Seals 
(Aluminum seal)

ABgene AB-0626 To avoid volatilization of the ladder 
and sample solutions, use this for 
analyzing a minimum of 13 samples 
with the 96-well PCR plate.

Buffer bottle 
Recommended product:
Centrifugal tube, 5 mL, 1000/
packing

ASSIST (Sarstedt) 60.558 Extra separation buffer container 
(Note *2)

Vial
Recommended product:
Vial made of PP, 0.6 mL and 
1000/packing (without cap) 

BIO MEDICAL 
EQUIPMENT

NC-502 Extra marker solution container 
(Note *2)

Micro pipet and tip - - Designed for volume of 0.5 µL to 
5 mL

Protective glasses, protective 
mask, and protective gloves

- - -

Vortex mixer - - -
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! CAUTION

• Use the sample plate (96 well plate) to analyze 13 or more samples, and attach an 
aluminum seal.

• Use only the aluminum seal recommended in the list above.
If any other aluminum seal is used, the piercing needle may fail to penetrate, resulting in damage to 
the sample probe or other instrument problems.
Do NOT use parafilm. It may adhere to the sample probe or cause other instrument problems.

• The aluminum seal can only be used with the sample plate recommended in the list above.
Do NOT use the aluminum seal to cover sample tubes, it prevents the sample holder from being 
properly set in place.

! CAUTION

• Use only the sample tube and sample plate recommended in the list above.
Use of any other sample tube or sample plate could lead to dispensing failures of at least 5 µL.

• Do NOT cap a sample tube.
Using a capped sample tube could result damage to the sample probe, or other instrument problems.

! CAUTION

• The sample tube types shown below can be only used in the normal sample stand.
There are tabs on both ends of the tube that prevent it from being properly positioned in the extra 
sample stand.

• ABgene PCR 8-strip/12-strip tubes (low profile): Part No. AB-0771, AB-0847

! CAUTION

• Dispense to sample tube not to exceed 30 µL. Otherwise, that may be interfered with 
analysis sequence.
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1.6.2 Contents of the DNA-500 Kit
The DNA-500 kit (Part No. 292-27910-91) is composed of the following parts. When the kit is delivered, 
immediately open it, check the part names and quantity, and then store them at the temperatures specified 
for each part.

Fig.1-17 Contents of the DNA-500 Kit

• Expiration dates are noted on the labels. Use the reagents in refrigerated or frozen storage before the 
expiration dates.

• Observe the laws, regulations, and rules of the country, local governing authority, or resident facility when 
discarding reagents.

@NOTE
To avoid repeated freezing and thawing of marker solutions, it is recommended that they be divided into 
small allotments for frozen storage.

1.6.3 Diluted Dye Solution Preparation
Prepare SYBR® Gold solution diluted to 1/100.

No. Part Name Capacity Quantity Remarks

1 DNA-500 separation 
buffer

30 mL 1 Refrigerated storage at 2°C to 8°C (PP bottle)
(Up to 1000 analyses)

2 DNA-500 marker solution 1.2 mL 4 Frozen storage at -20°C (Aluminum pack)
(Up to 1000 analyses)

3 Buffer bottle (5 mL) 1 Separation buffer dispensing container (with cap)

4 Vial (0.6 mL) 2 Marker solution dispensing tube (without cap)

5 Manual - 1 -

! WARNING

• During operations, wear protective gloves, protective glasses, and a protective mask.

• See the MSDS for each reagent.
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@NOTE
• Restore each reagent to room temperature before use. 

• Do NOT mix reagents from different lot numbers (the lot number is noted on labels of the buffer bottles or 
mark solution aluminum packs).

• For dye handling precautions and storage conditions, see the relevant Invitrogen Co. Product Information 
and MSDS.

• To avoid repeated freezing and thawing of SYBR® Gold for preparation of the diluted solution, it is 
recommended that the solution be divided into small allotments (about 10 µL) and placed into microtubes. 
It should be frozen and shielded from light. 

Requirements
• SYBR® Gold
• TE buffer
• Microtube (volume from 200 µL to 1.5 mL)
• Micro pipette
• Vortex mixer

Procedures

1 Use a micro pipette to dispense 99 µL of TE buffer to a microtube.

2 Add 1 µL of SYBR® Gold dye, and agitate the solution with the vortex mixer for at least 
of 10 seconds.minimum of 10 seconds.

1.6.4 Ladder Solution Preparation
Dilute a 25 bp DNA ladder (Invitrogen Co., catalog No. 10597-011) to 1/50 to prepare the ladder solution.

[V1.05] 
If using an optional ladder, prepare the ladder solution by referring to "4.10 Using Optional Ladders" P.205.

Requirements
• 25 bp DNA ladder
• TE buffer
• Microtube (volume from 200 µL to 1.5 mL)
• Micro pipette
• Vortex mixer

Procedures

1 Use a micro pipette to dispense 49 µL of TE buffer to a microtube.

2 Add 1 µL of the 25 bp DNA ladder, and agitate the solution with the vortex mixer for at 
least 10 seconds.
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1.6.5 Separation Buffer Preparation

@NOTE
The separation buffer mixed with diluted dye solution should be used on the day it is prepared.

Requirements
• DNA-500 separation buffer
• Diluted dye solution ("1.6.3 Diluted Dye Solution Preparation" P.34)
• Buffer bottle
• Micro pipette

Procedures

1 Dispense the separation buffer included in the DNA-500 kit into the buffer bottle, and 
use the micro pipette to add the diluted dye solution.
• Ensure that the volume of the mixed solution exceeds the required volume displayed in the [Reagent 

Information] window.
• Add the diluted dye solution until it reaches a volume ratio of 1/100 to the separation buffer transferred 

to the buffer bottle. For example, if the volume requirement is 1000 µL, add 10 µL of diluted dye 
solution to 990 µL of separation buffer.

Refer to the table below and use a micro pipette to dispense the separation buffer and diluted dye solution 
in the amounts required for the number of analyses (total ladders and samples) into the buffer bottle. 

Guidelines for Required Amounts of Separation Buffer and Diluted Dye Solution

@NOTE
The required amount of separation buffer is about 20 µL per analysis. The amounts described below 
are included in the required volumes indicated in [Reagent Information] and in the above guidelines.

• Amount needed for retries (up to 2 retries) if a problem is detected when automatically adding 
separation buffer to the microchip

• Dead volume of buffer bottle

• Minimum bottle amount detectable by a level sensor

@NOTE
The reagent kit contains 30 mL of separation buffer (for 1000 analyses). The total number of 
analyses will be less than 1000 in situations where the number of analyses for each sequence is 
small, because the redundant amounts will be larger.

2 Cap the bottle, and agitate the solution with the vortex mixer for at least 10 seconds.

Number of analyses 
(Total ladders and 

samples)

Amount of separation 
buffer

Amount of diluted dye 
solution

Amount of mixed 
solution

8 analyses or less 495 µL 5 µL 500 µL
9 to 29 analyses 990 µL 10 µL 1000 µL

30 to 79 analyses 1980 µL 20 µL 2000 µL
80 to 120 analyses 2970 µL 30 µL 3000 µL
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3 Remove the cap and put the bottle in the blue reagent holder position (color code for 
DNA-500 kit).

@NOTE
Let the solution adhering to the inner sides of the buffer bottle settle, and use a micro pipette to 
remove any residual bubbles before placing the tube in the reagent holder.

@NOTE
Move the bottle around to ensure that the bottom of the buffer bottle is in the correct position at the 
bottom of the reagent holder.

Fig.1-18 DNA-500 Separation Buffer in Reagent Holder

! CAUTION

• Remove the cap from the buffer bottle before placing it in the reagent holder.
The sample probe may be damaged. 
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1.6.6 Ladder, Sample and Marker Solution Usage
Insert the tubes into the positions specified in the analysis schedule.

@NOTE
Follow these precautions to prevent volatilization of solution, and to confirm the minimum amount of 
dispensable solution.

• When total number of ladders or samples to be analyzed is 12 or less

No aluminum seal is needed to prevent volatilization, and the recommended 8-strip or 12-strip 
sample tubes can be used. Dispense a minimum of 9 µL into each tube.

• When the number of ladders or samples is 13 or more

Use the 96-well sample plate, and the recommended aluminum seal. Dispense a minimum of 6 µL 
(premix) or 5 µL (on-chip mix) into each well. 

• When the same ladder or sample is analyzed multiple times

Use the recommended 8-strip or 12-strip sample tubes without an aluminum seal, and place it in the 
extra sample stand (X1 to X12). Since the amount of solution dispensed to each tube differs 
between premix and on-chip mix, see the respective descriptions for those items.

@NOTE
When the prepared sample is expected to exceed the quantitative range (0.5 ng/µL to 50 ng/µL) or the 
maximum salt concentration (KCI or NaCl concentration; maximum of 125 mM) for DNA samples use the TE 
buffer (pH 8.0) to dilute it prior to analysis.

For Premix
Mix the marker solution at a volume ratio of 2:1 into the ladder or sample, and place it in the instrument.

Nothing is placed in the marker solution position.

1 Place the ladder solution and marker solution mix in the extra sample stand.
Transfer the ladder solution prepared as per "1.6.4 Ladder Solution Preparation" P.35 into the sample 
tube (or sample plate). Then, add the marker solution at a volume ratio of 2:1, and mix the solution 
thoroughly through pipetting. 
• For example, to analyze a ladder solution four times from the extra sample stand requires a minimum 

of 15 µL (3 x (4 + 1) = 15 µL). Add 10 µL of marker solution to 5 µL of ladder solution.

2 Place the sample and marker solution mix in the appropriate sample compartment.
Transfer the sample to the sample tube (or sample plate). Then, add the marker solution at a volume ratio 
of 2:1, and mix the solution thoroughly through pipetting.
• For example, for analysis of up to 12 samples, mix 6 µL of marker solution with 3 µL of sample in a 

sample tube, and place the tube in the extra sample stand.
• To analyze 13 samples or more, mix 4 µL of marker solution with 2 µL of sample in a sample plate well, 

cover it with an aluminum seal, and place the sample plate on the sample stand.

Sample stand (One analysis per well)
Number of analyses (Total 

ladders and samples) Container Amount of ladder 
or samples

Amount of 
marker solution

Amount of mixed 
solution

12 analyses or less Sample tube 3 µL 6 µL 9 µL
13 analyses or more Sample plate with seal 2 µL 4 µL 6 µL

Extra sample stand (Multiple analyses per well) 
Number of 
analyses Container Amount of ladder or 

sample
Amount of marker 

solution
Amount of mixed 

solution
1 to 4 times Sample tube 5 µL 10 µL 15 µL
5 to 9 times Sample tube 1 x (Number of 

analyses + 1) µL
2 x (Number of 

analyses + 1) µL
3 x (Number of 

analyses + 1) µL
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For On-Chip Mix
In on-chip mixes, the ladder or sample, and the marker solution, are placed into the instrument separately. 
The ladder or sample is automatically mixed with the marker solution on the microchip.

1 Place the ladder solution in the extra sample stand.
Transfer the ladder solution prepared as per "1.6.4 Ladder Solution Preparation" P.35 into the sample 
tube (or sample plate).
• For example, to analyze a ladder solution four times from the extra sample stand requires a minimum 

of 11 µL (5 + 2 x 3 = 11) of solution. Add 11 µL of ladder solution to the sample tube and place it in the 
extra sample stand.

2 Place the sample in the appropriate sample compartment.
Transfer the sample to the sample tube (or sample plate).
• For analysis of up to 12 samples, dispense 9 µL or more of sample into the sample tube, and place the 

tube in the extra sample stand.
• For analysis of 13 or more samples, dispense 5 µL or more of sample into the sample plate well, cover 

with an aluminum seal, and place the sample plate on the sample stand.

3 Dispense the marker solution.
Use a micro pipette to dispense marker solution in excess of the required amount shown in [Reagent 
Information] into a vial (PP 0.6-mL vial, no cap). 

Or use the formula below to calculate the amount of marker solution required for the number of analyses 
(samples and ladders), and use a micro pipette to dispense it to a vial (PP 0.6-mL vial, no cap).

 

(Amount of marker solution required) = 2 x (Number of analyses) + 40 (µL)

@NOTE
Since the minimum detectable amount using a level sensor is 40 µL, use a larger amount.

4 Put the bottle in the blue reagent holder position (color code for DNA-500 kit).

Fig.1-19 DNA-500 Marker Solution in Reagent Holder

Sample stand (One analysis per well)
Number of analyses 

(Total ladders and samples) Container Amount of ladder or sample

12 analyses or less Sample tube 9 µL
13 analyses or more Sample plate with seal 5 µL

Extra sample stand (Multiple analyses per well) 
Number of analyses Container Amount of ladder or sample

1 to 3 times Sample tube 9 µL
3 to 13 times Sample tube 5 + 2 x (Number of analyses - 1) µL
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1.7 Preparation for Analysis with the DNA-1000 Kit

1.7.1 Requirements

@NOTE
*1) In this manual, the 0.2-mL PCR tube listed in the above table is called the sample tube, 

and the 96-well PCR plate is called the sample plate.

*2) One buffer bottle and two vials (marker solution bottles) are provided for each reagent kit. 
If more are required, order the recommended items separately. 

Part Name Sales origin Part No. 
(Catalog No.) Remarks

Microchip Type DR-C Shimadzu Corporation 292-27900-91 -
Reagent kit DNA-1000 Shimadzu Corporation 292-27911-91 -

SYBR® Gold Invitrogen S-11494 Diluted to 1/100

φX174 DNA/HaeIII Markers Promega G1761 Diluted to 1/100
TE buffer 10 MM Tris-HCl - - pH 8.0
Micro tube - - Volume from 200 µL to 1.5 mL

For diluted dye solution and ladder 
solution

Sample tube or sample plate 
(recommended product)

- - Sample and ladder solution vessel 
(Note *1)

MicroAmp® reaction tubes Applied Biosystems N801-0533 1 tube

MicroAmp® strip tubes
(without cap, 8 tubes/strip)

N801-0580 8-strip tubes

MicroAmp® Optical 96-well 
Reaction Plate

N801-0560 96-well PCR plate

Strips of 8 Thermo-Tubes ABgene AB-0452 8-strip tubes
Strips of 12 Thermo-Tubes AB-1112 12-strip tubes
8 Low profile Thermo-strip AB-0771 8-strip/12-strip tubes

<Note> Since there are tabs on both 
ends of the tube, they cannot be used 
on the extra sample stand.

12 Low profile Thermo-strip AB-0847

Termo-Fast® 96 PCR Plate 
Non-Skirted

AB-0600 96-well PCR plate

Adhesive PCR Foil Seals 
(Aluminum seal)

ABgene AB-0626 To avoid volatilization of the ladder and 
sample solutions, use this for analyzing 
a minimum of 13 samples with the 96-
well PCR plate.

Buffer bottle 
Recommended product:
Centrifugal tube, 5 mL, 
1000/packing

ASSIST (Sarstedt) 60.558 Extra separation buffer container
(Note *2)

Vial
Recommended product:
Vial made of PP, 0.6 mL and 
1000/packing (without cap) 

BIO MEDICAL 
EQUIPMENT

NC-502 Extra marker solution container 
(Note *2)

Macrobiotic and tip - - Designed for volume of 0.5 µL to 5 mL
Protective glasses, protective 
mask, and protective gloves

- - -
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1.7  Preparation for Analysis with the DNA-1000 Kit

1

! CAUTION

• Use the sample plate (96 well plate) to analyze 13 or more samples, and attach an 
aluminum seal.

• Use only the aluminum seal recommended in the list above.
If any other aluminum seal is used, the piercing needle may fail to penetrate, resulting in damage to 
the sample probe or other instrument problems.
Do NOT use parafilm. It may adhere to the sample probe or cause other instrument problems.

• The aluminum seal can only be used with the sample plate recommended in the list above.
Do NOT use the aluminum seal to cover sample tubes, it prevents the sample holder from being 
properly set in place.

! CAUTION

• Use only the sample tube and sample plate recommended in the list above.
Use of any other sample tube or sample plate could lead to dispensing failures of at least 5 µL.

• Do NOT cap a sample tube.
Using a capped sample tube could result damage to the sample probe, or other instrument problems.

! CAUTION

• The sample tube types shown below can be only used in the normal sample stand.
There are tabs on both ends of the tube that prevent it from being properly positioned in the extra 
sample stand.

• ABgene PCR 8-strip/12-strip tubes (low profile): Part No. AB-0771, AB-0847

! CAUTION

• Dispense to sample tube not to exceed 30 µL. Otherwise, that may be interfered with 
analysis sequence.
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1.7.2 Contents of the DNA-1000 Kit
The DNA-1000 kit (Part No. 292-27911-91) is composed of the following parts. When the kit is delivered, 
immediately open it, check the part names and quantity, and then store them at the temperatures specified 
for each part.

Fig.1-20 Contents of the DNA-1000 Kit

• Expiration dates are noted on the labels. Use the reagents in refrigerated or frozen storage before the 
expiration dates.

• Observe the laws, regulations, and rules of the country, local governing authority, or resident facility when 
discarding reagents.

@NOTE
To avoid repeated freezing and thawing of marker solutions, it is recommended that they be divided into 
small allotments for frozen storage.

No. Part Name Capacity Quantity Remarks

1 DNA-1000 separation 
buffer

30 mL 1 Refrigerated storage at 2°C to 8°C (PP bottle)
(Up to 1000 analyses)

2 DNA-1000 marker solution 1.2 mL 4 Frozen storage at -20°C (Aluminum pack)
(Up to 1000 analyses)

3 Buffer bottle (5 mL) 1 Separation buffer dispensing container (with cap)

4 Vial (0.6 mL) 2 Marker solution dispensing tube (without cap)

5 Manual - 1 -
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1.7  Preparation for Analysis with the DNA-1000 Kit

1

1.7.3 Diluted Dye Solution Preparation
Prepare SYBR® Gold solution diluted to 1/100.

@NOTE
• Restore each reagent to room temperature before use. 

• Do NOT mix reagents from different lot numbers (the lot number is noted on labels of the buffer bottles or 
mark solution aluminum packs).

• For dye handling precautions and storage conditions, see the relevant Invitrogen Co. Product Information 
and MSDS.

• To avoid repeated freezing and thawing of SYBR® Gold for preparation of the diluted solution, it is 
recommended that the solution be divided into small allotments (about 10 µL) and placed into microtubes. 
It should be frozen and shielded from light. 

Requirements
• SYBR® Gold
• TE buffer
• Microtube (volume from 200 µL to 1.5 mL)
• Micro pipette
• Vortex mixer

Procedures

1 Use a micro pipette to dispense 99 µL of TE buffer to a microtube.

2 Add 1 µL of SYBR® Gold dye, and agitate the solution with the vortex mixer for at least 
10 seconds.

1.7.4 Ladder Solution Preparation
Dilute φX174 DNA/HaeIII Markers (Promega Co., catalog No. G1761) to 1/100 to prepare the ladder 
solution.

[V1.05] 
If using an optional ladder, prepare the ladder solution by referring to "4.10 Using Optional Ladders" P.205.

Requirements
• φX174 DNA/HaeIII marker (Promega Co. catalog number G1761)
• TE buffer
• Microtube (volume from 200 µL to 1.5 mL)
• Micro pipette
• Vortex mixer

! WARNING

• During operations, wear protective gloves, protective glasses, and a protective mask.

• See the MSDS for each reagent.
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Procedure

1 Use a micro pipette to dispense 99 µL of TE buffer to a microtube.

2 Add 1 µL of φX174 DNA/HaeIII Markers, and agitate the solution with the vortex mixer for 
at least 10 seconds.

1.7.5 Separation Buffer Preparation

@NOTE
The separation buffer mixed with diluted dye solution should be used on the day it is prepared.

Requirements
• DNA-1000 separation buffer
• Diluted dye solution ("1.7.3 Diluted Dye Solution Preparation" P.43)
• Buffer bottle
• Micro pipette

Procedures

1 Dispense the separation buffer included in the DNA-1000 kit into the buffer bottle, and 
use the micro pipette to add the diluted dye solution.
• Ensure that the volume of the mixed solution exceeds the required volume displayed in the [Reagent 

Information] window.
• Add the diluted dye solution until it reaches a volume ratio of 1/100 to the separation buffer transferred 

to the buffer bottle. For example, if the volume requirement is 1000 µL, add 10 µL of diluted dye 
solution to 990 µL of separation buffer.

Refer to the table below and use a micro pipette to dispense the separation buffer and diluted dye solution 
in the amounts required for the number of analyses (total ladders and samples) into the buffer bottle. 

Guidelines for Required Amounts of Separation Buffer and Diluted Dye Solution

@NOTE
The required amount of separation buffer is about 20 µL per analysis. The amounts described below 
are included in the required volumes indicated in [Reagent Information] and in the above guidelines.

• Amount needed for retries (up to 2 retries) if a problem is detected when automatically adding 
separation buffer to the microchip

• Dead volume of buffer bottle
• Minimum bottle amount detectable by a level sensor

@NOTE
The reagent kit contains 30 mL of separation buffer (for 1000 analyses). The total number of 
analyses will be less than 1000 in situations where the number of analyses for each sequence is 
small, because the redundant amounts will be larger.

Number of analyses 
(Total ladders and 

samples)

Amount of separation 
buffer

Amount of diluted dye 
solution

Amount of mixed 
solution

8 analyses or less 495 µL 5 µL 500 µL
9 to 29 analyses 990 µL 10 µL 1000 µL

30 to 79 analyses 1980 µL 20 µL 2000 µL
80 to 120 analyses 2970 µL 30 µL 3000 µL
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1.7  Preparation for Analysis with the DNA-1000 Kit

1

2 Cap the bottle, and agitate the solution with the vortex mixer for at least of 10 seconds.

3 Remove the cap and put the bottle in the green reagent holder position (color code for 
DNA-1000 kit).

@NOTE
Let the solution adhering to the inner sides of the buffer bottle settle, and use a micro pipette to 
remove any residual bubbles before placing the tube in the reagent holder.

@NOTE
Move the bottle around to ensure that the bottom of the buffer bottle is in the correct position at the 
bottom of the reagent holder.

 

Fig.1-21 DNA-1000 Separation Buffer in Reagent Holder

! CAUTION

• Remove the cap from the buffer bottle before placing it in the reagent holder.
The sample probe may be damaged. 
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1.7.6 Ladder, Sample, and Marker Solution Usage
Insert the tubes into the positions specified in the analysis schedule.

@NOTE
Follow these precautions to prevent volatilization of solution, and to confirm the minimum amount of 
dispensable solution.
• When total number of ladders or samples to be analyzed is 12 or less

No aluminum seal is needed to prevent volatilization, and the recommended 8-strip or 12-strip 
sample tubes can be used. Dispense a minimum of 9 µL into each tube.

• When the number of ladders or samples is 13 or more
Use the 96-well sample plate, and the recommended aluminum seal. Dispense a minimum of 6 µL 
(premix) or 5 µL (on-chip mix) into each well. 

• When the same ladder or sample is analyzed multiple times
Use the recommended 8-strip or 12-strip sample tubes without an aluminum seal, and place it in the 
extra sample stand (X1 to X12). Since the amount of solution dispensed to each tube differs 
between premix and on-chip mix, see the respective descriptions for those items.

@NOTE
When the prepared sample is expected to exceed the quantitative range (0.5 ng/µL to 50 ng/µL) or the
maximum salt concentration (KCI or NaCl concentration; maximum of 125 mM) for DNA samples use the 
TE buffer (pH 8.0) to dilute it prior to analysis.

For Premix
Mix the marker solution at a volume ratio of 2:1 into the ladder or sample, and place it in the instrument. 
Nothing is placed in the marker solution position.

1 Place the ladder solution and marker solution mix in the extra sample stand.
Transfer the ladder solution prepared as per "1.7.4 Ladder Solution Preparation" P.43 into the sample 
tube (or sample plate). Then, add the marker solution at a volume ratio of 2:1, and mix the solution 
thoroughly through pipetting. 
• For example, to analyze a ladder solution four times from the extra sample stand requires a minimum 

of 15 µL (3 x (4 + 1) = 15 µL). Add 10 µL of marker solution to 5 µL of ladder solution.

2 Place the sample and marker solution mix in the appropriate sample compartment.
Transfer the sample to the sample tube (or sample plate). Then, add the marker solution at a volume ratio 
of 2:1, and mix the solution thoroughly through pipetting.
• For example, for analysis of up to 12 samples, mix 6 µL of marker solution with 3 µL of sample in a 

sample tube, and place the tube in the extra sample stand.
• To analyze 13 samples or more, mix 4 µL of marker solution with 2 µL of sample in a sample plate well, 

cover it with an aluminum seal, and place the sample plate on the sample stand.

Sample stand (One analysis per well)
Number of analyses (Total 

ladders and samples) Container Amount of ladder 
or samples

Amount of 
marker solution

Amount of 
mixed solution

12 analyses or less Sample tube 3 µL 6 µL 9 µL
13 analyses or more Sample plate with seal 2 µL 4 µL 6 µL

Extra sample stand (Multiple analyses per well) 
Number of 
analyses Container Amount of ladder or 

sample
Amount of marker 

solution
Amount of mixed 

solution
1 to 4 times Sample tube 5 µL 10 µL 15 µL
5 to 9 times Sample tube 1 x (Number of 

analyses + 1) µL
2 x (Number of 

analyses + 1) µL
3 x (Number of 

analyses + 1) µL
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1.7  Preparation for Analysis with the DNA-1000 Kit

1

For On-Chip Mix
In on-chip mixes, the ladder or sample, and the marker solution, are placed into the instrument separately. 
The ladder or sample is automatically mixed with the marker solution on the microchip.

1 Place the ladder solution in the extra sample stand.
Transfer the ladder solution prepared as per "1.7.4 Ladder Solution Preparation" P.43 into the sample 
tube (or sample plate).
• For example, to analyze a ladder solution four times from the extra sample stand requires a minimum 

of 11 µL (5 + 2 x 3 = 11) of solution. Add 11 µL of ladder solution to the sample tube and place it in the 
extra sample stand.

2 Place the sample in the appropriate sample compartment.
Transfer the sample to the sample tube (or sample plate).
• For analysis of up to 12 samples, dispense 9 µL or more of sample into the sample tube, and place the 

tube in the extra sample stand.
• For analysis of 13 or more samples, dispense 5 µL or more of sample into the sample plate well, cover 

with an aluminum seal, and place the sample plate on the sample stand.

3 Dispense the marker solution.
Use a micro pipette to dispense marker solution in excess of the required amount shown in [Reagent 
Information] into a vial (PP 0.6-mL vial, no cap). 

Or use the formula below to calculate the amount of marker solution required for the number of analyses 
(samples and ladders), and use a micro pipette to dispense it to a vial (PP 0.6-mL vial, no cap).

(Amount of marker solution required) = 2 x (Number of analyses) + 40 (µL)

@NOTE
Since the minimum detectable amount using a level sensor is 40 µL, use a larger amount.

4 Put the bottle in the green reagent holder position (color code for DNA-1000 kit).

Fig.1-22 DNA-1000 Marker Solution in Reagent Holder

Sample stand (One analysis per well)
Number of analyses 

(Total ladders and samples) Container Amount of ladder or sample

12 analyses or less Sample tube 9 µL
13 analyses or more Sample plate with seal 5 µL

Extra sample stand (Multiple analyses per well) 
Number of analyses Container Amount of ladder or sample

1 to 3 times Sample tube 9 µL
3 to 13 times Sample tube 5 + 2 x (Number of analyses - 1) µL
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1.8 Preparation for Analysis with the DNA-2500 Kit

1.8.1 Requirements

@NOTE
*1) In this manual, the 0.2-mL PCR tube listed in the above table is called the sample tube, 

and the 96-well PCR plate is called the sample plate.

*2) One buffer bottle and two vials (marker solution bottles) are provided for each reagent kit. 
If more are required, order the recommended items separately. 

Part Name Sales origin Part No. 
(Catalog No.) Remarks

Microchip Type DR-C Shimadzu Corporation 292-27900-91 -
Reagent kit DNA-2500 Shimadzu Corporation 292-27912-91 -

SYBR®Gold Invitrogen S-11494 Diluted to 1/100

pGEM® DNA Markers Promega G1741 Diluted to 1/100

TE buffer 10 MM Tris-HCl - - pH 8.0
Micro tube - - Volume from 200 µL to 1.5 mL

For diluted dye solution and ladder 
solution

Sample tube or sample plate (recommended product) Sample and ladder solution vessel 
(Note *1)

MicroAmp® reaction tubes Applied Biosystems N801-0533 1 tube

MicroAmp® strip tubes
(without cap, 8 tubes/strip)

N801-0580 8-strip tubes

MicroAmp® Optical 96-well 
Reaction Plate

N801-0560 96-well PCR plate

Strips of 8 Thermo-Tubes ABgene AB-0452 8-strip tubes
Strips of 12 Thermo-Tubes AB-1112 12-strip tubes
8 Low profile Thermo-strip AB-0771 8-strip/12-strip tubes

<Note> Since there are tabs on both 
ends of the tube, they cannot be used 
on the extra sample stand.

12 Low profile Thermo-strip AB-0847

Termo-Fast® 96 PCR Plate 
Non-Skirted

AB-0600 96-well PCR plate

Adhesive PCR Foil Seals 
(Aluminum seal)

ABgene AB-0626 To avoid volatilization of the ladder and 
sample solutions, use this for analyzing 
a minimum of 13 samples with the 96-
well PCR plate.

Buffer bottle 
Recommended product:
Centrifugal tube, 5 mL, 1000/
packing

ASSIST (Sarstedt) 60.558 Extra separation buffer container (Note 
*2)

Vial
Recommended product:
Vial made of PP, 0.6 mL and 
1000/packing (without cap) 

BIO MEDICAL 
EQUIPMENT

NC-502 Extra marker solution container (Note 
*2)

Macrobiotic and tip - - Designed for volume of 0.5 µL to 5 mL
Protective glasses, protective 
mask, and protective gloves

- - -

Vortex mixer - - -
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1.8  Preparation for Analysis with the DNA-2500 Kit

1

! CAUTION

• Use the sample plate (96 well plate) to analyze 13 or more samples, and attach an 
aluminum seal.

• Use only the aluminum seal recommended in the list above.
If any other aluminum seal is used, the piercing needle may fail to penetrate, resulting in damage to 
the sample probe or other instrument problems.
Do NOT use parafilm. It may adhere to the sample probe or cause other instrument problems.

• The aluminum seal can only be used with the sample plate recommended in the list above.
Do NOT use the aluminum seal to cover sample tubes, it prevents the sample holder from being 
properly set in place.

! CAUTION

• Use only the sample tube and sample plate recommended in the list above.
Use of any other sample tube or sample plate could lead to dispensing failures of at least 5 µL.

• Do NOT cap a sample tube.
Using a capped sample tube could result damage to the sample probe, or other instrument problems.

! CAUTION

• The sample tube types shown below can be only used in the normal sample stand.
There are tabs on both ends of the tube that prevent it from being properly positioned in the extra 
sample stand.

• ABgene PCR 8-strip/12-strip tubes (low profile): Part No. AB-0771, AB-0847

! CAUTION

• Dispense to sample tube not to exceed 30 µL. Otherwise, that may be interfered with 
analysis sequence.
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1.8.2 Contents of the DNA-2500 Kit
The DNA-2500 kit (Part No. 292-27912-91) is composed of the following parts. When the kit is delivered, 
immediately open it, check the part names and quantity, and then store them at the temperatures specified 
for each part.

Fig.1-23 Contents of the DNA-2500 Kit

• Expiration dates are noted on the labels. Use the reagents in refrigerated or frozen storage before the 
expiration dates.

• Observe the laws, regulations, and rules of the country, local governing authority, or resident facility when 
discarding reagents.

@NOTE
To avoid repeated freezing and thawing of marker solutions, it is recommended that they be divided into 
small allotments for frozen storage.

No. Part Name Capacity Quantity Remarks

1 DNA-2500 separation 
buffer

30 mL 1 Refrigerated storage at 2°C to 8°C (PP bottle)
(Up to 1000 analyses)

2 DNA-2500 marker solution 1.2 mL 4 Frozen storage at -20°C (Aluminum pack)
(Up to 1000 analyses)

3 Buffer bottle (5 mL) 1 Separation buffer dispensing container (with cap)

4 Vial (0.6 mL) 2 Marker solution dispensing tube (without cap)

5 Manual - 1 -
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1.8  Preparation for Analysis with the DNA-2500 Kit

1

1.8.3 Diluted Dye Solution Preparation
Prepare SYBR® Gold solution diluted to 1/100.

@NOTE
• Restore each reagent to room temperature before use. 

• Do NOT mix reagents from different lot numbers (the lot number is noted on labels of the buffer bottles or 
mark solution aluminum packs).

• For dye handling precautions and storage conditions, see the relevant Invitrogen Co. Product Information 
and MSDS.

• To avoid repeated freezing and thawing of marker solutions, it is recommended that they be divided into 
small allotments for frozen storage. 

Requirements
• SYBR® Gold
• TE buffer
• Microtube (volume from 200 µL to 1.5 mL)
• Micro pipette
• Vortex mixer

Procedures

1 Use a micro pipette to dispense 99 µL of TE buffer to a microtube.

2 Add 1 µL of SYBR® Gold dye, and agitate the solution with the vortex mixer for at least 
10 seconds.

1.8.4 Ladder Solution Preparation
Dilute pGEM® DNA Markers (Promega Co., catalog No. G1741) to 1/100 to prepare the ladder solution.

[V1.05] 
If using an optional ladder, prepare the ladder solution by referring to "4.10 Using Optional Ladders" P.205.

Requirements
• pGEM® DNA Markers
• TE buffer
• Microtube (volume from 200 µL to 1.5 mL)
• Micro pipette
• Vortex mixer

! WARNING

• During operations, wear protective gloves, protective glasses, and a protective mask.

• See the MSDS for each reagent.
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Procedures

1 Use a micro pipette to dispense 99 µL of TE buffer to a microtube.

2 Add 1 µL of pGEM® DNA Markers, and agitate the solution with the vortex mixer for at 
least 10 seconds.

1.8.5 Separation Buffer Preparation

@NOTE
The separation buffer mixed with diluted dye solution should be used on the day it is prepared.

Requirements
• DNA-2500 separation buffer
• Diluted dye solution ("1.8.3 Diluted Dye Solution Preparation" P.51)
• Buffer bottle
• Micro pipette

Procedures

1 Dispense the separation buffer included in the DNA-2500 kit into the buffer bottle, and 
use the micro pipette to add the diluted dye solution.
• Ensure that the volume of the mixed solution exceeds the required volume displayed in the [Reagent 

Information] window.
• Add the diluted dye solution until it reaches a volume ratio of 1/100 to the separation buffer transferred 

to the buffer bottle. For example, if the volume requirement is 1000 µL, add 10 µL of diluted dye 
solution to 990 µL of separation buffer.

Refer to the table below and use a micro pipette to dispense the separation buffer and diluted dye solution 
in the amounts required for the number of analyses (total ladders and samples) into the buffer bottle. 

Guidelines for Required Amounts of Separation Buffer and Diluted Dye Solution

@NOTE
The required amount of separation buffer is about 20 µL per analysis. The amounts described below 
are included in the required volumes indicated in [Reagent Information] and in the above guidelines.

• Amount needed for retries (up to 2 retries) if a problem is detected when automatically adding 
separation buffer to the microchip

• Dead volume of buffer bottle

• Minimum bottle amount detectable by a level sensor

@NOTE
The reagent kit contains 30 mL of separation buffer (for 1000 analyses). The total number of 
analyses will be less than 1000 in situations where the number of analyses for each sequence is 
small, because the redundant amounts will be larger.

Number of analyses (Total 
ladders and samples)

Amount of separation 
buffer

Amount of diluted dye 
solution

Amount of mixed 
solution

8 analyses or less 495 µL 5 µL 500 µL
9 to 29 analyses 990 µL 10 µL 1000 µL

30 to 79 analyses 1980 µL 20 µL 2000 µL
80 to 120 analyses 2970 µL 30 µL 3000 µL
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1.8  Preparation for Analysis with the DNA-2500 Kit

1

2 Cap the bottle, and agitate the solution with the vortex mixer for at least 10 seconds.

3 Remove the cap and put the bottle in the purple reagent holder position (color code for 
DNA-2500 kit).

@NOTE
Let the solution adhering to the inner sides of the buffer bottle settle, and use a micro pipette to 
remove any residual bubbles before placing the tube in the reagent holder.

@NOTE
Move the bottle around to ensure that the bottom of the buffer bottle is in the correct position at the 
bottom of the reagent holder.

Fig.1-24 DNA-2500 Separation Buffer in Reagent Holder

! CAUTION

• Remove the cap from the buffer bottle before placing it in the reagent holder.
The sample probe may be damaged.
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1.8.6 Ladder, Sample and Marker Solution Usage
Insert the tubes into the positions specified in the analysis schedule.

@NOTE
Follow these precautions to prevent volatilization of solution, and to confirm the minimum amount of 
dispensable solution.

• When total number of ladders or samples to be analyzed is 12 or less

No aluminum seal is needed to prevent volatilization, and the recommended 8-strip or 12-strip 
sample tubes can be used. Dispense a minimum of 9 µL into each tube.

• When the number of ladders or samples is 13 or more

Use the 96-well sample plate, and the recommended aluminum seal. Dispense a minimum of 6 µL 
(premix) or 5 µL (on-chip mix) into each well. 

• When the same ladder or sample is analyzed multiple times

Use the recommended 8-strip or 12-strip sample tubes without an aluminum seal, and place it in the 
extra sample stand (X1 to X12). Since the amount of solution dispensed to each tube differs 
between premix and on-chip mix, see the respective descriptions for those items.

@NOTE
When the prepared sample is expected to exceed the quantitative range (0.5 ng/µL to 50 ng/µL) or the 
maximum salt concentration (KCI or NaCl concentration; maximum of 125 mM) for DNA samples use the TE 
buffer (pH 8.0) to dilute it prior to analysis.

For Premix
Mix the marker solution at a volume ratio of 2:1 into the ladder or sample, and place it in the instrument. 
Nothing is placed in the marker solution position.

1 Place the ladder solution and marker solution mix in the extra sample stand.
Transfer the ladder solution prepared as per "1.8.4 Ladder Solution Preparation" P.51 into the sample 
tube (or sample plate). Then, add the marker solution at a volume ratio of 2:1, and mix the solution 
thoroughly through pipetting. 
• For example, to analyze a ladder solution four times from the extra sample stand requires a minimum 

of 15 µL (3 x (4 + 1) = 15 µL). Add 10 µL of marker solution to 5 µL of ladder solution.

2 Place the sample and marker solution mix in the appropriate sample compartment.
Transfer the sample to the sample tube (or sample plate). Then, add the marker solution at a volume ratio 
of 2:1, and mix the solution thoroughly through pipetting.
• For example, for analysis of up to 12 samples, mix 6 µL of marker solution with 3 µL of sample in a 

sample tube, and place the tube in the extra sample stand.
• To analyze 13 samples or more, mix 4 µL of marker solution with 2 µL of sample in a sample plate well, 

cover it with an aluminum seal, and place the sample plate on the sample stand.

Sample stand (One analysis per well)
Number of analyses (Total 

ladders and samples) Container Amount of ladder 
or samples

Amount of 
marker solution

Amount of 
mixed solution

12 analyses or less Sample tube 3 µL 6 µL 9 µL
13 analyses or more Sample plate with seal 2 µL 4 µL 6 µL

Extra sample stand (Multiple analyses per well) 
Number of 
analyses Container Amount of ladder or 

sample
Amount of marker 

solution
Amount of mixed 

solution
1 to 4 times Sample tube 5 µL 10 µL 15 µL
5 to 9 times Sample tube 1 x (Number of 

analyses + 1) µL
2 x (Number of 

analyses + 1) µL
3 x (Number of 

analyses + 1) µL
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1.8  Preparation for Analysis with the DNA-2500 Kit

1

For On-Chip Mix
In on-chip mixes, the ladder or sample, and the marker solution, are placed into the instrument separately. 
The ladder or sample is automatically mixed with the marker solution on the microchip.

1 Place the ladder solution in the extra sample stand.
Transfer the ladder solution prepared as per "1.8.4 Ladder Solution Preparation" P.51 into the sample 
tube (or sample plate).
• For example, to analyze a ladder solution four times from the extra sample stand requires a minimum 

of 11 µL (5 + 2 x 3 = 11) of solution. Add 11 µL of ladder solution to the sample tube and place it in the 
extra sample stand.

2 Place the sample in the appropriate sample compartment.
Transfer the sample to the sample tube (or sample plate).
• For analysis of up to 12 samples, dispense 9 µL or more of sample into the sample tube, and place the 

tube in the extra sample stand.
• For analysis of 13 or more samples, dispense 5 µL or more of sample into the sample plate well, cover 

with an aluminum seal, and place the sample plate on the sample stand.

3 Dispense the marker solution.
Use a micro pipette to dispense marker solution in excess of the required amount shown in [Reagent 
Information] into a vial (PP 0.6-mL vial, no cap). 

Or use the formula below to calculate the amount of marker solution required for the number of analyses 
(samples and ladders), and use a micro pipette to dispense it to a vial (PP 0.6-mL vial, no cap).

(Amount of marker solution required) = 2 x (Number of analyses) + 40 (µL)

@NOTE
Since the minimum detectable amount using a level sensor is 40 µL, use a larger amount.

4 Put the bottle in the purple reagent holder position (color code for DNA-2500 kit).
 

Fig.1-25 DNA-2500 Marker Solution in Reagent Holder

Sample stand (One analysis per well)
Number of analyses (Total ladders 

and samples) Container Amount of ladder or sample

12 analyses or less Sample tube 9 µL
13 analyses or more Sample plate with seal 5 µL

Extra sample stand (Multiple analyses per well) 
Number of analyses Container Amount of ladder or sample

1 to 3 times Sample tube 9 µL
3 to 13 times Sample tube 5 + 2 x (Number of analyses - 1) µL
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1.9 Preparation for Analysis with the RNA Kit

1.9.1 Requirements

Part Name Sales origin Part No. 
(Catalog No.) Remarks

Microchip Type DR-C Shimadzu 
Corporation

292-27900-91 -

Reagent kit RNA Shimadzu 
Corporation

292-27913-91 -

SYBR® Green II (Note *2) Invitrogen S-7586 Diluted to 1/100

RNA6000 ladder Ambion 7152 Diluted to 1/6
formamide
Recommended product:
1)Biochemistry Deionized  or

2)UltraPure® formamide

Wako

Invitrogen

066-02301

15515-026

-

RNase ZAP® Ambion 9780 Probe rinse solution

THE RNA Storage Solution Ambion 7001 -
TE buffer 10mM Tris-HCl - - pH 8.0
Micro tube - - Volume from 200 µL to 1.5 mL

For diluted dye solution and ladder solution
Sample tube or sample plate (recommended product) Sample and ladder solution vessel (Note *1)

MicroAmp® reaction tubes Applied 
Biosystems

N801-0533 1 tube

MicroAmp® strip tubes
(without cap, 8 tubes/strip)

N801-0580 8-strip tubes

MicroAmp® Optical 96-well 
Reaction Plate

N801-0560 96-well PCR plate

Strips of 8 Thermo-Tubes ABgene AB-0452 8-strip tubes
Strips of 12 Thermo-Tubes AB-1112 12-strip tubes
8 Low profile Thermo-strip AB-0771 8-strip/12-strip tubes

<Note> Since there are tabs on both ends of 
the tube, they cannot be used on the extra 
sample stand.

12 Low profile Thermo-strip AB-0847

Termo-Fast® 96 PCR Plate 
Non-Skirted

AB-0600 96-well PCR plate

MicroAmp® Caps, 8 Caps/Strip Applied 
Biosystems

N801-0535 Cap for 1 tube and 8-strip tube (for 
prevention of volatilization of ladder and 
sample solution during thermal denaturation)

Adhesive PCR Foil Seals 
(Aluminum seal)

ABgene AB-0626 Seal for 96-well PCR plate (to avoid 
volatilization of ladder and sample solutions)

Buffer bottle 
Recommended product:
Centrifugal tube, 5 mL, 1000/packing

ASSIST 
(Sarstedt)

60.558 Extra separation buffer container (Note *3)

Vial
Recommended product:
Vial made of PP, 0.6 mL and 
1000/packing (without cap) 

BIO 
MEDICAL 
EQUIPMENT

NC-502 Extra marker solution container 
(Note *3)

Thermal cycler (oil free) - - Item that can be heated to about 65°C for 
purposes of RNA denaturation, and then 
rapidly cooled

Macrobiotic and tip - - Designed for volume of 0.5 µL to 5 mL
Protective glasses, protective mask, 
and protective gloves

- - -

Vortex mixer - - -
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@NOTE
*1) In this manual, the 0.2-mL PCR tube listed in the above table is called the sample tube, and the 96-well 

PCR plate is called the sample plate.

*2) Use SYBR® Green II for the dye. This is different from SYBR® Gold used in DNA analysis.

*3) Each RNA reagent kit includes two buffer bottles and two vials (marker solution containers). One of the 
buffer bottles is used for the probe rinse solution. If more are required, order the recommended items 
separately. 

^ Reference
"2.5.8 Wash" P.126

! CAUTION

• Use only the formamide recommended in the list above.
Since formamide decomposes easily, store it at -20°C. To avoid repeated freezing and thawing, it is 
recommended that the formamide be dispensed in 1 mL units in microtubes before being frozen. 

! CAUTION

• During thermal denaturation, use a cap for the sample tube (0.2 mL PCR tube) or an 
aluminum seal for the sample plate (96-well PCR plate).
An oil-free thermal cycler is used to thermally denature the RNA sample before analysis. It is 
necessary to cap the vial or use the aluminium seal to prevent of evaporation of the sample solution. 

• Use only the aluminum seal recommended in the list above.
If another aluminum seal is used, the piercing needle may fail to penetrate, resulting in damage to the 
sample probe or in other instrument problems.
Do NOT use parafilm. It may adhere to the sample probe or cause other instrument problems.

• The aluminum seal can only be used with the sample plate recommended in the list above.
Do NOT use the aluminum seal to cover sample tubes. It prevents the sample holder from being 
properly placed over the sample tubes. The aluminum seal can only be used with the sample plate.

! CAUTION

• Use only the sample tubes and plates recommended in the list above.
Use of another sample tube or sample plate could lead to dispensing failures of at least 5 µL.

! CAUTION

• The sample tube types shown below can be only used for setting samples into the normal 
sample stand.
There are tabs on both ends of the tube, that prevent it from being properly placed in the extra sample 
stand.

• ABgene PCR 8-strip/12-strip tubes (low profile): Part No. AB-0771, AB-0847

! CAUTION

• Dispense to sample tube not to exceed 30 µL. Otherwise, that may be interfered with 
analysis sequence.
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1.9.2 Contents of the RNA Kit
The RNA kit (Part No. 292-27913-91) is composed of the following items. When the kit is delivered, 
immediately open it, check the part names and quantity, and then store them at the temperatures specified 
for each part. 

Fig.1-26 Contents of the RNA Kit

• Expiration dates are noted on the labels. Use the reagents in refrigerated or frozen storage before the 
expiration dates.

• Observe the laws, regulations, and rules of the country, local governing authority, or resident facility when 
discarding reagents.

@NOTE
To avoid repeated freezing and thawing of marker solutions, it is recommended that they be divided into 
small allotments for frozen storage.

No. Part Name Capacity Quantity Remarks

1 RNA separation buffer 30 mL 1 Refrigerated storage at 2°C to 8°C (PP bottle)
(Up to 1000 analyses)

2 RNA marker solution 1.2 mL 4 Frozen storage at -20°C (Aluminum pack)
(Up to 1000 analyses)

3 Buffer bottle (5 mL) 2 Separation buffer dispensing container (with cap)

4 Vial (0.6 mL) 2 Marker solution dispensing tube (without cap)

5 Manual - 1 -
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1.9.3 Diluted Dye Solution Preparation
Prepare SYBR® Green II solution diluted to 1/100.

@NOTE
• Restore each reagent to room temperature before use. 

• Do NOT mix reagents from different lot numbers (the lot number is noted on labels of the buffer bottles or 
mark solution aluminum packs).

• For dye handling precautions and storage conditions, see the relevant Invitrogen Co. Product Information 
and MSDS.

• To avoid repeated freezing and thawing of SYBR® Green II, it is recommended that the solution be 
divided in small volumes (about 10 µL) and placed into microtubes. The microtubes should then be frozen 
and shielded from light.

Requirements
• SYBR® Green II
• TE buffer
• Microtube (volume from 200 µL to 1.5 mL)
• Micro pipette
• Vortex mixer

Procedures

1 Use a micro pipette to dispense 99 µL of TE buffer to a microtube.

2 Add 1 µL of SYBR® Green II dye, and agitate the solution with the vortex mixer for at 
least 10 seconds.

1.9.4 Ladder Solution Preparation
Dilute an RNA 6000 ladder (Applied Biosystems (formerly Ambion), catalog No. 7152) to 1/6 to prepare the 
ladder solution. For the amount to be prepared, see "1.9.6 Ladder, Sample and Marker Solution Usage" 
P.62.

The following procedure describes preparation of 6 µL of ladder solution. 

Requirements
• RNA6000 ladder
• THE RNA storage solution
• Microtube (volume from 200 µL to 1.5 mL)
• Micro pipette
• Vortex mixer

! WARNING

• During operations, wear protective gloves, protective glasses, and a protective mask.

• See the MSDS for each reagent.
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Procedures

1 Dispense 5 µL of THE RNA Storage Solution to a microtube.

2 Add 1 µL of the RNA 6000 ladder, use a micro pipette for repeating suction and 
discharge 5 times, and agitate the solution.

1.9.5 Separation Buffer Preparation

@NOTE
The separation buffer mixed with diluted dye solution should be used on the day it is prepared.

Requirements
• RNA separation buffer
• Formamide
• Diluted dye solution ("1.9.3 Diluted Dye Solution Preparation" P.59)
• Buffer bottle
• Micro pipette

Procedures

1 Dispense the separation buffer included in the RNA kit into the buffer bottle, and add the 
diluted dye solution and formamide.

1 Refer to the table below, and dispense the separation buffer into the buffer bottle in the required 
amounts based on the total number of analyses (ladder, sample, and blanks).

2  Add the diluted dye solution until it reaches a volume ratio of 1/80 to the separation buffer (see table 
below).

3 Add formamide until it reaches a volume ratio of 1:4 with the mixture of separation buffer and diluted 
dye solution (see table below). 

Guidelines for Required Amounts of Separation Buffer, Diluted Dye Solution, and Formamide

@NOTE
When formamide is added, the volume of the mixed solution decreases by about 10%. Ensure that 
the mixed solution volume exceeds the required volume indicated in the [Reagent Information] 
window. 

@NOTE
The required amount of separation buffer is about 20 µL per analysis. The amounts described below 
are included in the required volumes indicated in [Reagent Information] and in the above guidelines. 

• Amount needed for retries (up to 2 retries) if a problem is detected when automatically adding 
separation buffer to the microchip 

• Dead volume of buffer bottle
• Minimum bottle amount detectable by a level sensor

Number of analyses 
(Total ladders, samples, 

and blank analyses)

Amount of separation 
buffer

Amount of diluted dye 
solution Amount of formamide

6 analyses or less 395 µL 5 µL 100 µL
7 to 15 analyses 632 µL 8 µL 160 µL

16 to 22 analyses 790 µL 10 µL 200 µL
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@NOTE
The reagent kit contains 30 mL of separation buffer (for 1000 analyses), the total number of analyses 
will be less than 1000 in situations where the number of analyses for each sequence is small, 
because the redundant amounts will be larger.

2 Cap the bottle, and agitate the solution with the vortex mixer for at least 10 seconds.

3 Remove the cap and place the bottle in the peach reagent holder position (color code 
for RNA kit).

@NOTE
Let the solution adhering to the inner sides of the buffer bottle settle, and use a micro pipette to 
remove any residual bubbles before placing it in the reagent holder.

@NOTE
Move the bottle around to verify that the bottom of the buffer bottle is in the correct position at the 
bottom of the reagent holder.

Fig.1-27 RNA Separation Buffer in Reagent Holder

! CAUTION

• Remove the cap from the buffer bottle before placing it in the reagent holder.
The sample probe may be damaged. 
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1.9.6 Ladder, Sample and Marker Solution Usage

• For RNA analysis, analyze a blank in each microtube before analyzing the ladder. 

^ Reference
"1.5.9 Creating a Sample Sheet and Entering It into an Analysis Schedule", step "6" P.29

• For RNA analysis, only the premix mode is used for mixing the marker solution. Nothing has to be placed in 
the marker solution position.

• Add an equal amount of marker solution into each of the sample, ladder and THE RNA Storage Solution 
(blank) vials. Perform thermal denaturation before placing the sample tubes into the instrument. Cap the 
sample tube (aluminum seal on the sample plate) to prevent volatilization during thermal denaturation.

• Place the samples into the positions specified in the analysis schedule.

@NOTE
Follow these precautions to prevent evaporation, and to confirm the minimum amount of dispensable 
solution.

• Normal samples

Use the 96-well sample plate, and the recommended aluminum seal. Dispense a minimum of 6 µL 
into each well.

• Multiple analysis of ladders, samples, and blanks

Use the recommended sample tube without an aluminum seal in the extra sample stand (X1 to X12). 
At least 3 x (Number of analyses + 1) µL of solution is required for each container.

@NOTE
When the prepared sample is expected to exceed the quantitative range (Total RNA of 25 ng/µL to 
500 ng/µL, mRNA of 25 ng/µL to 250 ng/µL) or the maximum salt concentration (Tris concentration 10 mM 
and EDTA concentration 1 mM) for RNA samples, use THE RNA Storage Solution to dilute it prior to 
analysis.

! CAUTION

• Use the table below as a guide for determining the number of RNA samples that can be 
entered into a single analysis.
The sample stand has no cooling function. To maintain the denatured state of RNA samples, use the 
table below to determine the number of samples that can be entered into a single analysis based on 
the number of microchips used.

Number of 
microchips used Number of samples Ladder analysis Blank analysis Total number of 

analyses
1 1 to 6 1 1 8 max.
2 2 to 12 2 2 16 max.
3 3 to 16 3 3 22 max.
4 4 to 14 4 4 22 max.

Sample stand (One analysis per well)

Container Amount of ladder, 
sample, or blank

Amount of marker 
solution

Amount of mixed 
solution

Sample tube 4.5 µL 4.5 µL 9 µL
Sample plate with seal 3 µL 3 µL 6 µL

Extra sample stand (Multiple analyses per well) 
Number of 
analyses Container Amount of ladder or 

sample
Amount of marker 

solution
Amount of mixed 

solution
1 to 4 times Sample tube 7.5 µL 7.5 µL 15 µL
5 to 9 times Sample tube 1.5 x (Number of 

analyses + 1) µL
1.5 x (Number of 
analyses + 1) µL

3 x (Number of analyses 
+ 1) µL
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1 Mix the ladder solution and marker solution.
Transfer the ladder solution prepared as per "1.9.4 Ladder Solution Preparation" P.59) into the sample 
tube (or sample plate). Then, add an equal amount of marker solution, and mix the solution thoroughly 
through pipetting.
• For example, to analyze a ladder solution four times from the extra sample stand requires a minimum 

of 15 µL 3 x (4 + 1) = 15. 7.5 µL of marker solution is added to 7.5 µL of ladder solution.

2 Mix the sample and marker solution.
Transfer the sample to the sample plate (or sample tube). Then, add an equal amount of marker solution, 
and mix the solution thoroughly through pipetting.
• For normal analysis, dispense 3 µL of marker solution and 3 µL of sample into a sample plate to mix 

them, and cover the sample plate with an aluminum seal.

3 Mix the THE RNA Storage Solution and marker solution.
Transfer THE RNA Storage Solution for blank analysis to the sample plate (or sample tube). Then, add an 
equal amount of marker solution, and mix the solution thoroughly through pipetting.
• For example, to analyze blank four times from the extra sample stand requires a minimum of 15 µL 

(3 x (4 + 1) = 15). 7.5 µL of marker solution is added to 7.5 µL of THE RNA Storage Solution.

4 Immediately before analysis, use the oil-free thermal cycler to perform thermal 
denaturation.
Use a cap on the sample tube (or aluminum seal on the sample plate) to prevent evaporation of the mixed 
solution, (see "1.9.1 Requirements" P.56).
The thermal cycler temperature conditions are as follows.
65°C, 5 minutes -> 4°C, 5 minutes

@NOTE
After performing thermal denaturation at 65°C for 5 minutes, allow for cooling inside the thermal 
cycler at 4°C for 5 minutes. (Do NOT freeze the solution immediately after thermal denaturation at 
65°C.)

5 Place the sample plate (or sample tube with cap removed) into the sample stand (or 
extra sample stand). 
Use the positions specified in the analysis schedule.

! CAUTION

• Remove the cap used for thermal denaturation before placing the sample tubes into the 
sample stand (or extra sample stand).
Analysis with the cap attached may result in damage to the sample probe, or in other instrument 
problems.
It is not necessary to remove the aluminum seal before placing the sample plate on the sample stand.
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1.10 Analysis

1.10.1Sample Holder Installation
The sample holder is placed over the sample tube (or sample plate) to secure them to the sample stand or 
extra sample stand.

Use the following procedure to install the sample holder.

1 Examine the orientation of the sample holder.
Position the sample holder so that the holes in the sample holder match those of the sample stand (96-
well) and extra sample stand (12-well).

Fig.1-28 Sample Holder

2 Insert the front side of the sample holder between the extra sample stand and the metal 
rod (behind the metal rod.)

Fig.1-29 Front of the Sample Holder

! CAUTION

• Always use a sample holder.
Failure to use a sample holder will result in a stop error and analysis will not start.

• Install the sample holder so that it presses down on the sample tube (or sample plate).
Starting the instrument when the sample holder is improperly installed (elevated) may cause 
instrument damage.

Front
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3 Insert the back side of the sample holder in front of the metal rod between the sample 
stand and reagent holder.
Use the procedure shown in Steps 1 to 3 in the figure below.

Fig.1-30 Installing the Sample Holder

4 Apply downward pressure on the four corners of the sample holder, and verify that it is 
securely installed (not loose) over the sample stand and extra sample stand. 

Fig.1-31 Checking the Sample Holder Installation

Front

2

3

1
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1.10.2Starting the Analysis

1 Verify that the chip cover is closed.

^ Reference
"1.5.5 Microchip Installation" P.16

2 Ensure that the ladder or sample solution, separation buffer, marker solution (for on-
chip mix), and rinse solution are all properly positioned in the instrument.

Fig.1-32 DNA-1000 Kit (On-Chip Mix Mode), Sample Plate with Aluminum Seal 

3 Close the top cover. 

Fig.1-33 Closing the Top Cover
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4 Verify that the rinse water level is sufficient, especially for first time use or use after the 
instrument has remained idle for a long period. Initiate the Probe Rinse function before 
starting analysis.
On the MultiNA Control Software [Instrument] pull-down menu, select [Probe Rinse] and then [Wash] to 
initiate the Probe rinse function.

^ Reference
"2.5.8 Wash" P.126

5 Either select [Start] on the MultiNA Control Software [Analysis] pull-down menu, or click 
the  [Start] button on the toolbar.
Before starting analysis, the instrument automatically checks the following items. If no problems are 
found, the instrument proceeds to Step 6 and starts the analysis schedule. If a problem is detected, an 
error message is displayed and analysis is not started.
• Chip cover is closed.
• Top cover is closed.
• Sample holder is properly installed.
• Microchip is installed in the specified chip position.
• A sufficient volume of separation buffer and marker solution are correctly positioned in the reagent 

holder.
• The chip stage is at the set temperature.

For example, if the amount of separation buffer or marker solution (for on-chip mix only) is detected to be 
less than the necessary amount, the following message is displayed. 
If this message is displayed, click [OK], add the necessary amount of reagent, and restart the analysis 
from Step 5.

 

@NOTE
Do NOT step away from the instrument while these pre-analysis checks are in progress since an 
error message may be displayed.

6 After analysis starts, you can check the instrument analysis status in the window.
• The status of analysis, such as waiting, analyzing, normal end, and abnormal end, is shown in colors in 

the well display on the left and the schedule list on the right. 
• The status bar at the bottom of the window shows the content of the latest instrument action, and the 

expected time remaining to the end of the analysis. 
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@NOTE
The expected time remaining includes the automatic rinsing time after completion of analysis (see 
"1.10.4 Ending Analysis" P.69).

Either select [Chip Status] on the [View] pull-down menu, or press the [F8] key to switch between the 
[Reagent Information] window (top figure) and [Chip Status] window (bottom figure).

[V1.05] 
The window will automatically switch to the [Chip Status] window when starting to fill the first sample.

The voltage, current, and electropherogram are displayed in real-time for each microchip port (see "2.1.8 
Chip Status Window" P.88).

Well status display Status display in analysis 
schedule list State

Green Waiting State before pretreatment process on microchip (such 
as filling the separation buffer) 

Light blue Filling Currently filling separation buffer into microchip
Blue (blinking) Loading Currently loading the sample
Blue (blinking) Analyzing Currently analyzing the sample (separation analysis)

Blue Normal analysis end Analysis has ended normally
Red Abnormal end An error occurred, or analysis was interrupted
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1.10.3 Interrupting Analysis
To interrupt the analysis, either select [Stop] on the [Analysis] pull-down menu, or click the  [Stop] 
button on the toolbar.

^ Reference
"2.6.2 Stop" P.128

1.10.4Ending Analysis
The instrument automatically performs microchip rinsing and other posttreatment functions at the 
completion of the analysis sequence. Then the instrument stops.

@NOTE
When RNA analysis ends or is interrupted, it is recommended that [RNase removal washing] also be 
performed on the sample probe as per "2.5.8 Wash" P.126 after automatic rinsing is completed.

1.10.5Treatment after Analysis End

Removing the current containers
Remove the buffer bottle, marker solution vial (on-chip mix), and ladders or samples from the instrument.

Discarding waste fluid

Use the cartridge below for SYBR dye absorption in the waste container. 
• boNd EX Starter Kit: Nippon Genetics (Catalog No. 740701)

! CAUTION

• During removal, avoid spilling any residual solution.
Lift the buffer bottle from the reagent holder.

! CAUTION

• Discard waste fluid on a regular basis to keep the bottle from overflowing.

• Treat the waste fluid appropriately in accordance with prescriptions or guidelines from the 
applicable management department.
In addition to rinse water, waste fluid includes the separation buffer, marker solution, and dye. It will 
also contain formamide from RNA analysis.
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Rinsing the microchips
The microchips are automatically rinsed and can remain installed in the instrument after the normal 
conclusion of analysis.

However, if the “Remove all chips and immediately wash them” error message is displayed, manually rinse 
the microchips as instructed in section -Instrument and System- "6.2.7 Microchip Reservoirs".

(For details about error messages, see -Instrument and System- "9.2 Error Messages".)

“Remove all chips and immediately wash them” message

• Analysis has ended without the microchips being rinsed because an error occurred during analysis. 
• Immediately proceed to manual rinsing of the microchips to avoid clogs from dried separation buffer. 

Refer to section -Instrument and System- "6.2.7 Microchip Reservoirs".

“Chip # has an error” message

Click [OK] to display the message “Error occurred. Chip # is now unavailable”.
• Automatic washing that includes the designated microchip has been completed in the instrument. 
• Since the microchip of the displayed # (No.) is clogged or partially clogged, manually rinse it and check to 

see if it is clogged. If it is clogged, replace it with a new one.

^ Reference
-Instrument and System- "6.2.7 Microchip Reservoirs"

Preparation for long idle periods
If the instrument is not to be used for a long period (two weeks or more), clean the rinse water tubing and 
the microchips, and properly store the microchips.

^ Reference
-Instrument and System- "7.1 Moving or Storage Preparations", "7.3 Storage"
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1.11 Data Analysis
This section describes the method for using the MultiNA Viewer software to display and reanalyze data 
after sample analysis.

1.11.1Displaying the Data

1 Select [Data File] on the [View] pull-down menu of the MultiNA Control Software.

(Or click the  [Display Data File] button on the right end of the toolbar, or, press the [F12] key to 
perform the same operation.)
The MultiNA Viewer software starts and automatically displays the data file in the sample sheet.

@NOTE

If the  [MultiNA Viewer] icon on the desktop is used to open the software, the data file is not 
automatically displayed. To open the data file, select [Open] on the MultiNA Viewer [File] pull-down 
menu, then specify the data file (see "3.2.1 Open" P.143).

1 5

789 6

42 3
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2 Verify that the analysis ended normally.
In well display 4, the analysis status determines the display colors, as shown below. 
• Sample analyzed normally: Blue
• Sample with Warning: Yellow
• Sample with Error (and Fatal): Red

@NOTE
• When Warning, and Error or Fatal, appear simultaneously, the status color is red. 

• If multiple analyses were performed on the extra sample stand (X1 to X12), the yellow or red 
display color will appear if even one Warning, Error or Fatal, is generated.

^ Reference
For information about Warning or Error, see -Instrument and System- "9.2 Error Messages".

3 Display the ladder and sample data.
The ladder display color at the top of the gel image 5 is light green, while the sample color is gray. 
• For the ladder used in sample analysis, # mark (above the check box) and a chip position number are 

displayed. In the figure below, the circled #4 shows that the ladder was used for analysis at chip 
position 4. 

• Either click one well in the well display 4, one sample name in the sample name tree 3, or data in the 
gel image 5 to focus on the data (becomes circled in red) and display the corresponding 
electropherogram (single). 

^ Reference
"3.1.3 Focused data and selected data" P.134

No. Name Reference Page
1 Pull-down menu "3.1.1 Pull-down Menu List" P.132

2 Toolbar "3.1.2 Toolbar" P.134

3 Sample Name tree "3.1.5 Sample Name Tree" P.135

4 Well display "3.1.3 Focused data and selected data" P.134

5 Gel Image "3.1.6 Gel Image" P.135

6 Status Bar "3.4.3 Status Bar" P.165

7 Electropherogram (Multi) "3.1.10 Electropherogram (Multi)" P.142

8 Electropherogram (Single) "3.1.9 Electropherogram (Single)" P.140

9 Peak Table "3.1.7 Peak Table" P.139
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• Information about each sample is displayed in the sample name tree. For example, [(1)X1-1: 25bp 
ladder] In the figure below indicates as follows: [(1)]: Order of analysis, [X1-1]: First analysis for well 
X1, [25bp ladder]: Sample name entered in sample sheet 

• The peak table 9 displays the peak detection and analysis results for the sample being focused on.

^ Reference
Items displayed in the peak table can be changed. See "3.4.12 Options" P.174.

1.11.2Data Examination and Reanalysis
Inspect the electropherograms of all of the ladders and samples included in the data file.

1 Examine the detected peak numbers in the ladder and sample data.
Evaluate the electropherograms of all of the ladders and samples.
• The peak detection level in automatic analysis is classified into three categories, [Coarse], [Standard], 

and [Fine], according to the peak height and width at the lower detection limit. [Standard] analysis is 
performed immediately after the analysis completion.

• For detection for smaller peaks, use the [Reanalysis] pull-down menu and point to [Automatic] and 
then select [Fine] on the [Reanalysis] pull-down menu. Perform reanalysis. Select [Coarse] for 
detection of larger peaks, and perform reanalysis.”

^ Reference
"3.7.1 Automatic" P.183

2 Check the ladder data.

@NOTE
Accurate ladder analysis is necessary for obtaining highly precise results for size prediction and 
concentration quantitation. Use the procedure below to check all ladder data that has been obtained.

1 Refer to the recommended ladder data examples below to verify that ladder analysis has been 
performed correctly for each kit.
• Each fragment peak in the ladder must be separated as in the data examples. 
• Each marker peak must be correctly detected. 
• The size number must be displayed correctly for each fragment peak in the ladder.

@NOTE
Lower markers are displayed as LM, while upper markers are displayed as UM. 
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DNA-500 kit

DNA-1000 kit

No. Explanation
1 Lower marker (Magenta arrow displayed on upper part)

2 Upper marker (Blue arrow displayed on upper part)

3 25 bp to 500 bp peaks included in ladder
25 bp, 50 bp, 75 bp, 100 bp, 125 bp, 150 bp, 175 bp, 200 bp, 225 bp, 250 bp, 275 bp, 300 bp, 
325 bp, 350 bp, 375 bp, 400 bp, 425 bp, 450 bp and 500 bp; 19 peaks in total

4 125 bp peak is divided into 2 at front edge. While this is derived from the 25 bp DNA ladder 
components, it is recognized as one peak in the data analysis. 

5 2652 bp peak detected after upper marker. It will cause no problem with the analysis. 

No. Explanation
1 Lower marker (Magenta arrow displayed on upper part)

2 Upper marker (Blue arrow displayed on upper part)

3 72 bp to 1353 bp peaks included in ladder
72 bp, 118 bp, 194 bp, 234 bp, 271 bp, 281 bp, 310 bp, 603 bp, 872 bp, 1078 bp, and 1353 bp; 11 
peaks in total 

1 234 5

21 3
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DNA-2500 kit

@NOTE
While fragment peaks of less than 65 bp are detected, these are not used for preparation of size 
calibration curves.

RNA kit

No. Explanation
1 Lower marker (Magenta arrow displayed on upper part)

2 Upper marker (Blue arrow displayed on upper part)

3 65 bp to 2645 bp peaks included in ladder
65 bp, 75 bp, 126 bp, 179 bp, 222 bp, 350 bp, 396 bp, 460 bp, 517 bp, 676 bp, 1198 bp, 1605 bp, 
and 2645 bp; 13 peaks in total

No. Explanation
1 Lower marker (Magenta arrow displayed on upper part)

(Note: The RNA marker solution does not include a upper marker)
2 200 nt to 6000 nt peaks included in ladder

200 nt, 500 nt, 1000 nt, 2000 nt, 4000 nt and 6000 nt; 6 peaks in total

1 23

1 2
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2 If a ladder has not been correctly analyzed, see the following page to perform reanalysis.
• When lower markers or upper markers are not being correctly detected

Set the correct marker peak in [Manual Edit Mode] on the [Reanalysis] pull-down menu. 

^Reference
[Set to Lower Marker]/[Set to Upper Marker] in "3.7.2 Manual Edit Mode" P.184

• When fragment peaks are not being correctly detected
Set the correct fragment in [Manual Edit Mode] on the [Reanalysis] pull-down menu. 

^Reference
[Add Peak]/[Delete Peak] in "3.7.2 Manual Edit Mode" P.184

• When the separation pattern is not normal
Change the ladder, and proceed with analysis. 

^Reference
"3.7.3 Change Ladder and Analyze" P.189

3  When correct analysis data has been obtained for all samples, select [Save] on the [File] pull-down 
menu. 

^Reference
"3.2.3 Save" P.145

3 Check the sample data.

1 Click the sample data item one at a time, to focus. 
2 Check that the marker and fragment peaks are correctly detected. If not correctly detected, use the 

following method to perform reanalysis. 
• When lower makers or upper markers are not being correctly detected

Set the correct marker peak in [Manual Edit Mode] on the [Reanalysis] pull-down menu. 

^Reference
[Set to Lower Marker]/[Set to Upper Marker] in "3.7.2 Manual Edit Mode" P.184

• When the necessary peak is not being detected
On the [Reanalysis] pull-down menu, select [Manual Edit Mode] and point to [Add Peak] to add a 
peak. 

^Reference
[Add Peak] in "3.7.2 Manual Edit Mode" P.184

• When an unneeded peak should be deleted
On the [Reanalysis] pull-down menu, select [Manual Edit Mode] and point to [Delete Peak] to 
delete the peak. 

^Reference
[Delete Peak] in "3.7.2 Manual Edit Mode" P.184
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@NOTE
In automatic analysis, peaks detected before the lower marker and peaks detected after the upper 
marker are not recognized as peaks. While such peaks can be recognized by selecting [Manual Edit 
Mode] and then [Add Peak] on the [Reanalysis] pull-down menu, the accuracy of analysis results 
cannot be guaranteed since these peaks fall outside of the markers in the size calibration curve. 

3 If correct analysis data has been obtained for all samples, select [Save] on the [File] pull-down 
menu. 

^Reference
"3.2.3 Save" P.145

4 Check the peak table and RNA report (for RNA analysis only). 
Items displayed in the peak table can be selected from among the following by selecting [Options] on the 
[View] pull-down menu. 

^ Reference
"3.4.12 Options" P.174

DNA data
[Size], [Concentration], [Migration Index], [Height], [Area], and [Molarity] 
(For the lower marker and upper marker, “LM” or “UM” is displayed respectively in the [Size] column. 
[Concentration] and [Molarity] are not displayed for them.)

Data of RNA
[Attribute], [Concentration], [Migration Index], [Height, Area], [Peak Start Index], and [Peak End 
Index]
(For the lower marker, [Attribute] (property) is displayed while [Concentration] is not displayed.)

In RNA analysis, the peak table and the RNA report tab are displayed. 
The RNA report displays the calculated [Total Area] and [Total Concentration] results. In addition, the Total 
RNA analysis calculates and displays the [Ratio of 28S/18S rRNA]. 
The following shows examples of a peak table (DNA analysis) (left) and RNA report (right). 
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@NOTE
If multiple ladders were analyzed on the same microchip, only the ladder data generated 
immediately before the sample will be used for data analysis (see the gel image in the figure below).

In the four microchip example below, 2 ladder analyses, 1 sample analysis, 1 ladder analysis and 1 
sample analysis are performed. The relationship between the ladders and samples used in the 
analysis is as shown in the table below. The ladder data from (1) X1-1 to (4) X-4 is not used in the 
analysis. For samples (9) A1 to (13) A4, the ladder data immediately before their analyses is (5) X1-
5 to (8) X1-8, and these are ladders used in the analysis. For samples (17) B1 to (20) B4, the ladder 
data immediately before their analyses is (13) X2-1 to (16) X2-4, and these are ladders used in the 
analysis.

Sample Ladder used in analysis Chip position
(9) A1 (5) X1-5 1

(10) A2 (6) X1-6 2
(11) A3 (7) X1-7 3
(12) A4 (8) X1-8 4
(17) B1 (13) X2-1 1
(18) B2 (14) X2-2 2
(19) B3 (15) X2-3 3
(20) B4 (16) X2-4 4
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1.11.3Printing the Data
Print the electropherogram, gel image, and analysis results. 

1 In the gel image, select the check boxes on the data to be printed.

@NOTE
If printing all of the data, this procedure is not necessary. 

2 Either select [Print] on the [File] pull-down menu, or click the [Print] button on the 
toolbar. 

3 Use the [Print] dialogue box to select the layout to be printed.
Multiple layouts may be selected.

4 Select [All] or [Selected] on the [Range] menu.
[Selected] indicates data that has been selected on the gel image or the electropherogram (multi). 

5 Click [Print] to start printing. 

^ Reference
For details about printing, see "3.2.8 Print" P.152.
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1.11.4Differences Between Analyzed Data and Raw Data
The MultiNA Viewer software can display two kinds of data, analyzed data and raw data (Refer to "3.4.5 
Analyzed Data/Raw Data" P.166). Normally, when a data file is opened, the analyzed data is displayed.

• Raw data includes the detected signals saved without alteration. Analyzed data is based on the raw data. It 
includes the migration time index calculated based on the marker detection time, and the fragment size 
prediction value and concentration obtained after baseline correction.

The differences between analyzed data and raw data are detailed in the table below.

@NOTE
• The units for the calculation of area differs between the analyzed data and raw data. For analyzed data, 

the horizontal peak axis indicates the value converted to migration distance (unit: µm). For raw data it 
indicates the migration time (unit: sec). The peak height for both indicates signal strength (unit: mV).

• The migration index is a relative index value of the electropherogram time axis based on the marker 
detection time. In DNA analysis, the lower marker and upper marker detection times are set to 0% and 
100%, respectively. In RNA analysis, the lower marker and electropherogram end point are set to 0% and 
100%, respectively. If the lower marker was not detected, the electropherogram start point is set to 0%. In 
addition, in DNA analysis, if the upper marker was not detected, the electropherogram end point is 100%.

• When a data file is opened in the default display, the migration index is indicated on the horizontal axis in 
the electropherogram, while the distance image is indicated on the vertical axis in the gel image.

Item Analyzed data Raw data

Peak table From the [Display] menu select [Option] and 
designate the desired display items.
Peak width (value converted to distance axis, 
unit: µm) and height (mV) are used to calculate 
[Area].

Display items include time (sec), height (mV) 
and area (mV•µm) only. 
[Area] is calculated from peak width (sec) and 
height (mV). 

Electropherogram 
horizontal axis

Migration index (Based on the marker detection 
time, it is expressed as a relative index value.)
• In DNA analysis, the lower marker and upper 

marker detection times are set to 0% and 
100%, respectively. 

• In RNA analysis, the lower marker detection 
time is set to 0%, and the electropherogram 
end point is set to 100%.

You can also select [Migration Time] on the 
[Electropherogram] menu to display the 
migration time. 

Migration time (sec)

Electropherogram 
vertical axis

Height (mV) obtained after baseline correction 
on the signal detected with PMT. 

Signal strength (mV) detected with PMT. 

Gel image Distance image display (default)
You can also select [Time Image] on the [Gel 
Image] menu to display the time image before 
conversion to the distance image. 
The vertical axis scale always indicates the size. 

The vertical axis indicates the migration time 
(sec).

Reanalysis All items on the [Reanalysis] menu can be 
executed. 

Automatic reanalysis can be executed by 
selecting [Automatic] on the [Reanalysis].
[Change Ladder and Analyze] and [Manual 
Edit Mode] on the [Reanalysis] menu cannot 
be executed. 
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1.11.5Saving the Data
Data files automatically created in the instrument are as follows.

• To display the data in MultiNA Viewer, specify a raw data file (MLT file) (Refer to "3.2.1 Open" P.143). 
Analyzed data (MLA file) is automatically displayed at the same time.

• Files are created for each sample sheet and contain the analysis data for normal samples.
• Files are also created for each ladder analysis (ladder data: LDR file). This data is used for reanalyzing the 

data after the ladder has been changed (Refer to "3.7.3 Change Ladder and Analyze" P.189).
• Data folders are specified when the program is installed. The default location is C:\MultiNA (Refer to section 

-Instrument and System- "5.5.1 Installation".

• In the MultiNA - Project folder, a folder is created for each created project, within which acquired data 
(extension MLT, MLA), etc., is saved. 

Type File name (Base 
name) Extension Folder saved

Raw data Name specified at time 
of sample sheet 
creation

MLT Folders are created for each project in the project folder 
located inside the data folder (normally, C:\MultiNA\). Raw 
data is saved within these folders. 

Analyzed 
data

Same as raw data MLA Saved in the same folder as the raw data. 

Ladder data Number identifying date 
and time of analysis 
start

LDR Folders are created for each chip ID used in the Ladder 
folder located inside the data folder (normally, C:\MultiNA\). 
Within these folders, folders are further saved according to 
the separation buffer, ladder, marker solution mix mode, and 
chip position. 

Analytical 
performance 
check results

Same as raw data LOG Saved to the [(Reagent Kit Name)] folder in the Project folder 
located inside the data folder (Normally, C:\MultiNA\). 
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• In the MultiNA - Ladder folder, ladder data that is automatically created when data was analyzed is saved 
(extracted to one file for each ladder). Folders are created as follows, based on the conditions where the 
ladder is acquired, and the ladders are categorized and saved in these folders.

[Chip ID] (ND058-2, etc.)

- [Kind of reagent kit] (DNA-500/DNA-1000/DNA-2500/RNA)
- [Ladder type ID] (Normally, Standard only)

- [Method of mixing the marker] (Premix/On-chip)
- [Chip position] (ChipPosition1/ChipPosition2/ChipPosition3/ChipPosition4)

Data arrangement and backup
Guidelines for data file size are as follows. 

• MLT file: 96 sample data, about 6 MB
• MLA file: 96 sample data, about 3 MB
• LDR file: 1 Ladder data, about 100 KB
• LOG file: 1 kit, 4 microchip data, about 3 KB

Therefore, since analysis for 96 samples requires a hard disk capacity of about 10 MB, periodically arrange 
and back up data to ensure that sufficient hard disk capacity is available during analysis.

@NOTE
The MLT and MLA file for the each analysis should be copied and moved to the same folder.

• MLA files include automatically analyzed results and manually edited results.

• If no MLA file exists, select [Automatic] on the [Reanalysis] menu to re-create the automatic analysis data. 
However, if manually edited results exist for this file, the data is overwritten.

@NOTE
Since the hierarchy of the folders into which LDR files are saved is complicated, and a considerable number 
of files are likely to be created, it is recommended that each ladder folder be compressed, copied and 
moved.
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2

2MultiNA Control 
Software Functions

2.1 Explanation of Windows
Main Window (Displayed during analysis)

No. Name Reference

1 Pull-down menu "2.1.1 Pull-down Menu List" P.84

2 Toolbar "2.1.2 Toolbar" P.85

3 Well Status Display "2.1.3 Well Status Display" P.85

4 Analysis Schedule List "2.1.4 Analysis Schedule List" P.86

5 Detect Remaining Reagent Amount button "2.1.5 Detect Remaining Reagent Amount Button" P.86

6 Reagent Information "2.1.6 Reagent Information" P.87

7 Status Bar "2.1.7 Status Bar" P.87

1 3 2

7 6 5 4
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2.1.1 Pull-down Menu List

Menu item Functional overview Shortcut 
key

Reference 
page

Sample 
Entry

New Creates a new sample sheet to be analyzed F5 P.89

Add Adds another sample sheet to an open analysis 
schedule.

F6 P.101

Exit Closes the MultiNA Control Software. P.102

Edit Project Settings Create and edit a project F7 P.103

Edit Sample Sheet Edits a sample sheet that is included in the open 
analysis schedule.

P.107

Delete Sample Sheet Deletes a sample sheet from an open analysis 
schedule

P.108

Copy Copy range selected from analysis schedule to 
clipboard

Ctrl + C P.109

View Chip Status Displays the electropherogram and current voltage 
for each microchip

F8 P.110

Data File Opens the MultiNA Viewer software and displays the 
selected data file.

F12 P.111

Log Display event log P.111

Instru-
ment

Connect Connect to or disconnect from instrument P.113

Options Optional settings for instrument and displays P.114

Chip Management Opens the [Chip Management] window where, 
microchips can be selected, deselected or changed.

P.115

Detect Remaining 
Reagent Amount

Check residual amounts of separation buffer and 
marker

P.118

Move All Axes to 
Home Position

Moves all of the drive axes to their home position. P.119

Check Analysis 
Performance

Closes the current analysis schedule and opens an 
inspection schedule.

P.120

Parts Maintenance Control replacement parts and execute check 
program after replacement

P.125

Wash Wash (rinse) microchips and probes
Execute RNase removal and rinsing

P.126

Periodic Maintenance Peristalic pump maintenance when the instrument is 
out of use for an extended period.

P.126

Analysis Start Starts the analysis schedule. F9 P.127

Stop Stop the analysis schedule F10 P.128

Help Quick Start Manual Display the operations flow (Operating Procedure 
P2 to P3)

F1 P.128

Instrument Manual Display the Instrument Manual (Instrument and 
System)

Operation Manual Display the Instruction Manual (Operating 
Procedure)

About MultiNA Display the version information of the program P.129
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2.1.2 Toolbar

2.1.3 Well Status Display
The well status is displayed as follows, depending on the status of the corresponding sample. 

• White:  Sample not registered
• Green:  Sample registered, not yet analyzed
• Light blue:  Separation buffer now filling
• Light blue/Blue blinking:  Sample loading/Analyzing
• Blue:  Analysis has ended normally
• Red:  Analysis has ended abnormally

@NOTE
When multiple analyses are performed on a sample in the extra sample stand, the status of the sample is 
displayed. The display becomes red if any one of the multiple analyses ends abnormally.

No. Explanation

1 Instrument name: Instrument name entered in option setting ([Instrument] - [Options] - [General]). The text 
color expresses the state, as follows.
• Light blue: Connected to instrument
• Pale orange: Disconnected from instrument
• Light blue: Analyzing
• Red: Error occurred

2 [New] button ([Sample Entry] - [New])

3 [Add] button ([Sample Entry] - [Add])

4 [Start] button ([Analysis] - [Start])

5 [Stop] button ([Analysis] - [Stop])

6 [View Data File] button ([View] - [Data File]): Start MultiNA Viewer

1 2 3 4 5 6
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2.1.4 Analysis Schedule List
Displays the sample information entered in the analysis schedule and the sample status.

The column display can be changed by selecting [Options] on the [Instrument] menu and then selecting the 
[Column Selection] tab.

2.1.5 Detect Remaining Reagent Amount Button
Click this button before starting an analysis schedule to determine the residual amount of separation buffer 
or marker solution in the reagent holder. 

This function can also be accessed by selecting [Detect Remaining Reagent Amount] from the [Instrument] 
pull-down menu).

Column Explanation

Well name Displays the information of sample registration. For details, see "2.2 Sample Entry Menu" P.89

Project name

Sample name

Comment

Type

Sep. Buffer

Mode

Chip Displays the chip No. to be used (or used) for the respective samples. 

Status The status is displayed as follows, depending on the sample analysis state.

Waiting Pre-analysis state before pretreatment of microchip. 

Filling Pretreatment of microchip in progress (separation buffer filling, etc.).

Loading Loading sample onto microchip in progress.

Analyzing Analysis of sample in progress (separation in progress). 

Normal End Analysis has ended normally.

Abnormal End An error occurred, or analysis was interrupted.

Skipped Because failure occurs to the microchip during analysis performance 
inspection, analysis was skipped.
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2.1.6 Reagent Information
This window displays the amounts of separation buffer and marker solution (for on-chip mix only) required 
for analysis of the unanalyzed samples in the analysis schedule, and the remaining amounts of each 
reagent (after detection of the residual reagent amounts).

@NOTE
Required amount displayed in [Reagent Information] includes the following redundant amounts. 

• Amount needed for retries (up to 2) if a problem is detected when automatically adding separation buffer 
to the microchip

• Dead volume of the container

• Minimum bottle amount detectable by a level sensor

2.1.7 Status Bar

No. Explanation

1 DNA-500 kit

2 DNA-1000 kit

3 DNA-2500 kit

4 RNA kit

5 Displayed color indicates state of residual separation buffer amount.
• Gray: Residual amount unconfirmed
• Same color as background: Residual amount acceptable
• Red: Residual amount insufficient

6 Displayed color indicates state of residual marker solution amount. 
• Gray: Residual amount unconfirmed
• Same color as background: Residual amount acceptable
• Red: Residual amount insufficient

7 Displays amounts of separation buffer and marker solution required for use (calculated from the sample 
sheet), and their residual amounts. 

5

6

7

21 3 4

No. Explanation No. Explanation

1 Display of the latest instrument action 3 Data file name

2 The remaining time in the entire analysis 
schedule

4 Data file comment

1 2 3 4
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2.1.8 Chip Status Window
Select [Chip Status] on the [View] pull-down menu to display the electropherogram and current/voltage 
graphs for each microchip. 

To change the graph display scale, point to [Project Settings] and select [Display] (see "2.3.1 Project 
Settings" P.103).

[V1.05] 
The window will automatically switch to the [Chip Status] window when starting the analysis (when starting to 
fill the first sample).

@NOTE
When the Windows color scheme is set to the Windows XP silver or a similar color, the electropherogram 
may be difficult to view. Use the procedure below to change the electropherogram display color.

No. Explanation

1 Chip position 1

2 Chip position 2

3 Chip position 3

4 Chip position 4

5 Voltage status: Displays, in real-time, the voltage monitor value in each of microchip ports 1 to 4. 

6 Current status: Displays, in real-time, the current monitor value in each of microchip ports 1 to 4. 
(A negative value is indicated in red.)

7 Electropherogram: Displays, in real-time, the photometry data detected for each microchip. 

1

2

3

4

5 6 7
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2.2 Sample Entry Menu

2.2.1 New
A new sample sheet is created and entered into the analysis schedule.

(Click the  [New Entry] button on the toolbar to obtain the same result.)

@NOTE
The following message is displayed if the analysis schedule already contains a sample sheet.

Click [Yes] to proceed with the new entry. The content of the existing sample sheet is discarded when the 
new sample sheet is entered.

1 Select [New] on the [Sample Entry] pull-down menu. 
The [Sample Entry - New] window is displayed. 

@NOTE
If there is no project corresponding to the sample to be analyzed, cancel the window and create a 
new project. 

Select [Project Setting] from the [Edit] pull-down menu to display the [Project list] window. Click the 
[New] button to create a new project (see "2.3.1 Project Settings" P.103).

No. Explanation
1 List of projects already created 

2 Click this button to open a window for selecting the existing sample sheet file. Select the file name and 
click [Open] to display the sample sheet in the [Sample Sheet] window (for details, see "Sample Sheet 
File" P.94).

1 2
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2 In the [Sample Entry - New] window, select one project and click the [OK] button, or 
double-click the line. 
The [New Entry] window is displayed. 

No. Explanation
1 Specifies the well position where the ladder solution or sample is located. Either click on the well, or 

drag the mouse over it to select it. 
2 Displays the number of the samples included in the sample sheet. If it is “0”, you can create a sample 

sheet by entering the total number of samples. The well positions are entered automatically based on 
the [Analysis Order] selected in the [Project Settings] window. 
In [Add Entry] ("2.2.2 Add" P.101), this number includes the samples in the current analysis schedule 
and the samples in the current sample sheet.

3 When [Auto ladder entry] is selected on the [Edit] - [Project Settings] menu, the ladders are 
automatically entered at the top of the sample sheet according to the number of microchips being used 
("1.5.7 Project Creation" P.21). 

4 The data file name is automatically entered according to the [Default data file name] selected on the 
[Edit] - [Project Settings] menu. The default format is displayed and is continued by clicking the [Enter] 
button. If the mouse cursor is moved over the data file name column, a tool tip is displayed, enabling 
reference to the actual full data file path. 
[V1.05]
The file name shown below the column indicates the file name actually created. (Clicking the [Enter] 
button confirms the file name.)

5 The required amounts of separation buffer and marker solution (on-chip mix only) are calculated and 
displayed in the [Reagent Information] window. 

6 Use the [Import] window ("Import" P.96) to extract sample information from an existing Excel or CSV 
file.

1 2 3 4

56
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3 After selecting the sample well position, click the  button.
The sample information is entered into the appropriate columns. The content is automatically entered 
according to the [Project Settings].

^ Reference
"2.3.1 Project Settings" P.103

No. Explanation
1 Enter a [Sample Name] and [Comment]. Select ladder or sample for the [Type]. 

2 Click the [Save] button to save the sample sheet content as a sample sheet file. Use the [Sample sheet 
file] button in either the [Sample Entry - New] window or [Sample Entry - Add] window to open the 
saved file ("Sample Sheet File" P.94).

3 Clicking [Enter] or [Save] with this check box selected saves the content of the current [Sample Entry] 
window as the default sample sheet (file name: default.ssh). If [Load default sample sheet while 
starting up] is selected in the [Project Settings] window, this default sample sheet is displayed when the 
[Sample Entry] window is opened ("1.5.7 Project Creation" P.21).

1

23
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4 Click the [Enter] button, to add the set sample sheet to the analysis schedule. 

@NOTE
In the following cases, the [Enter] button is not displayed and sample sheets cannot be added to the 
analysis schedule. 

• When the instrument and PC are not connected (see "1.3 Instrument Startup and Shutdown" P.4).

• When the selected microchip is not installed or registered (see "1.5.4 Microchip Registration" 
P.13).

@NOTE
The following message is displayed when the sample sheet does not contain a ladder analysis.

Usually, click [No], and edit the sample sheet to add the ladder analysis.

• The analysis schedule can be executed without a ladder analysis, however, the data obtained 
cannot include size prediction, quantitation, and other analysis results.

• Alternatively, use the [Reanalysis] menu to import a ladder from a separate ladder data file and 
perform the analysis (). There is a possibility that the analysis results will not satisfy the 
specifications because the ladder data being used is an “import ladder”.

@NOTE
The maximum number of analyses (both ladders and samples) that can be entered into an analysis 
schedule is 120. The maximum number of analyses that can be entered into a sample sheet is also 
120.

Well Image Right-Click Menu

Menu Explanation

Clear Selection Clears all well selections (black). 

Apply Selected Wells Enters sample information for the selected wells into the sample sheet.

Delete Selected Sample Information Deletes information about the selected wells from the sample sheet. 
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Sample Sheet Right-Click Menu

Menu Explanation

Undo Restores operation to the content before change. 

Redo Re-performs the just-canceled operation. 

Auto Fill Fills in the content of the selected cells. Enters the sample name, comment, 
and type, as follows.
Sample name and comment columns:
Enter a name or comment in the top cell. Select the range to be filled and 
select [Auto Fill]. The cells are filled with the sample name or comment and a 
sequential numeric value is added at the end of the sample name or 
comment. If the last character is a number the sequence initiates from that 
number. (Example: 002 is entered in the top cell, the sequence becomes 
002,003,004...)
Type column:
Select the type in the top cell. Select the range to be set and select [Auto Fill], 
to copy the entered content from the top cell.

Cut Copies the content of the selected cell to the clipboard, and then delete it. 

Copy Copies the content of the selected cell to the clipboard. 

Paste Pastes the content in the clipboard to the selected range. 

Copy Sample Sheet Copies all information in the sample sheet to the clipboard.

Insert Line Inserts a line.

Delete Line Deletes sample information in the selected line. 

Hide/Show Columns (It is displayed if 
right-clicking on the top title line.)

Displays the window used for selecting items to be displayed in the column 
(see "2.5.2 Options" P.114).
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Sample Sheet File
To perform repeated analyses with the same sample composition and save sample entry time, save the 
content entered in the [Sample Entry] window to a file, then open that file for the subsequent sample sheet 
entries.

Saving the Sample Sheet

1 After creating the sample sheet, click the [Save] button. 

2 In the [File name] column, enter the name of the file and click the [Save] button. 
A sample sheet file with extension .ssh is saved in the project folder. 



 Operating Procedure   95

2.2  Sample Entry Menu

2

Opening the Saved Sample Sheet

1 Select [New] on the [Sample Entry] pull-down menu or click the [New Entry] button on 
the toolbar. 
The [Sample Entry - New] window is displayed. 

2 Select the project, and then click the [Sample sheet file] button. 
A window for opening the file in the corresponding project folder is displayed. 

3 Select the sample sheet file, and then click the [Open] button. 
The selected sample sheet file is opened, and the [Sample Entry] window is displayed. 

4 Edit the data as necessary, and then click the [Enter] button to add it to the analysis 
schedule.
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Import
[Import] is a function for converting and inputting sample information from an existing Excel or CSV file to a 
MultiNA sample sheet.

[Import from]: import source

[Import to]: import destination
• [Data file name], [Data file comment], [Well name], [Sample name], [Comment] and [Type] information can all 

be imported.

1 In the [Sample entry] window, clicking the [Import] button displays the window below. 
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2 Click the [Browse] button to display the [Open] dialog box. 
Select an Excel file or CSV file, and click the [Open] button. 

@NOTE
f the Excel or CSV file is currently open in another program (Excel, etc.), the following message will 
be displayed. Close the file in other software, and then reopen the file in the MultiNA Control 
Software.

The Excel or CSV file is displayed in the [Import from] section of the [Import] window.
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3 Create a rule for converting the [Import from] information to [Import to]. 

1 Drag the mouse to select the import source cell, and align the mouse cursor with the selected range. 
2 With the mouse cursor in arrow state, drop the selection into the blue box above the import 

destination column. 
The box color changes to pink. 
The figure below is an example of import source cells A4 to A9 selected, and then dropped into the 
box above the well name. 

3 The selected import source information (cell range) is entered in the blue boxes above the import 
destination column. The import source information is copied under these boxes. 

Or you can enter the desired import source cell information directly into the import destination blue 
boxes, and click the [Apply Rule] button in the center, to display the content at the import destination. 
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4 Use the same operation as Step 3 to create a rule for importing another import content 
(sample name, comment, type, data file name, and data file comment).

Saving the Rule

If saving the rule, you can easily convert the import source information to the import destination when 
importing the file with the same format next time. 

1 Click [Save rule] to display the [Save As] window. 

2 Enter a file name and click the [Save] button. 
Cell information converted from the import source to import destination is saved as a rule file 
(extension: .rle). 

3 When the next analysis schedule is created, click [Load Rule] in the [Import] window to open the 
saved rule file.

4 Click the [Browse] button to open the import source file, and the information is automatically input at 
the import destination.
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5 Click the [Import] button to import the content of the import destination to the sample 
sheet. 

@NOTE
If a sample sheet has already been created before the import, and a well name is duplicated, the 
information is not imported and the following message is displayed. 
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2.2.2 Add
Multiple sample sheets can be individually added to an analysis schedule.

The  [Add Entry] button is enabled on the analysis schedule toolbar after the first (new) sample sheet is 
entered in the analysis schedule.

@NOTE
If a sample sheet is added to an analysis schedule using a project name that is already entered in the 
analysis schedule, all of the data will be stored in the same data file.

Typically, data from separate sample sheets is stored in separate data files. A separate data file is created 
even when a sequence-number format has been applied to the data file name. 

^ Reference
"Fig.1-14 Work Flow from Project Creation to Data Acquisition" P.19

1 Select [Add] on the [Sample Entry] pull-down menu. 
The [Sample Entry - Add] window is displayed. 

2 Select a project in the window above, and click the [OK] button.
Or click the [Sample sheet file] button to open an existing sample sheet.

@NOTE
If a well in the existing sample sheet is already being used by the samples in the analysis schedule, 
the sample sheet file fails to load and the following error message is displayed. 
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3 The [Add Entry] window is displayed.
Wells already registered in the analysis schedule are grayed out. 

4 Select any open well, and use the same procedure as new entries to insert the sample.
The additional entry is inserted next to the existing analysis schedule.

2.2.3 Exit
The MultiNA Control Software is closed.

@NOTE
This menu item cannot be selected during analysis, cleaning, or other instrument operation. 
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2.3 Edit Menu

2.3.1 Project Settings
Create new projects or edit existing projects in the [Project List] window.

• [New] button:  Creates a new project. (P.103)
• [Copy] button:  Copy and edit an existing project. (P.105)
• [Edit] button:  Edit an existing project. (P.105)
• [Delete] button:  Delete an existing project. (P.106)

New
Create a new project. Enter and select the necessary items on the various tabs shown below, and then 
click [OK]. 

1 [General] tab
Enter the displayed items in [General] tab. Refer to "1.5.7 Project Creation", step"3" P.22 for more details.
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2 [Sample] tab
Select the displayed items in the [Sample] tab. Refer to "1.5.7 Project Creation", step"4" P.23 for more 
details.

3 [Display] tab
Select each item in the following window.

Item Explanation
Graph scale Configure the graph scales described in "2.1.8 Chip Status Window" P.88. The possible 

manual selection ranges are as follows.
Voltage: 1 to 1500 (V)
Current: 1 to 300 (µA)
Electropherogram: 0 to 2500 (mV)
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Copy
Copy and edit an existing project.

1 Select an existing project in the [Project list] window (P.103), and click the [Copy] 
button.
A window is displayed with a blank project name and all of the other items copied from the existing 
project. 

2 Enter a new project name. 

3 After completing entry and selection for the necessary items on each tab, click the [OK] 
button. 
The project is saved. 

Edit
Edit the content of an existing project. 

@NOTE
The project name cannot be changed. To change the project name, [Copy] the project and save it with a 
different name. 

1 Select an existing project in the [Project list] window (P.103), and click the [Edit] button.
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2 Change the necessary items in the [Project Settings] window.

3 Click the [OK] button to display the following message.
Click [Yes] to save the changed content. 

@NOTE
The following message is displayed when an attempt is made to edit a project that is currently 
associated with samples entered in the analysis schedule. Select [Yes] to open the [Edit] window. 
Some items such as, type of separation buffer, will be disabled and cannot be changed.

Delete
Delete an existing project. 

1 Select an existing project in the [Project list] window (P.103), and click the [Delete] 
button.
The following confirmation message is displayed.
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2 Verify the project name, and click [Yes].
The project is deleted.

@NOTE
A project cannot be deleted if it is associated with a sample in the analysis schedule. The following 
message is displayed. 

2.3.2 Edit Sample Sheet
Use this menu to edit sample sheet that is entered in analysis schedule.

1 Click any one cell in the in the analysis schedule for the sample sheet to be edited.
If only one sample sheet has been added to the analysis schedule, this procedure is not required.

2 Select [Edit Sample Sheet] on the [Edit] pull-down menu. 
(You can also right-click on the sample sheet to bring up a menu, then select [Edit Sample Sheet].)
The [Sample Entry] window is displayed. 

3 Edit the sample sheet in the [Sample Entry] window.

4 After editing the sample sheet file, click the [Enter] button.
The sample sheet is re-entered into the analysis schedule.
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2.3.3 Delete Sample Sheet
Use this menu to delete a sample sheet from the analysis schedule.

1 Click any one cell in the in the analysis schedule for the sample sheet to be deleted.
If only one sample sheet has been added to the analysis schedule, this procedure is not required.

2 Select [Delete Sample Sheet] on the [Edit] pull-down menu.
Or right-click on the sample sheet and select [Delete Sample Sheet].
The following confirmation message is displayed.

3 Check the project name and data file name, and click [Yes]. 
The sample sheet is deleted, and the analysis schedule in the main window is changed. 
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2.3.4 Copy
Use this menu to copy the content (text) selected in the analysis schedule to the clipboard. 

1 Drag the mouse over the range to be copied in the analysis schedule to select it.
 

2 Select [Copy] on the [Edit] pull-down menu. 
The selected range is copied to the clipboard with partition tabs.

3 Paste the content into another application (Excel, etc.). 
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2.4 View Menu

2.4.1 Chip Status
The [Chip Status] window displays the electropherogram and current/voltage graphs for each microchip. 

^ Reference
"2.1.8 Chip Status Window" P.88

To return the display to [Reagent Information] (P.83), either select [Chip Status] on the [View] menu, or 
press the [F8] key. 

[V1.05] 
The window will automatically switch to the [Chip Status] window when starting the analysis (when starting to 
fill the first sample).
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2.4.2 Data File
Start the MultiNA Viewer to display the analyzed data. 
(Or you can click the  [View Data File] button on the right end of the toolbar.)

@NOTE
If the analysis schedule contains more than one sample sheet, only the data file for the selected sample 
sheet is displayed when the MultiNA Viewer is opened. 

2.4.3 Log
Follow the procedures below to displays the instrument events recorded in the log. 

1 Select [Log] on the [View] pull-down menu.
The [Search Criteria] window is displayed. 

2 To narrow the search criteria, enter or select the necessary conditions, and click [OK].
 

Search criteria Explanation
Max. number Indicates the number of cases to be displayed. A maximum of 5000 cases can be 

entered. 
Date (From/To) Specifies the event generation range. 
Level Specifies the event level (Info, Warning, Error, Fatal). 
Source Specifies the event source. 
Code Specifies the event code. 
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An [Event Log] window is displayed.

@NOTE
Levels in the event log are classified as follows. 

• To rearrange the list displayed in the [Event Log] window, click the header of [Date] or [Level].

• Use the mouse to select the range, then right-click and select [Copy] to copy the selected range to the 
clipboard.In the displayed [Event Log] window, you can click the header of [Date] or [Level], etc., to 
rearrange the list. 

[Event Log] Window Button

Level Explanation
Info Event (information) generated in the instrument (Analysis start or end, etc.). 
Warning Event that will not impede the continuous analysis but could have an effect on data. 

See -Instrument and System- "Warning".
Error Event that disables continuation of automatic analysis. See -Instrument and System- "Error".
Fatal Event that requires an instrument status check and could lead to a situation where continuation 

of operations in this condition is either impossible or dangerous. See -Instrument and System- 
"Fatal". 

No Button Explanation
1 Save as Use this button to save the displayed content to a CSV file. Click the button, and then 

enter a name in the file save dialogue box.
2 Delete Use this button to delete the selected event log line. Click the button, and select [Yes] 

in the displayed confirmation dialogue box to delete the content. (The content is 
deleted not only from the display, but also from the file where the event log is saved.)

3 Search criteria The event log search window is re-displayed. Change the search criteria and perform 
search. 

1 2 3
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2.5 Instrument Menu

2.5.1 Connect
Communication between the MultiNA instrument and the PC is connected or disconnected with this menu.

• When connected, the check box of this menu is selected.
• During analysis, this menu is disabled and cannot be selected.
• The characters in the [Instrument name] display (“MultiNA” in the figure below) on the left end of the toolbar 

are light blue when connected and pale orange when disconnected. 

@NOTE
Select the [Connect at start up] check box to automatically establish communication between the PC and the 
instrument when the MultiNA software is opened. Refer to "2.5.2 Options" P.114.

Automatic connection is not performed in the following cases, Verify that the instrument power is ON and 
that the LAN cable is properly connected, then use this menu to establish communication.

• Instrument was not turned ON when the software was started up 

• [Connect at start up] check box is cleared

• LAN cable is not correctly connected

• Communication was canceled from the instrument for some reason 
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2.5.2 Options
The instrument options and display items common to all projects are set with this menu.

[General] tab

@NOTE
Do NOT change the IP address from the address set during the instrument installation. If any change is 
necessary, contact your Shimadzu service representative. 

Item Explanation

Instrument name Instrument name displayed on left end of toolbar. (Up to 16 characters.)

IP address Instrument IP address (entered during installation)

Port number Port number used for socket communication (cannot be changed)

Connect at start up Determines whether automatic connection to the instrument is established when the software 
is opened.

Enter sleep mode 
after finishing 
analysis schedule

Enter sleep mode after finishing analysis schedule - Determines whether the instrument enters 
the sleep mode after completion of the analysis schedule.
If selected:
• The instrument enters into the sleep mode when all instrument operations (analysis, 

washing, and all other operations) are complete, and there are no PC mouse or keyboard 
operations for a period of at least one hour.

• In the sleep mode, all motor power, chip stage temperature adjustment, and fan operation 
stop, to reduce power consumption.

• Operating the PC mouse or keyboard cancels the sleep mode.
• It takes up to 5 minutes for the chip stage to reach the designated temperature after the 

sleep mode is canceled. (If analysis is started during this warm-up period, actual analysis 
will not begin until the chip stage reaches the designated temperature.)
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[Column Selection] tab

2.5.3 Chip Management
Follow the procedures below to control information for microchips installed in the instrument.

• The chip No. at [Chip in use] shows the chip position in the instrument. (Chip 1 is farthest back, followed in 
order by chip 2 and chip 3, with chip 4 in front.)

• Removing the [Chip in use] check box prevents use of that microchip for analysis.

Item Explanation

Main window
(analysis schedule)

Determines the columns to be displayed in the analysis schedule.

Sample entry window
(sample sheet)

Determines the columns to be displayed in the sample sheet.
(The well names and types are essential for sample entry and cannot be changed.)
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@NOTE
Changing the chip to be used after a sample has been entered will invalidate the analysis schedule. The 
following warning message is displayed.

To delete the analysis schedule and enter a new sample sheet, select [Yes].

To use the same analysis schedule, select [No], and use the procedure below to enter the sample into the 
analysis schedule.

 

1 Click [No] in the message dialog box.
The [Chip management] window is displayed. 

2 Click the [Close] button, and close the [Chip management] window. 
Returns to the main window.

3 Select [Edit Sample Sheet] on the [Edit] pull-down menu. 
Or right-click on the analysis schedule list, and select [Edit Sample Sheet] on the displayed menu. 

4 Click the [Save] button in the [Sample Entry] window.
Name the sample sheet, and save it. 

5 Click the [Cancel] button in the [Sample Entry] window to close the window.
6 Select [Chip Management] on the [Instrument] pull-down menu, to change the microchip to be used. 

If the warning message in the figure above is displayed, click [Yes]. 
7 After changing the microchip to be used, select [New] on the [Sample Entry] pull-down menu. 
8 In the [Sample Entry - New] window, select a project, and click the [Sample sheet file] button. 
9 Select the sample sheet given a name and saved in Step 4, and load it. 

10 Click the [Enter] button in the [Sample Entry] window to enter the sample into the analysis schedule.

^ Reference
"Sample Sheet File" P.94

[Clear unavailable flag]
A microchip judged during analysis to be unavailable cannot be used any further and the following 
message is displayed. Manually clean the microchip, to eliminate clogging or other problems. 
Refer to -Instrument and System- "6.2.7 Microchip Reservoirs".
 

• If using a previously cleaned microchip, click the [Clear unavailable flag] button in the [Chip Management] 
window, to allow the chip to be used.



 Operating Procedure   117

2.5  Instrument Menu

2

[History]
Click the [History] button to display the history of the microchip being used.

The following items are included in the history file.
• [Chip ID]
• [No. of runs]
• [Start] (date of initial use)
• [Last] (date of last use)
• [Chip position]

Click the [Delete] button to delete the chip history. Histories of microchips currently in use cannot be 
deleted.

Exchanging the microchip
Use the [Chip Management] window to control microchip exchange or removal. 

To exchange the microchip

1 Click the  [Change] button next to the microchip to be exchanged.
The [Chip x Change] window is displayed. 

2 Enter the microchip serial number (chip ID) in the [Chip x Change] window, and click the 
[Change] button.
If the microchip was previously used, the history of its usage is displayed.
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To remove the microchip
The following describes the procedure for removing a microchip, using chip position 1 for the example. 

1 Click the  [Change] button next to chip 1, in the [Chip Management] window.
The [Chip 1 Change] window is displayed.

2 Click the [Remove] button in the [Chip 1 Change] window.
Chip 1 is grayed out, and the check box is cleared.

3 Click the [Close] button. 

2.5.4 Detect Remaining Reagent Amount
Follow the procedures below to check the residual amount of separation buffer or marker solution. Or press 
the button on the top right corner of the [Reagent Information] window.

• The residual reagent amount is calculated by inserting a sample probe into the reagent bottle to detect the 
reagent liquid level.

• The residual reagent amount is automatically checked when an analysis sequence is started. This function 
can also be used to check the residual reagent amount without starting the analysis sequence.
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1 Place the reagents and samples in the appropriate positions and close the instrument 
cover.

2 Verify that the analysis schedule has been entered.

3 Select [Detect Remaining Reagent Amount] from the [Instrument] pull-down menu.
Or click the button on the upper right corner of the [Reagent Information] window. 

4 If the following message is displayed, click [Yes].
The check is started. 

5 The residual amount of reagent is displayed in the [Reagent Information] window.
If the amount of reagent is insufficient, the location for the separation buffer or marker solution is 
displayed in red. Then add that reagent.

2.5.5 Move All Axes to Home Position

Use this menu to return the instrument drives (autosampler, pneumatic unit, and syringe pump) to the 
home position. 

• The drives automatically return to the home position when analysis is completed normally. If an error occurs 
during operation the drives may stop without returning to the home position. Move all axes to the home 
position before performing other operations such as, micro chip removal, reagent replenishment, etc.

• This function is also used for parts replacement. Refer to Section -Instrument and System- "6.4 Part 
Replacement and Inspection".
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Fig.2-1 Home Positions for Autosampler and Pneumatic Unit

@NOTE
This function will not operate if the chip cover or instrument cover are open. Close the chip cover and 
instrument cover before starting this operation. 

2.5.6 Check Analysis Performance
Select [Check Analysis Performance] from the [Instrument] drop-down menu to create a schedule for checking 
the analysis performance.

• The [Check Analysis Performance] function checks for problems with the instrument, microchips, and 
reagent kit.
Regular checks are recommended. Perform the evaluation as necessary if the sample analysis results are 
unfavorable.

• Use the TE buffer (10 mM Toris, 1 mM EDTA, pH 8.0) for the DNA kit sample and THE RNA Storage Solution 
for the RNA kit. (DNA, RNA, and ladders are not required.)
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@NOTE
The check is performed using the on-chip mix mode for the DNA kit (DNA-500, DNA-1000, or DNA-2500) 
and premix for the RNA kit.

• See (P.123) for a list of all of the items that are evaluated during [Check Analysis Performance]. “Passed” or 
“Failed” is displayed as the general result and for each specific item.

• The following files are created when the analysis performance check is executed.

• If the check results raw data file (MLT file) is opened in MultiNA Viewer, the check results log file (LOG file) is 
also automatically opened. ()

• Since the LOG file is text data, it can also be opened with a [Memo] program or editor program.

1 1Refer to the chapters in this manual listed below to prepare the analysis performance 
check for the appropriate reagent kit.
(No need to prepare a ladder.)
• DNA-500: "1.6.1 Requirements" P.32
• DNA-1000: "1.7.1 Requirements" P.40
• DNA-2500: "1.8.1 Requirements" P.48
• RNA: "1.9.1 Requirements" P.56

2 Prepare the same diluted dye solution as for the regular analysis. 
• DNA-500: "1.6.3 Diluted Dye Solution Preparation" P.34
• DNA-1000: "1.7.3 Diluted Dye Solution Preparation" P.43
• DNA-2500: "1.8.3 Diluted Dye Solution Preparation" P.51
• RNA: "1.9.3 Diluted Dye Solution Preparation" P.59

3 Select the appropriate items in the [Check Analysis Performance] window.
Select the kit to be used from among DNA-500, DNA-1000, DNA-2500, and RNA. Select all the 
microchips to be used.

@NOTE
• Multiple performance checks can be entered into a single analysis schedule by repeatedly 

selecting [Check Analysis Performance] to add these checks to the analysis schedule. The results 
for each of the performance checks are saved in separate files.

• Performance checks can be performed on the same DNA kit up to 26 times and up to 8 times on 
the same RNA kit (upper limit for liquid in sample tube: 30 µL).

• Regular analysis samples cannot be added to an analysis schedule that contains performance 
checks.

• After the performance checks are added to the analysis schedule, [Delete Sample Sheet] can be 
performed, but [Edit Sample Sheet] cannot be performed.

Type File name (base name) Extension Save folder

Raw data Name showing date and time when 
check was performed (Ex.: Check was 
executed at 14:50' 20", September 13, 
2006: 20060913_45020.MLT).

MLT [Reagent kit name] folder in the Project 
folder located inside the data folder 
(Regularly, C:\MultiNA\). 

Analyzed data Same as raw data MLA Same folder as raw data

Analysis 
performance 
check results 
log

Same as raw data LOG Same folder as raw data
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4 Click the [Enter] button, prepare the necessary amounts of the reagent shown in 
[Reagent Information], and place them in the reagent holder.

DNA kit

1 Dispense the DNA kit separation buffer into the buffer bottle, and add the diluted dye solution.
To perform two checks on four microchips (8 analyses), add 5 µL of diluted dye solution to 495 µL of 
separation buffer. Refer to the following chapters for more details.
• DNA-500: "1.6.5 Separation Buffer Preparation" P.36
• DNA-1000: "1.7.5 Separation Buffer Preparation" P.44
• DNA-2500: "1.8.5 Separation Buffer Preparation" P.52

2 Cap the bottle, and agitate the solution with the vortex mixer for at least 10 seconds.
3 Remove the cap, and place the bottle in the reagent holder position that corresponds to the kit that 

was used.
4 Dispense the required amount of marker solution into a marker solution vial, and place it in the 

reagent holder position that corresponds to the kit that was used. Refer to the “On-chip mix” sections 
in the following chapters.
• DNA-500: "1.6.6 Ladder, Sample and Marker Solution Usage" P.38
• DNA-1000: "1.7.6 Ladder, Sample, and Marker Solution Usage" P.46
• DNA-2500: "1.8.6 Ladder, Sample and Marker Solution Usage" P.54

5 Use a TE buffer (10 mM Toris, 1 mM EDTA, pH 8.0) for the sample. Refer to the table below to 
dispense the required volume of sample into a sample tube, and place the tube into the specified 
well in the extra sample stand.
For example, to make one DNA-500 kit check on four microchips (4 analyses), place at least 11 µL of 
TE buffer in the X1 well.

@NOTE
The sample wells cannot be changed, place the samples in the specified wells.

Minimum amount of TE buffer 
required

5 + 2 x (Number of analyses - 1) µL

Container Sample tube
Maximum amount of solution 30 µL

Reagent kit Sample well
DNA-500 X1
DNA-1000 X2
DNA-2500 X3
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RNA kit

1 Dispense the RNA separation buffer into the buffer bottle, and add the diluted dye solution and 
formamide.
For example, to perform one check on four microchips (4 analyses), add 5 µL of diluted dye solution 
and 100 µL of formamide to 395 µL of separation buffer. Refer to the following chapters for more 
details.
• RNA: "1.9.5 Separation Buffer Preparation" P.60

2 Cap the bottle, and agitate the solution with the vortex mixer for at least 10 seconds.
3 Remove the cap, and place the bottle in the RNA position in the reagent holder.
4 Use THE RNA Storage Solution for the sample. Refer to the table below to dispense the required 

volume of THE RNA Storage Solution into a sample tube, add an equal amount of marker solution, 
mix the solution, and place the tube into the X4 well in the extra sample stand.
For example, to make one check on four microchips (4 analyses), add 7.5 µL of marker solution to 
7.5 µL of THE RNA Storage Solution, mix them together, and place the sample tube in the X4 
position of the extra sample stand.

@NOTE
The sample position cannot be changed, place the sample in the specified well.

5  Start analysis as usual. 

Either select [Start] on the [Analysis] pull-down menu, or click the  [Start] button on the toolbar. 

6 Use MultiNA Viewer to review the analysis performance check results.

Either select [Data File] on the [View] pull-down menu, or click the  [View Data File] button on the 
toolbar. The check results are automatically displayed.

Minimum amount of mixed 
solution required

3 x (Number of analyses + 1) µL

Amount of THE RNA Storage 
Solution

1.5 x (Number of analyses + 1) µL

Amount of marker solution 1.5 x (Number of analyses + 1) µL
Container Sample tube

Maximum amount of solution 30 µL
Sample position X4
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• Items marked with asterisk (*) are not displayed for RNA checks (RNA uses lower marker only).
• “Passed” or “Failed” is displayed for each check item. The acceptable range is in the parentheses and 

varies depending on the reagent kit used.
• If any one of the check items has a “Failed” result, the general result (<Result No. #>) is also “Failed”.

7 If the check result is “Failed”, the following causes can be considered.

Check item Explanation
No. of Errors Number of “Errors” that occurred during sample analysis
No. of Warnings Number of “Warnings” that occurred during sample analysis
LM Time (sec.) Peak detection time for the lower marker
UM Time (sec.)* Peak detection time for the upper marker
LM Height (mV) Peak height for the lower marker
UM Height (mV)* Peak height for the upper marker
L1 to L4 Curr. (µA) Current value for sample injection in microchip reservoirs No.1 to No.4
S1 to S4 Curr. (µA) Current value for sample separation in microchip reservoirs No.1 to No.4
Baseline (mV) Baseline height in [Raw Data]
UM No. of TP* Theoretical plate number for the upper marker peak
Noise Ampl. Noise amplitude in electropherogram

Check item Symptom Possible cause
No. of Error/
Warning 

An error or warning occurred 
during analysis.

“Error” or “Warning” occurred in the instrument during sample 
analysis.
Display the log ("2.4.3 Log" P.111) and check the content. For 
error messages, see -Instrument and System- "9.2.1 MultiNA 
Control Software".

LM Time Value under standard range 
(detection is too fast)

Low separation buffer concentration.
Kit type used differs from the recorded kit. 

Value over standard range 
(detection is too slow)

Incorrect current running.
High separation buffer concentration.
Kit type used differs from the recorded kit. 

UM Time Value under standard range 
(detection is too fast)

Low dye concentration in separation buffer.
Kit type used differs from the recorded kit. 

Value over standard range 
(detection is too slow)

Incorrect current running.
High dye concentration in separation buffer.
Kit type used differs from the recorded kit. 

LM Height Value under standard range 
(peak is too low)

Lower marker has deteriorated.
Microchip surface is contaminated.
Microchip not installed correctly on chip stage. 
(For RNA analysis) Formamide has deteriorated.

UM Height Value under standard range 
(peak is too low)

Dye has deteriorated.
Separation performance degraded due to microchip 
deterioration.
Separation performance degraded due to separation buffer 
deterioration. 
Insufficient marker solution dispensed to microchip (degraded 
instrument dispensing precision). 
Microchip surface is contaminated.
Microchip not installed correctly on chip stage. 
(For RNA analysis) Formamide has deteriorated. 

L1 to L4 Curr. Value under standard range 
(value is too low.)

Microchip flow channel is clogged, or partially clogged.
Bubbles generated in microchip flow channel. 
Insufficient amount of separation buffer in microchip reservoir. 
Insufficient amount of sample dispensed to microchip. 
Kit type used differs from the recorded kit. 

Value over standard range 
(value is too high.)

Separation buffer concentration increase.
Foreign material (salt) intruded into separation buffer. 
High salt concentration in sample.
Kit type used differs from the recorded kit. 
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• Corresponding to the presumed cause, clean the microchip surface, or replace the reagent kit, dye, 
microchip, and formamide (RNA analysis only) with new items, and repeat the analysis performance 
check again.

• If this does not solve the problem, contact your Shimadzu service representative. 

2.5.7 Parts Maintenance
This window displays the previous number of analyses, their operation times, and the previous 
replacement dates and times.

Access this window regularly to determine if any of the parts need to be replaced.

^ Reference
-Instrument and System- "6.3.1 Parts Maintenance", "6.4 Part Replacement and Inspection" 

S1 to S4 Curr. Value under standard range 
(value is too low.)

Microchip flow channel is clogged, or partially clogged.
Bubbles generated in microchip flow channel. 
Insufficient amount of sample dispensed to microchip. 
Kit type used differs from the recorded kit. 

Value over standard range 
(value is too high.)

Separation buffer concentration increase.
Foreign material (salt) intruded into separation buffer. 
High salt concentration in sample.
Kit type used differs from the recorded kit. 

Baseline Small value (baseline is too 
low.)

Low dye concentration in separation buffer.

Large value (baseline is too 
high.)

High dye concentration in separation buffer.
Microchip has deteriorated.
Microchip surface is contaminated.

UM No. of TP Small value (theoretical plate 
number is too small)

Microchip has deteriorated.
Reagent kit has deteriorated, and salt concentration changing 
(increase).

Noise Ampl. Large value (noise is large) Microchip surface is contaminated.

Check item Symptom Possible cause
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2.5.8 Wash

Select the following items from the pull-down menu, and perform each rinsing operation. 

Before rinsing, verify that the glass rinse water bottle for rising contains at least 100 mL of Milli-Q ultrapure 
water or distilled water.

Before RNase removal, insert 1 mL of probe rinsing solution (RNaseZAP® Applied Biosystems (formerly 
Ambion)) into the buffer bottle, and place it in front of the rinse port in the reagent holder.

2.5.9 Periodic maintenance
Operate the peristalic pump, so that the operation prevents the pump from performance decrement when 
the instrument is out of use for an extended period (for 1 month or more). See -Instrument and System- 
"7.3.3 Peristalic Pump Storage".

Menu item Explanation

Chip 1 to Chip 4 Washing Rinse each microchip with water. 

All Chip Washing Rinse all the microchips installed with water.
Even chips that are not selected in the [Chip Management] window are washed.

Probe Rinse Rinse the sample probe with water.

RNase Removal Rinse the sample probe with probe rinsing solution and water.

Rinse port

Probe rinsing solution
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2.6 Analysis Menu

2.6.1 Start

After the analysis schedule is entered, [Start] on the [Analysis] pull-down menu (and the  [Start] button 
on the toolbar) is enabled.

Select either on to display the following message. Click [yes] to start the analysis operation.

@NOTE
• The instrument automatically checks the following items before starting an analysis sequence. If an error 

occurs during this evaluation, perform appropriate measures. See -Instrument and System- "9.2.1 
MultiNA Control Software" for more details.

• Do NOT leave the instrument unattended until the check is complete and the analysis starts.

• After analysis starts, check the analysis status in the main window. See "2.1 Explanation of Windows" P.83.
• Select [Chip Status] on the [View] pull-down menu to switch between the chip status display and reagent 

information display. See "2.1.8 Chip Status Window" P.88.

Check item Explanation

Control power 
supply unit

Check the voltage.

Top cover/chip 
cover open/close

The instrument will not operate while the covers are open. Close the covers and 
then start analysis. 

Sample holder 
conditions

Verifies that the sample holder is correctly installed. Uses a sample probe to perform 
contact detection. Analysis will not start if the sample holder is not correctly installed. 
"1.10.1 Sample Holder Installation" P.64 

Microchip in position Verifies that a microchip is installed in the specified position. Uses a sample probe to 
perform contact detection. Analysis will not start if the microchip is not installed in the 
specified position. Install the microchip in the specified position, and restart the 
analysis. "2.5.3 Chip Management" P.115 

Amount of 
remaining reagent

Determines the residual reagent amount, Uses a sample probe to perform liquid level 
detection. Analysis will not start if the residual reagent amount is insufficient. Refer to 
the [Reagent Information] window and dispense the required amount of reagent, and 
then restart the analysis.

Chip temperature Verifies that the microchip temperature, is at least 37°C. If the temperature is low 
it is warmed to the set temperature. Analysis starts when the temperature is 
reached. 
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2.6.2 Stop
After analysis, the instrument performs microchip rinsing and other post-processing, and then 
automatically stops.

Use this menu to interrupt analysis.

1 Either select [Stop] on the [Analysis] pull-down menu, or click the  [Stop] button on 
the toolbar.
Depending on the instrument status, one of the two messages below is displayed. 

1 Before starting sample analysis
The following message is displayed. Click [yes] to stop analysis after completing the processes in 
progress. 

2 During sample analysis
The following message is displayed. Select either [Stop after finishing analysis of current sample] or 
[Stop immediately], and click [OK]. 

• [Stop after finishing analysis of current sample]
Selecting this check box continues analysis of sample currently being analyzed or currently 
being loaded. After the analysis is completed, rinsing of the microchip and sample probe is 
automatically executed, and the operation is ended. 

• [Stop immediately]
Selecting this check box immediately stops analysis even if a sample is currently being 
analyzed. Rinsing of the microchip and sample probe is then automatically executed, and 
operation ends. 

Samples currently in loading or analysis have a data file prepared for partway through the 
analysis. 

2 Check the instrument indicators, etc., to confirm that operation has stopped, and open 
the top cover.
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2.7 Help Menu

2.7.1 Manual
Select the menu below to display the PDF files for the corresponding instruction manuals. 

[Quick Start Manual]: Analysis operations flow (Operating Procedure P.2 to P.3)

[Instrument Manual]: Instrument and System

[Operation manual]: Operating Procedure

@NOTE
Adobe® Reader® distributed by Adobe Systems Co. or other PDF file viewing software (provided free) is 
required to view the PDF file. Adobe® Reader® (Ver. 4 or later) can be downloaded from the following 
website:

http://www.adobe.com/products/acrobat/readstep2.html

2.7.2 About MultiNA
Use this menu to display the software version information. The MultiNA Control Software version 
information is shown as well as version information for the current method. 
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3MultiNA Viewer Functions

3.1 Explanation of the Window 

No. Name Reference

1 Pull-down menu "3.1.1 Pull-down Menu List" P.132

2 Toolbar "3.1.2 Toolbar" P.134

3 Sample Name Tree "3.1.5 Sample Name Tree" P.135

4 Well Display "3.1.3 Focused data and selected data" P.134

5 Gel Image "3.1.6 Gel Image" P.135

6 Status Bar "3.4.3 Status Bar" P.165

7 Electropherogram (Multi) "3.1.10 Electropherogram (Multi)" P.142

8 Electropherogram (Single) "3.1.9 Electropherogram (Single)" P.140

9 Peak Table "3.1.7 Peak Table" P.139

1 2 3 4 5

7 689
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3.1.1 Pull-down Menu List

Menu Item Outline of Function Shortcut 
Key

Reference 
Page

File Open Open a data file. Ctrl + O P.143

Close Close a data file being viewed. P.145

Save Rewrite and save a data file. Ctrl + S P.145

Save As Save a data file with a different name. P.146

[V1.05]
Save Selected 
Data

Save only the selected data in a separate file. P.147

Search Search data files. P.149

Export Export data in CSV format. P.150

Print Print out data. Ctrl + P P.152

Print Setup Set up a printer. P.159

Data File 
Properties

Display conditions where a data file is acquired. P.160

Sample 
Properties

Display conditions where each sample data item in a data 
file is acquired. 

P.160

(File Name) Reopen a file that has already been opened. 

Exit Quit the data analysis software MultiNA Viewer. P.160

Edit Copy Copy information displayed on [Gel Image], [Electropherogram], 
[Peak Table], or [RNA Report] to the clipboard. 

P.162

[V1.05]
Save Image As

Save what is displayed on [Gel image] and [Electropherogram] 
as an image file.

P.163

View Refresh Reopen a data file. P.164

Marker Switch between hide and display marker peak sign. P.164

Status Bar Switch between hide and display Status Bar. P.165

[V1.05]
Title

Tooltip displayed in the upper right area of 
[Electropherogram (Single)] and at the top of [Gel Image].

P.165

Analyzed Data / 
Raw Data

Switch between analyzed data and raw data. P.166

Normal Sensitivity 
Data / Low 
Sensitivity Data

Switch between normal sensitivity data and low sensitivity 
data. 

P.166

Comparison Display multiple data files for comparison. P.167

Size Calibration 
Curve

Display the size calibration curve used for data analysis. P.171

Analysis 
Performance 
Check Result

Display the results of analysis performance check. P.171

Select Ladder 
Used for Analysis

Select and display the ladder used to analyze the focused 
sample. 

P.172

Select All Samples 
Analyzed Using 
This Ladder

Select and display the samples analyzed using the focused 
ladder.

P.173

Options Set options for items to be displayed or scale. P.174
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Gel 
Image

Invert Black and 
White

Switch black and white highlighting. P.176

[V1.05]
Vertical Axis

Select the image to be displayed on the vertical axis from 
among [Distance Image], [Size Image], or [Time Image].

P.177

Gel Image List Display the [Gel Image List] window. P.178

Undo Zoom Undo the last zooming operation on [Gel Image]. Ctrl + Z P.180

Undo Zoom All Undo all zooming operations on [Gel Image]. Ctrl + R P.180

Electro-
phero-
gram

Peak Top Select the item displayed at the top of the peak. P.181

[V1.05]
Font Size

Select size of text displayed at the top of the peak. P.181

Show Baseline Switch between show and hide baseline. P.181

[V1.05]
Horizontal Axis

Switch the item to be displayed on the vertical axis from 
among [Migration Index], [Size], or [Migration Time].

P.182

[V1.05]
Overlay

Switches between [Ascending Order] and [Descending 
Order] for displaying overlays. 

P.182

Undo Zoom Undo the last zooming, enlargement, and pan operations on 
[Electropherogram].

P.182

Undo Zoom All Undo all zooming, enlargement, and pan operations on 
[Electropherogram].

P.182

Reanal-
ysis

Automatic Reanalyze all data by automatic operation. P.183

Manual Edit Mode Switch to the mode where addition or deletion of peaks or 
attribution of peaks are manually edited. 

P.184

Change Ladder 
and Analyze

Reanalyze with a different ladder data. P.189

Help Quick Start 
Manual

Display the Analysis Operation Flow (Operating Procedure 
P.2 to P.3).

F1 P.194

Instrument 
Manual

Display the Instruction Manual (Instrument and System)

Operation Manual Display the Instruction Manual (Operating Procedure).

About MultiNA 
Viewer

Display the version information of the program. P.194

Menu Item Outline of Function Shortcut 
Key

Reference 
Page
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3.1.2 Toolbar

3.1.3 Focused data and selected data

• “To focus” means to click specific data displayed in [Well Display], [Sample Name Tree], [Gel Image], or 
[Electropherogram (Multi)] and outline it with red lines. The outlined data is called “focused data.”

• “To select” means to select a check box of data displayed on [Gel Image] or [Electropherogram (Multi)]. Two 
or more data items can be selected. The data with a check mark is called “selected data.”

No. Explanation

1 [Open existing data file] button ([File] - [Open]):
Open an existing data file (*.MLT). 

2 [Print active data file] button ([File] - [Print]):
Display the [Print] dialog box and start printing.

3 [View Gel Image List] button:
Display the gel image list. There are three types of layouts available to display the gel image list, 12-well unit, 
8-well unit, or sort by chip position. The list is displayed in a layout previously displayed by selecting the [Gel 
Image List] on the [Gel Image] menu.

4 [Data file name] list box:
Display the name of the data file currently open. When multiple files are loaded, click the downward arrow on 
the right to select a data file to be displayed.

5 [Open active data file] button ([File] - [Close]):
Close the currently displayed data file.

1 2 3 4
5

Focused data

Selected data
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3.1.4 Well Display

• Samples analyses that completed normally are displayed in blue. If a 
“Warning” occurred during the analysis, the sample is displayed in 
yellow. If an “Error” or “Fatal” error occurred during the analysis, the 
sample is displayed in red.

• Click a colored well to focus on that sample. The data on the [Gel Image] 
and [Electropherogram (Multi)] is outlined in red. The applicable data is 
displayed for [Electropherogram (Single)].

3.1.5 Sample Name Tree

• Click the [Sample Name] tab to display the [Sample Name Tree].
• The original file name (one used to save the sample sheet) is displayed 

at the top of the tree. The name remains the same even if the file is 
saved with a different name.

• Analysis order (number), well, and sample name are displayed under 
the original file name.

• The well and sample name were entered on the sample sheet.
• Click a sample name to focus on that sample. The data on the [Gel 

Image] and [Electropherogram (Multi)] is outlined in red. The applicable 
data is displayed for [Electropherogram (Single)].

3.1.6 Gel Image

• When a regular data file is open, [Analyzed Data] ([Distance Image]) is displayed in gel image.
• Click a desired piece of [Gel Image] to focus on that sample. The corresponding [Electropherogram] is 

displayed below. 
• The upper tab of the [Gel Image] is gray for sample data and pale green for ladder data.
• For DNA analysis, [Gel Image] ([Analyzed Data]) is displayed so that the position of the lower marker (LM) 

and upper marker (UM) align. For RNA analysis, it is displayed so that the position of the lower marker (LM) 
and the end of electrophoretic data align.
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An example of selected check boxes on the [Gel Image] is displayed below.

No. Explanation

1 Click the check box. The respective data becomes “selected data.” 

2 Indicates a well name. More than one analysis can be performed from the extra sample stand and 
analysis order is displayed below the well name. 

3 The “#” mark and chip position (1 to 4) is displayed above the ladder data check box. 

4 Size axis. (It is based on the position of fragment peaks in the ladder data.)

5 Click the button to display the knob (6) and a red horizontal on [Gel Image]. 

6 Drag the knob up or down to move the red line.

7 Drag the knob up or down to adjust color contrast of [Gel Image]. While dragging the knob, the color 
contrast adjustment is applied only to the focused data. After adjustment, the color contrast is applied to 
all of the data displayed. 

5

4

6

3

7

1
2

6

1 2 3 4 5
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3@NOTE
• If the check mark is cleared from a selected data when [Show Selected] is selected, the respective data 

disappears from [Gel Image] because the data is no longer selected.

• If the check mark is cleared from all of the displayed data and [Show Selected] is selected, the display 
state automatically changes to [Show All].

Zooming of [Gel Image]

• Select an area by dragging the mouse and then releasing it. While dragging the mouse up or down on [Gel 
Image], red lines are displayed at the starting and ending points of the area to be enlarged.

• To return to the original display, select [Undo Zoom]/[Undo Zoom All] on the [Gel Image] menu or use the 
right click pop-up menu.

• When the display range on [Gel Image] is changed, the display range of the horizontal axis of 
[Electropherogram (Single)] is scaled to the same. (To return to the original display in [Electropherogram 
(Single)], select [Undo Zoom]/[Undo Zoom All] on the [Electropherogram] menu or right click pop-up menu 
on [Electropherogram (single)].)

Example of [Gel Image] Zooming in
 (Left: Before Zooming in, Center: While Specifying the Range, Right: After Zooming in)

No. Explanation

1 [Show All] is selected in the initial display. All data (with and without a check mark) is displayed. 

2 Select [Show Selected] to display only the data that is selected with a check mark. This button is enabled 
when at least one data item is selected with a check mark.

3 Click [Select All] to select all of the data in a data file with check marks. 

4 Click [Reverse] to switch between the selected and non selected data.

5 Click [Clear All] to remove the check marks from all of the samples.

6 A small color bar is displayed at the top of the gel image for the selected data. The color of the bar 
corresponds to the color in the [Electropherogram] overlay (see "3.1.9 Electropherogram (Single)" P.140). 
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[Electropherogram] Zoomed in
 (Top: Before Zooming in, Bottom: After Zooming in)

[Gel Image] Right Click Pop-up Menu

Menu Explanation Reference 
Page

Undo Zoom Undo the last zooming operation on [Gel Image]. P.180

Undo Zoom All Undo all zooming operations on [Gel Image] to recover the initial display 
state.

P.180

Copy Copy the image data displayed on [Gel Image] to the clipboard. (Or select 
[Copy] on the [Edit] pull-down menu and point to [Gel Image].)

P.162

[V1.05]
Save Image As

Save the image data displayed on [Gel Image] to a file. (Or select [Save 
Image As] on the [Edit] pull-down menu and point to [Gel Image].)

P.163

Add Focused Data to 
Comparison

Add focused data to the [Comparison] view. P.167

Add All Selected Data to 
Comparison

Add all selected data (ones with a check mark) to the [Comparison] view.

Delete Focused Data from 
Comparison

Delete focused data from the [Comparison] view.

Delete All Selected Data 
from Comparison

Delete all selected data (ones with a check mark) from the [Comparison] 
view.

Select Ladder Used for 
Analysis

Select and display ladder data used for analyzing the focused sample and 
the sample data.

P.172

Select All Samples 
Analyzed Using This 
Ladder

Select and display sample data analyzed using the focused ladder and 
the ladder

P.173

Sample Properties Display properties for acquiring data of each sample. P.160
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3.1.7 Peak Table
 

• The peak table of the focused sample is displayed.
• (LM) represents the lower marker peak and (UM) represents the upper 

marker peak.
• To customize Items displayed on the columns, select [Options] on the 

[View] pull-down menu (see "3.4.12 Options" P.174).
• Double-click a cell in the [Peak Table] or a peak to apply a “*” mark next 

to the peak no. and cause the corresponding peak top information on 
[Electropherogram] to be displayed in red.

• Double-click the peak with the “*” mark again to remove the mark and 
recover the original display.

[Peak Table] Right Click Pop-up Menu

3.1.8 RNA Report

• For RNA analysis data, the [RNA Report] tab is displayed. The following 
items are displayed.

Total RNA: [Total Area], [Total Conc.], [Ratio of 28S/18S rRNA]

mRNA: [Total Area], [Total Conc.]

• Although peaks of only 18S rRNA and 28S rRNA are displayed on 
[Electropherogram], the area and concentration of all RNA peaks are 
calculated.

Right Click Pop-up Menu in [RNA Report]

Menu Explanation Reference 
Page

Copy Selected Cells Copy the data selected in [Peak Table] to the clipboard. P.162

Set to Lower Marker Set the peak right-clicked in [Peak Table] as the lower marker when 
[Manual Edit Mode] is selected on the [Reanalysis] pull-down menu.

P.184

Set to Upper Marker Set the peak right-clicked in [Peak Table] as the upper marker when 
[Manual Edit Mode] is selected on the [Reanalysis] pull-down menu.

Set to 18S rRNA Set the peak right-clicked in [Peak Table] as 18S rRNA in the case of RNA 
sample (total RNA) when [Manual Edit Mode] is selected on the 
[Reanalysis] pull-down menu.

Set to 28S rRNA Set the peak right-clicked in [Peak Table] as 28S rRNA in the case of RNA 
sample (total RNA) when [Manual Edit Mode] is selected on the 
[Reanalysis] pull-down menu.

Delete Peak Delete the peak right-clicked in [Peak Table] when [Manual Edit Mode] is 
selected on the [Reanalysis] pull-down menu].

Menu Explanation Reference 
Page

Copy Selected Cells Copy the data selected in [Peak Table] to the clipboard. P.162
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3.1.9 Electropherogram (Single)

No. Explanation

1 [Rectangle Zoom] button:
[Rectangle Zoom] where this button is pressed mode appears in the default setting.
Drag the rectangular box in the graph to zoom in on the area surrounded by the box.
To return the display to its original state, select [Undo Zoom] or [Undo Zoom All] on the [Electropherogram] 
menu or right-click pop-up menu. 

2 [Horizontal/Vertical Zoom] button:
Click this button to start the [Horizontal/Vertical Zoom] mode.
Drag the mouse vertically or horizontally. The selected area is zoomed in or out in the respective direction 
according to the dragged distance. 
To return the display to its original state, select [Undo Zoom] or [Undo Zoom All] on the [Electropherogram] 
menu or right-click pop-up menu. 

3 [Pan] button:
Click this button to start the [Pan] mode.
Drag the mouse in a desired direction in the graph to move the displayed range in that direction.
To return the display to its original state, select [Undo Zoom] or [Undo Zoom All] on the [Electropherogram] 
menu or right-click pop-up menu. 

4 [Manual Edit Mode] button:
Click this button to switch ON/OFF of manual editing of analysis results.
(This operation is also available by selecting [Manual Edit Mode] on the [Reanalysis] menu.) (See "3.7.2 
Manual Edit Mode" P.184.)

5 [Overlay] button:
Clicking this button starts the [Overlay] mode, and selected data (data with a check mark) and focused data 
(data framed in red) on [Gel Image] are overlaid.
[V1.05]
[Ascending Order] / [Descending Order] display setting is specified by selecting the [Electropherogram] 
menu and pointing to [Overlay].

6
Next 
figure

[Slider]: (Displayed only when data is overlaid.)
Drag the slider to adjust the width to display overlaid data that is off vertically. 
Focused data is displayed on the bottom.

1
2
3

4

5
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• The horizontal axis of analyzed data indicates time index while the vertical axis indicates signal strength 
(with background being removed). 

• Raw data can be displayed by selecting [Raw data] on the [View] menu. In this case, the horizontal axis 
indicates migration time and the vertical axis indicates signal strength.

• The information displayed at the top of the peak can be selected from [Peak Top] on the [Electropherogram] 
menu.

• Point to [Electropherogram] and select [Show Baseline] to display the peak baseline and vertical parting line.
• Select [Show Baseline] from the [Electropherogram] menu to display the baseline and vertical peak parting 

line.
• Double-click a cell in the [Peak Table] or a peak to apply a “*” mark next to the peak no. and cause the 

corresponding peak top information on [Electropherogram] to be displayed in red.
• Double-click the peak with the “*” mark again to remove the mark and recover the original display.

6
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[Electropherogram] (Single) Right-click Pop-up Menu

3.1.10Electropherogram (Multi)

• Click the [Multi] tab to display multiple electropherograms.
• If the check box on the upper right of an electropherogram is selected, the data becomes “selected data.” (Or 

select the check box on [Gel Image].) 

Menu Explanation Reference 
Page

Undo Zoom Undo the previous zooming or pan operation on [Electropherogram]. P.182

Undo Zoom All Undo all zooming or pan operations on [Electropherogram] to recover the 
initial display state.

P.182

Copy Copy image data of [Electropherogram] to the clipboard. (Or on the [Edit] 
pull-down menu, select [Copy] and point to [Electropherogram].)

P.162

[V1.05]
Save Image As

Saves the image data displayed on [Electropherogram] to a file. (Or 
select [Save Image As] on the [Edit] pull-down menu and point to 
[Electropherogram])

P.163

Set to Lower Marker When there is a peak near the cursor where the mouse is right-clicked in 
the Manual Edit mode, the peak is set as the lower marker. When there is 
no peak near the cursor, a peak for the lower marker is added.

P.184

Set to Upper Marker When there is a peak near the cursor where the mouse is right-clicked in 
the Manual Edit mode, the peak is set as the upper marker. When there is 
no peak near the cursor, a peak for the upper marker is added.

Set to 18S rRNA When there is a peak near the cursor where the mouse is right-clicked in 
the Manual Edit mode, the peak is set as 18S rRNA. When there is no 
peak near the cursor, a peak for 18S rRNA is added.

Set to 28S rRNA When there is a peak near the cursor where the mouse is right-clicked in 
the Manual Edit mode, the peak is set as 28S rRNA. When there is no 
peak near the cursor, a peak for 28S rRNA is added.

Add Peak In the Manual Edit mode, the peak closest to the cursor where the mouse 
is right-clicked is detected and added. 

Delete Peak In the Manual Edit mode, peaks near the cursor are deleted when the 
mouse is right-clicked.
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3.2 File Menu

3.2.1 Open

1 Select [Open] on the [File] pull-down menu or click the  [Open existing data file] 
button at the left end of the toolbar.

• Data files are saved in a folder named with the project name used for analysis.
• When a data file (extension: .MLT) is selected, the content of the data file is displayed as preview 

(project name, separation buffer used, marker mix mode, data file comment, sample name tree, and 
gel image).



MultiNA Viewer Functions

144   MultiNA Instruction Manual

@NOTE
A data folder contains two files: a raw data file (extension: .MLT) and analyzed data file (extension: 
.MLA). When [Open] is selected on the [File] menu, only a raw data file (extension: .MLT) is 
displayed. When this file is opened, the analyzed data file is also loaded and automatically 
displayed. 

2 To open a data file, select a data file and click [Open] or double-click the file. 
• Two or more files can be loaded by repeatedly selecting [Open] on the [File] menu. Switch the file to be 

displayed on the File Name list box on the toolbar (see "3.1.2 Toolbar" P.134). 
• Data files can be opened by double-clicking them on “Windows Explorer” (single-clicking in some 

settings on Windows). They can also be opened by dragging and dropping to the [MultiNA Viewer] 
window from Explorer. 

@NOTE
If multiple iterations of the MultiNA Viewer are open, the following message is displayed when an 
attempt is made to open a data file that is already open in one of the other iterations. Click [OK] to 
open the file in read-only mode or click [Cancel] to stop opening the file.

• [OK]: Opens the file in read-only mode. Reanalysis (automatic, manual edit or ladder change) is 
disabled.

• [Cancel]: Stops the open file process.

@NOTE
If only raw data (no analyzed data) exists in the folder, the following message is displayed and only 
raw data is opened. This occurs when the analyzed data file has been deleted or moved to a 
different folder.

Select [Automatic] from the [Reanalysis] menu, and then select either [Fine], [Standard] or [Coarse] 
to re-analyze the data. An analyzed data file is created and displayed. [Fine], [Standard] and 
[Coarse] indicate the level of peak detection precision (see "3.7.1 Automatic" P.183).

@NOTE
The following message is displayed when there is no ladder data selected for analysis. 

In this case, select [Change Ladder and Analyze] on the [Reanalysis] menu and add ladder data 
(see "3.7.3 Change Ladder and Analyze" P.189).
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@NOTE
In the following cases, data files are opened in the read-only mode and “(Read only)” is displayed at 
the end of the file name on the window title and the file selection drop-down list box.

• When the specified file is currently being acquired in the MultiNA Control Software

• When [Comparison View] is displayed

@NOTE
The following message is displayed when a file, being analyzed by the instrument, is opened or 
updated by a PC with insufficient memory.

Click [OK] and close other applications or close the other files open in the MultiNA Viewer then 
repeat the operation.

If this memory error appears frequently, a PC memory upgrade is recommended.

3.2.2 Close
Select [Close] to close the file currently being displayed.

(Or click the  [Close] button under the toolbar.)

@NOTE
The following message is displayed when the results were not saved after editing using [Manual Edit Mode] 
on the [Reanalysis] menu or [Change Ladder and Analyze] on the [Reanalysis] menu.

Click [Yes] to save the results and close the file, [No] to close the file without saving the results, or [Cancel] to 
cancel the closing operation.

 

3.2.3 Save
Select [Save] to overwrite an analyzed data file that has been changed.

Analyzed data can be changed and saved in the following cases.
• Manually edit the file using [Manual Edit Mode] on the [Reanalysis] menu.
• Reanalyze the file using [Change Ladder and Analyze] on the [Reanalysis] menu.
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3.2.4 Save As
Select [Save As] to save a data file with a new name.

Raw and analyzed data are saved with different names at the same time.

1 Select [Save As] on the [File] pull-down menu. 
The [Save As] dialog box is displayed.

2 Enter a new file name in the [File name] box and click [Save]. 
The data file (raw and analyzed data) is saved with the new name. 
(/\<>:"|?* cannot be used for a file name.)

@NOTE
Although the data file is saved with the new name, the data file name given when the sample sheet 
was created is kept in the data file as “Original data file name.” “Original data file name” is displayed 
on the top 2 of [Sample Name Tree]. (1 is displayed by the new name.) 

1

2
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@NOTE
The following message is displayed if an attempt is made to save the file using a previously used file 
name.

Click [Yes] to overwrite the file and [No] to cancel the saving operation.

When [Yes] is clicked and the applicable file is open on MultiNA Viewer, the following message is 
displayed. In this case, the file cannot be saved with the specified name. Click [OK] and enter a 
different file name to save.

3.2.5 Saving Selected Data

[V1.05] 
Save only data indicated with a selected checkbox to a separate file. 

1 Select data (sample) to be saved in a different file with a check mark on a gel image (or 
an electropherogram (multi)).
Ladders used for sample analysis are automatically saved. Therefore, they do not need to be selected 
with a check mark.
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2 Select [Save Selected Data] on the [File] pull-down menu.
The [Save As] dialog box is displayed.

3 Enter a new file name, which is different from the original data file, in the [File name] box 
and click [Save].
By default, the new file name has "~" and numbers at the end of the original data file name.

4 The saved file is automatically loaded and displayed.
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3.2.6 Search
Select [Search] to search data files in a specified folder with specific screening conditions such as data file 
names, keywords, or date analysis started.

1 Select [Search] on the [File] pull-down menu. 
The [Search] dialog box is displayed.

2 Enter or select search conditions.
[Data file name]: Enter all or part of a data file name.
[A Word in the File]: Enter a keyword for searching in selected search fields.
[Project Name]: Select or enter a project name. 
[Date Analysis Started]: Select the date when analysis started.
[Folder]: Select or enter a target folder.

• “AND” is applied to each condition entered in search fields. 
• Only one target keyword can be used for searching. Select at least one search field from [Original data 

file], [Data file comment], [Sample name], and [Comment]. 
• To search by specifying a project name, select a project name from the combo box below [Project 

Name] or enter a project name (or part of it). Select <Any> when not specifying any name. 
• To specify [Date Analysis Started], select the range of date analysis started from the list in the combo 

box ([Today], [Within the last week], [Within the last 30 days], [Within the last 90 days]) or select 
[Custom] and then specify the start and end of the time range. 

• To search by specifying a folder, select the folder from the combo box or enter the folder name. Click 
<Browse…> from the list in the combo box. The [Select Folder] dialog box is displayed and a folder 
can be selected.

@NOTE
[Date Analysis Started] represents date and time where analysis of each data saved in MLT files 
started (see "3.4.3 Status Bar" P.165). It may be different from the time when the file was updated. 
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3 Click [Search] to start searching.
Click [Stop] to stop searching.

4 Extracted data files are displayed on the list to the right with information such as data 
file name and date analysis started. 
Click a file name to display the preview of gel image and sample names. 

5 Select a file and click [Open] or double-click the file name to load the data.

@NOTE
Only one data file can be selected or loaded at a time.

3.2.7 Export
Select [Export] to export sample sheet or peak table as a CSV format file.

[V1.05] 
This allows selecting all detailed items to be exported.

1 Select data to be exported by selecting the respective check box on [Gel Image] (or 
[Electropherogram (Multi)]). 
When exporting all data, data selection is unnecessary. 
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2 Select [Export] on the [File] pull-down menu. 
The [Export] dialog box is displayed.

3 Specify items, range, and delimination mark to be exported in the dialog box above.
Click the arrow facing downward on the right side of the items to display a drop-down list. Select 
necessary detailed items with a check mark.

@NOTE
If the horizontal axis of the analyzed data on [Electropherogram] represents migration index or size, 
the migration index data is exported. If the horizontal axis represents time, then time data is exported. 

 

Item Explanation
[Sample Sheet] Well name, sample name, comment, chip ID, date analysis started, etc.
[Peak Table] Peak table of sample data (size, concentration, height, time, area, etc.)
[RNA Report] Total area, total concentration, and 28S rRNA/18S rRNA ratio for RNA sample (total RNA 

analysis only)
[Analyzed Data] Migration index/time and signal strength at each data point in analyzed data
[Raw Data] Time and signal strength at each data point in raw data
[Current] Time and current on four electrodes of a microchip at each data point 
[Voltage] Time and voltage on four electrodes of a microchip at each data point 

Range Explanation
[All] All data in the data file
[Selected] Selected data with a check mark on [Gel Image] (or [Electropherogram (Multi)])

Delimination mark Explanation
[Comma] Data items are separated by commas.
[Tab] Data items are separated by tabs and enclosed by double quotation marks.
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4 Click [Export] to display the [Save As] dialog box.

5 Enter a file name and click [Save].

6 The display returns to the dialog box shown in step 2.
To continuously export another item, select the item and export it in the same procedure. 
Click [Close] to finish the exporting procedure.

3.2.8 Print
Select [Print] from the [File] menu to print data.

Check the following menu parameters to select the printed material.

Available print layouts are shown in the table below. Layout diagrams are shown assuming that printing is 
carried out vertically. The layout is changed when printing horizontally, 

Refer to "Printing Procedure" P.158.

Matters reflected in printing Settings in windows displayed Reference

• Both Gel Image and Electropherogram

Selection between [analyzed data]/[raw data] [View] - [Analyzed Data] / [Raw Data] P.166

Scale [View] - [Options] - [Scale of Default View] P.174

• Gel Image

Selection of inversion of black and white [Gel Image] - [Invert Black and White] P.176

Brightness adjustment Slider at the right of [Gel Image] P.135

Selection between time image/distance image [Gel Image] - [Time Image] / [Distance 
Image]

P.178

• Electropherogram (whole)

Show or hide baseline [Electropherogram] - [Show Baseline] P.181

• Electropherogram (single)

Show or hide marker signs [View] - [Marker] P.164

Peak top item [Electropherogram] - [Peak Top] P.181

•  Analysis result (excluding 12 samples/page layout)

Selection of items on the peak table [View] - [Options] - [Peak Table] P.139

• Overlaying selected data

Width to make overlaid data vertically off Slider during overlaying on 
[Electropherogram (Single)]

P.140
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Layout Category Printed Subjects Explanation

[120 Samples/Page] Sample sheets
(Data file properties, chip 
and ladder information)

A sample sheet containing up to 120 samples is printed on a 
page.

Gel Image
(Data file properties, chip 
and ladder information)

Gel images for up to 120 samples are printed on a page.

[24 Samples/Page] Sample sheet, gel image
(Data file properties, chip 
and ladder information)

A sample sheet and gel images for up to 24 samples are 
printed on a page. Ladder data is added to the left end of the 
gel image.
(Among the ladders displayed, the ladder used for the first 
analysis is printed.)
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[12 Samples/Page] Electropherogram, gel 
image
(Data file properties, chip 
and ladder information, 
sample sheet)

Electropherograms, gel images, and sample sheet for up to 12 
samples are printed on a page.
 

Analysis result, gel 
image
(Data file properties, chip 
and ladder information, 
sample sheet)

Analysis results, gel images, and sample sheet for up to 12 
samples are printed on a page.
Concerning analysis results, only the size of each peak is 
printed for DNA analysis. Only RNA report contents and 
concentration of each peak are printed for RNA analysis.
(For one analysis, up to 60 lines of data can be printed.)
 

[1 Sample/Page] Electropherogram, 
analysis result 
(Data file properties, chip 
and ladder information, 
sample sheet)

An electropherogram and analysis result for one sample are 
printed on a single page.
More than one page may be used if the analysis result display 
will not fit on a single page.
 

Layout Category Printed Subjects Explanation
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@NOTE
Imported ladder data is not printed except for “Chip and Ladder Information” (see "3.7.3 Change Ladder and 
Analyze" P.189).

@NOTE
For printing [Comparison View], “1 sample/page” layout cannot be used. Some displayed contents are 
different from ones of ordinary data files (see "3.4.7 Comparison" P.167).

Contents printed

Data File Properties

Properties such as data acquisition date and conditions set for the instrument are printed. 

[Overlay Selected Data] Electropherogram 
(sample sheet)

Electropherograms of selected data and focused data are 
printed overlaid. 

Other All analysis results 
(Data file properties, chip 
and ladder information)

Analysis results for all data to be printed are printed.
 

Layout Category Printed Subjects Explanation
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@NOTE
If a large number of characteristics are selected for each item, all of the information may not be printed. 
(Printable range differs according to the printing conditions such as paper size and margin.)

Chip and Ladder Information

Microchip ID, number of uses (analysis schedule starting point), no., well, and electropherogram for the 
ladder used is printed for each chip position.

Sample Sheet

The sample sheet is printed (no., well, sample name, comment, type, and microchip position).

A “#” mark is added on the left of the chip position number to indicate the ladder used for analysis.

@NOTE
If a large number of characteristics are selected for each item, all of the information may not be printed. 
(Printable range differs according to the printing conditions such as paper size and margin.)
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Gel Image

[Ladder] (the ladder used for the first analysis among ladder data displayed in Gel Image) is added to the 
left end of each gel Image. A size scale can be marked according to the band of this ladder.

Contrast is adjusted by the slider on the right end in the [Gel Image] window (see "3.1.6 Gel Image" P.135). 

There are three types of gel images; for analyzed data (distance image), for analyzed data (time image), 
and for raw data.

The following is an example of analyzed data (distance image). 

Electropherogram

Each electropherogram is printed with (number), well, and sample name. The vertical scale, set in 
[Options] on the [View] menu of the [Electropherogram] window is applied.

There are three types of electropherograms; analyzed data (migration index), analyzed data (migration 
time), and raw data.

The following is an example of analyzed data (migration index).

Results Table: DNA analysis

In the [12 samples/page] layout, (number), well, and predicted size of each peak are printed.

In the [1 sample/page and all results table] layout, (number), well, and items selected in [Options] on the 
[View] menu are printed.

Results Table: RNA analysis

In the [12 samples/page] layout, (number), well, concentration of each peak, and contents of RNA report 
(total area, total concentration, and the 28S rRNA/18S rRNA ratio for Total RNA) are printed.

In the [1 sample/page and all results table] layout, (number), well, and items selected on [Options] on the 
[View] menu are printed. 

Overlay Selected Data

On sample sheet, data file names, (numbers), wells, sample names, comments, types, and chip positions 
of overlaid data.
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Printing Procedure

1 Select the data to be printed.
This process is unnecessary when printing all data.

2 Select [Print] on the [File] pull-down menu or click the  [Print active data file] button 
on the toolbar.
The [Print] dialog box is displayed.

3  Select a layout for printing.
• Click a “+” mark displayed with printing layouts at the left to display items to be printed such as sample 

sheet and gel image under each printing layout category. 
• Select an item to be printed and the image of the respective layout is displayed in the right field of the 

dialog box. 
• Click [Page Setup] to set paper size, orientation, page margins, and other items.

4 Select the items to be printed.
The [Preview] and [Print] buttons are enabled. 

5 Select the data range to be printed.
Click [All] to print all of the data in the file or click [Selected] to print only the selected data.
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6 Click [Preview] to review the print image and determine the number of pages.

7 Click [Print] to start printing.

3.2.9 Print Setup
The [Print Setup] dialog box is displayed. Select a printer and set the printer properties such as paper size 
and orientation.
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3.2.10Data File Properties
Select [Data File Properties] to display the instrument conditions when a data file was acquired.

• Click [Copy All] to copy all of the displayed contents to the clipboard.
• Select cells, lines, or columns and then right-click and select [Copy Selected Cells] to copy the selected cells 

to the clipboard.

3.2.11Sample Properties
Select [Sample Properties] to display all of the information in the file such as the conditions when the data 
was acquired.

• Click [Copy All] to copy all of the displayed contents to the clipboard.
• Select cells, lines, or columns and then right-click and select [Copy Selected Cells] to copy the selected cells 

to the clipboard.

[V1.05] 
Sample names and comments can be edited using the following procedure. 
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1 On the [File] pull-down menu, click [Sample Properties]. Or click [Sample Properties] on 
the right click pop-up menu displayed on the gel image. 
The [Sample Properties] window is displayed.

2 Double-click the sample name or comment box to be edited. 
When the cursor appears, the content can be edited. 

3 When finished editing, click [OK] to close the window. 
Clicking [Cancel] aborts any editing changes made. 

4 On the [File] pull-down menu, select [Save] or [Save As] to save the file. 

@NOTE
The message below is displayed when an attempt is made to close a data file without saving the 
changes. 

• Click [Yes] to save the changes in the initial data file.

• Click [No] to cancel the changes.

• Click [Cancel] to stop the closing process.
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3.2.12Exit
Click [Exit] to quit MultiNA Viewer.

@NOTE
The following message is displayed when the results were not saved after editing using [Manual Edit Mode] 
on the [Reanalysis] menu or [Change Ladder and Analyze] on the [Reanalysis] menu. Click [Yes] to save the 
changes and close the MultiNA Viewer, [No] to close the MultiNA Viewer without saving the changes, or 
[Cancel] to cancel the exit operation. 

3.3 Edit Menu

3.3.1 Copy

Select either [Gel Image], [Electropherogram], [Peak Table], or [RNA Report] (RNA analysis only) from 
[Copy] on the [Edit] menu. The corresponding image and data is copied to the clipboard.

• [Gel image] / [Electropherogram]
Image data (except for the red focus outline) is copied. 

The same result can be achieved by selecting [Copy] on the right click pop-up menu on [Gel Image] or 
[Electropherogram]. 

[V1.05] 
If [Gel Image] is selected, each data number, well, sample name, and comment can be copied to the 
top of the gel image. Select the items to copy by clicking [View] and pointing to [Title] on the pull-
down menu.
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• [Peak table], [RNA report]
When [Copy] is selected on the [Edit] menu:

All cells including item names and line numbers are copied. 

When “Copy Selected Cells” is selected on the right click pop-up menu:

Only selected cells are copied. Item names and line numbers are not copied. 

@NOTE
The [Copy] function of [Gel Image] and [Electropherogram] is used for copying the window currently being 
displayed. Note that if a different window is displayed over the MultiNA Viewer window immediately after 
selecting the menu (within approx. one second), the content of the different window is copied. 

3.3.2 Saving Images to File

[V1.05] 
On the [Edit] pull-down menu, clicking [Save Image As] and pointing to [Gel Image] or [Electropherogram] 
saves the gel image or electropherogram currently displayed as an image file. 

The same result can be achieved by selecting [Save Image As] on the right click pop-up menu on [Gel 
Image] or [Electropherogram].

If [Gel Image] is selected, items selected by clicking [Title] on the [View] pull-down menu (number, well, 
sample name, and comments) are inserted at the top of the gel image. 

@NOTE
The [Save Image As] function of [Gel Image] and [Electropherogram] is used for copying the window 
currently being displayed. Note that if a different window is displayed over the MultiNA Viewer window 
immediately after selecting the menu (within approx. one second), the content of the different window is 
saved.

1 On the [Edit] pull-down menu, select [Save Image As], then click [Gel Image] or 
[Electropherogram]. 
Or click [Save Image As] on the right click pop-up menu displayed on [Gel Image] or [Electropherogram].

2 When the [Save As] window appears, select [TIFF], [Bitmap], or [JPEG] for the file type. 

3 Select [Save in], enter the file name, and click the [Save] button. 
File extensions are automatically added to file names. 
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3.4 View Menu

3.4.1 Refresh
Select [Refresh] to reload a data file and update it. Use this function to update data being analyzed.

@NOTE
The following message is displayed when a file, being analyzed by the instrument, is opened or updated by 
a PC with insufficient memory.

Click [OK] and close other applications or close the other files open in the MultiNA Viewer then repeat the 
operation.

If this memory error appears frequently, a PC memory upgrade is recommended.

3.4.2 Marker
Select [Marker] to switch between display/hide the marker on [Gel Image] or [Electropherogram (Single)]. 
When the [Marker] menu is selected with a check mark (default), the lower marker (magenta line and 
triangle 1) and the upper marker (blue line and triangle 2) are displayed as shown in the figure below. 

2

1

1 2
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3.4.3 Status Bar
Select [Status Bar] on the [View] menu to display or hide the status bar at the bottom of the window. The 
information displayed on the status bar pertains to the focused data and is described below.

3.4.4 Title

[V1.05] 

Items selected with checkmarks on this menu will be reflected in the following displayed or printed 
information. 

• Title displayed in upper right area on [Electropherogram (Single)]
• Tooltip displayed when the cursor rolls over the top (light green or gray) area of gel images 
• Information displayed in lower right area of respective overlaid electropherograms 
• Information inserted at top of gel images when they are copied or saved by clicking [Copy] or [Save Image 

As] 
• Title printed in upper right area of electropherograms by clicking [Sample] or [Page Print] 
• Information printed in lower right area of each image overlaid when printing overlays of selected data 

No. Explanation

1 Project name

2 Separation buffer (TotalRNA or mRNA distinction for RNA analysis)

3 (Analysis No.)Well name:

4 Sample name: Comment

5 Date analysis started

6 Chip position

7 Chip ID

8 Chip use count

9 Information from MultiNA Viewer (cursor position); values on vertical and horizontal axes on single 
electropherogram

1 2 3 4 5 6 7 8 9
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3.4.5 Analyzed Data/Raw Data
Analyzed data is displayed when a data file is opened. To display raw data, select [Raw Data] on the [View] 
pull-down menu.

To display analyzed data again, select [Analyzed Data] on the [View] pull-down menu.

The following contents are displayed in the raw data view.

3.4.6 Normal Sensitivity Data/Low Sensitivity Data
Select [Low Sensitivity Data] from the [View] menu to display low sensitivity raw data.

• Signal intensity of low sensitivity data is approximately half as compared to normal sensitivity data.
• If signal saturation occurs on normal sensitivity data due to high sample concentration (50 ng/µL min of DNA 

concentration), the sample may need to be diluted. Refer to the peak height obtained in low sensitivity data 
to decide how much the sample should be diluted.

• Reanalysis, print, or export is not available with low sensitivity data because it contains raw data only.
• To return the display to analyzed data, select [Normal Sensitivity Data] on the [View] menu, and select 

[Analyzed Data] on the [View] menu.

Window Contents Displayed
[Gel Image] Vertical axis: Migration time (sec)
[Electropherogram] Horizontal axis: Migration time (sec), Vertical axis: Signal strength before the removal of 

baseline (mV)
[Peak Table] Time (sec), height (mV), area (mV•sec) (Items to be displayed cannot be changed.)
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3.4.7 Comparison

Select [Comparison] to display data in different data files in one window. Only data obtained with the same 
type of separation buffer can be displayed.

• Well numbers and sample names of the samples that have been added to the [Comparison] view are 
displayed under the original data file names in the comparison sample name tree. A sequential number 
(displayed in parentheses) is added to each sample name on the view.

• Data displayed in the [Comparison] view is “read only.” The [Save], [Save As], and [Reanalysis] functions are 
not enabled.

@NOTE
Only data obtained with the same type of separation buffer can be compared. The following message is 
displayed if an attempt is made to add data obtained with a different type of separation buffer.

@NOTE
Up to 120 data can be added to the [Comparison] view. The following message is displayed if an attempt is 
made to add more than 120 data to the [Comparison] view.
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Add Data to Comparison
This section describes the addition of focused or selected data to the comparison view.

Add Focused Data to Comparison

1 Focus (Click) the data to be added to Comparison on Gel Image.

2 On the [View] pull-down menu, select [Comparison] and point to [Add Focused Data to 
Comparison].
Or select [Add Focused Data to Comparison] on the right click pop-up menu on Gel Image.

3 The data is added to the Comparison view.

Add All Selected Data to Comparison

1 Select the check box of the data to be added to Comparison on Gel Image.

2 On the [View] pull-down menu, select [Comparison] and point to [Add All Selected Data 
to Comparison].
Or select [Add All Selected Data to Comparison] on the right click pop-up menu on Gel Image.

3 The data is added to comparison view.

@NOTE
When the first data is added to the [Comparison] view, the window automatically changes to [Comparison]. 
However, the [Comparison] window is not automatically displayed when the next or following data is added. 

Add all data to be compared then select [Comparison] in the file name list box on the toolbar. 
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Delete Data From Comparison
This section describes procedures to delete focused or selected data from the [Comparison] view.

Delete Focused Data from Comparison

1 Focus (click) the data to be deleted on [Gel Image] at the [Comparison] view. 

2 On the [View] pull-down menu, select [Comparison] and point to [Delete Focused Data 
from Comparison].
Or select [Delete Focused Data from Comparison] on the right click pop-up menu on Gel Image.

3 The focused data is deleted from the Comparison view and the view is updated.

Delete All Selected Data from Comparison

1 Select the check box of the data to be deleted on Gel Image at the Comparison view.

2 On the [View] pull-down menu, select [Comparison] and point to [Delete All Selected 
Data from Comparison].
Or select [Delete All Selected Data from Comparison] on the right click pop-up menu on Gel Image.

3 The selected data is deleted from the [Comparison] view and the view is updated.
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Print

Data displayed on the Comparison view can be printed by selecting the [Print] menu. Refer to "3.2.8 Print" 
P.152. Some differences from printing ordinary data files are described below.

• The [1 Sample/Page] layout is not available.
• <Data file numbers> and the original data file names are printed in the [Data File Information] section.
• (Sequential data numbers), wells in the original data file, and <data file numbers> are printed in the [Sample 

Sheet] section. Sample names, comments, types, and positions of the chip used are also printed to the right.

• The (sequential data number), well, and <data file number> are printed for each data in the 
[Electropherogram] and [Gel Image] sections. The left end ladder on Gel Image is the first ladder displayed 
on the comparison view. The ladder is automatically added to the Gel Image.

• The (sequential data number), well, <data file number>, and sample name of each sample are printed in the 
left cell of the [Results Table]. 
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3.4.8 Size Calibration Curve
Select [Size Calibration Curve] to display a graph of the size calibration curve used in analysis of focused 
data (sample and ladder). 

• Size calibration curve is created for each chip position based on the ladder that was analyzed on that chip. 
For the ladder used for analysis, see "1.11.2 Data Examination and Reanalysis" P.73.

• When Raw Data is displayed, size calibration curve is not displayed.

• Click the  button on the upper right corner to close the window.

3.4.9 Analysis Performance Check Result
Select [Analysis Performance Check Result] to display the result of analysis performance check. 

•  Normally, when an analysis performance check data file is loaded, the result is automatically displayed as 
well. Select this menu to display the result window again after closing it.

• The result (LOG file) is saved in a [reagent kit name] folder in the project folder as plain text and can be 
opened on “Notepad” or an editor program. (The data is easier to view when it is displayed in single spaced 
font.) 

^ Reference
"2.5.6 Check Analysis Performance" P.120, check item: P.123
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3.4.10Select Ladder Used for Analysis
Select the [Select Ladder Used for Analysis] menu item from the [View] menu to display the ladder data 
used to analyze the focused sample data. 

1 Focus (click) the sample data on Gel Image.
 The upper area of the Gel Image is gray for sample data. 

2 Select [Select Ladder Used for Analysis] on the [View] pull-down menu.
Or select [Select Ladder Used for Analysis] on the Gel Image right click pop-up menu.

3 The check box of the focused sample and the corresponding ladder data is selected and 
only the “selected data” is displayed ([Show Selected]) on Gel Image.
To return to the original display, select [Show All].

Refer to "3.4.11 Select All Samples Analyzed Using This Ladder" P.173 to display all of the data that was 
analyzed using the selected ladder.

@NOTE
The following message is displayed if there is no ladder data associated with the focused sample 
data. 
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3.4.11Select All Samples Analyzed Using This Ladder
Select the [Select All Samples Analyzed Using This Ladder] menu item from the [View] menu to display all 
of the sample data that was analyzed using the focused ladder.

1 Focus (click) the ladder data on the Gel Image.
For ladders used for analysis, numbers #1 to #4 (numbers indicate chip positions) are displayed above 
the check box.

2 Select [Select All Samples Analyzed Using This Ladder] on the [View] pull-down menu.
Or select [Select All Samples Analyzed Using This Ladder] on the Gel Image right click pop-up menu.

3 Check boxes of the ladder and all the corresponding sample data are selected and only 
the “selected data” is displayed ([Show Selected]) on the Gel Image.
To return to the original display, select [Show All].
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3.4.12Options
Select [Options] from the [View] menu to change the following items. 

[Peak Table] Tab
Select the items to be displayed on the peak table. 

@NOTE
• For [Raw data] only time (sec), height (mV), and area (mV•sec) are displayed and these settings cannot 

be changed.

• For RNA analysis, there is only one marker, making accurate size prediction impossible. Size values for 
RNA analysis are not included in the instrument specifications.

Item Explanation

DNA 
(Display 
items for 
DNA data)

Size (bp) Specified size for ladder data. Size calculated using the size calibration curve for 
sample data

Concentration 
(ng/µL)

Concentration calculated using the fragment and marker peak areas.

Migration Index (%) Migration index based on marker detection time (Lower marker: 0%, Upper 
marker: 100%).

Height (mV) Peak height measured from baseline

Area (mV•µm) Peak area calculated by converting the migration time into the migration distance

Molarity (pmol/L) Mol concentration calculated from the concentration assuming that the average 
molecular mass is 333/1 mer 

RNA 
(Display 
items for 
RNA data)

Attribute Specified size for lower marker (LM), rRNA (18S, 28S), and ladder data
[V1.05]
Size for samples (reference value only.)

Concentration 
(ng/µL)

Concentration calculated using the fragment and marker peak area

Migration Index (%) Migration index based on marker detection time (Lower marker: 0%, End point of 
data: 100%)

Height (mV) Peak height measured from baseline

Area (mV•µm) Peak area calculated by converting the migration time into the migration distance

Peak start index (%) Migration index at the peak start point

Peak end index (%) Migration index at the peak end point
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[Scale of Default View] Tab

@NOTE
Scale changes are not immediately reflected when the [Electropherogram] is zoomed in. [Scale of Default 
View] changes are applied when the default display is recovered by selecting [Undo Zoom All]. 

The graph may be displayed over the display range even after [Undo Zoom All] has been selected if [Fixed 
scale] has been selected.

Item Explanation

Scale to each sample The maximum concentration displayed on Gel Image and the maximum vertical 
axis value on Electropherogram are displayed according to the maximum value 
of each data. 

Scale to all samples The maximum concentration displayed on Gel Image and the maximum vertical 
axis value on Electropherogram are displayed according to the maximum value 
of all data (except for import ladder) included in the data file. 

Fixed scale The maximum and minimum values both for contrast displayed on Gel Image and 
the vertical axis on Electropherogram are displayed according to the entered 
values. 
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3.5 Gel Image Menu

3.5.1 Invert Black and White
Select [Invert Black and White] from the [Gel Image] menu to change the background of the Gel Image 
display from white to black and back again.

• Select [Invert Black and White] on the [Gel Image] pull-down menu to invert black and white on Gel Image. 
• Brightness can be adjusted by dragging the slider at the right end up or down.
• To revert the black and white display, select [Invert Black and White] again. 
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3.5.2 Vertical Axis 

[V1.05] 
Select the display on the vertical axis of the analyzed data from among [Distance Image], [Size Image], or 
[Time Image]. 

• [Distance Image] is displayed by default when a data file is opened. 

• When [Distance Image] is selected, the value calculated by converting the migration time into the 
migration distance is displayed on the vertical axis. This gel image is similar to one obtained by Agarose 
gel electrophoresis.

• When [Size Image] is selected, the image displayed is obtained by correcting the distance image based 
on one reference ladder size. Same-size peaks are displayed in the same-position band. The reference 
ladder is the ladder used for the first analysis. 

@NOTE
For raw data or data without a ladder, or if there is data from a failed analysis, size cannot be 
calculated. Consequently, [Size Image] cannot be selected. If this occurs, reanalyze or manually edit 
the data, or click [Show Selected] on [Gel Image] to display only data that has been successfully 
analyzed. 

• When [Time Image] is selected, the vertical axis is displayed as migration index for analyzed data and 
migration time for raw data.

• For raw data, [Time Image] is always displayed and this menu is not selectable (see "3.4.5 Analyzed 
Data/Raw Data" P.166).

Fig.3-1 Distance Image (Left) and Size Image (Right)

Fig.3-2 Analyzed Data (Left) and Raw Data (Right) of Time Image
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3.5.3 Distance Image/Time Image
Select the [Distance Image] or [Time Image] item from the [Gel Image] menu to change vertical axis 
displayed on the Gel Image.

• By default, [Distance Image] is displayed when a data file is opened. 
• When [Distance Image] is selected, the value calculated by converting the migration time into the migration 

distance is displayed on the vertical axis. This gel image is similar to one obtained by Agarose gel 
electrophoresis.

• When [Time Image] is selected, the vertical axis is displayed as migration index for analyzed data and 
migration time for raw data.

• [Time Image] is always displayed for raw data, and selection between [Distance Image] and [Time Image] is 
not available (see "3.4.5 Analyzed Data/Raw Data" P.166).

[Distance Image] is selected in the upper example and [Time Image] in the lower example.

3.5.4 Gel Image List
On to the [Gel Image] pull-down menu, point to [Gel Image List], and select [12-well Unit], [8-well Unit], or 
[Sort by Chip Position]. The selected [Gel Image List] layout is displayed.

• Or click the  [View Gel Image List] button on the toolbar to display the gel image list. When the [Gel 
Image List] is open from the toolbar icon, it is displayed the last selected layout ([12-well Unit], [8-well Unit], 
and [Sort by Chip Position]).

• The other Gel Image display (black and white inversion, selection between distance image and time image) 
are applied as they were last set.

• Click the  button in the upper right corner to close the [Gel Image List] window. Or double-click on a data 
to close the [Gel Image List] window and focus the corresponding data on the Gel Image. 

• To copy an image data to the clipboard, select [Copy] on the [Gel Image List] right click pop-up menu. 
• To print an image data, select [Print] on the [Gel Image List] right click pop-up menu. (The paper margins 

previously specified in the [Page Setup] window are applied.)
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@NOTE
[Copy] and [Print] are functions are for the currently displayed window. If a different window is displayed over 
that window immediately (approx. one second) after selecting [Copy] or [Print], the content of the new 
window is copied or printed. 

12-well Unit

• Gel image list is displayed by a horizontal line on the sample stand (12 wells). The list is displayed in two 
separated portions; the left side (A to D) and the right side (E to H). 

• “L” displays the ladder used for the first analysis in the data file.
• The number above each data represents (sample number) (see "3.1.5 Sample Name Tree" P.135). 

8-well Unit

• Gel image list is displayed by a vertical column on the sample stand (8 wells). The list is displayed in two 
separate portions; the left side (1 to 6) and the right side (7 to 12). 

• “L” displays the ladder used for the first analysis in the data file.
• The number above each data represents (sample number) (see "3.1.5 Sample Name Tree" P.135). 
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Sort by Chip Position

• Gel image list is displayed in sideways (1 to 4) for each chip position.
• The numbers above each data represent (sample number) (see "3.1.5 Sample Name Tree" P.135) and well 

name. 

3.5.5 Undo Zoom
Select [Undo Zoom] to cancel the previous zooming operation on the Gel Image. The same operation is 
available using the Gel Image right click pop-up menu.

@NOTE
When the display range in Gel Image is changed, the display range of the horizontal axis of 
Electropherogram (Single) is rescaled to match. To return to the original display in Electropherogram 
(Single), select [Undo Zoom]/[Undo Zoom All] on the [Electropherogram] menu or Electropherogram (Single) 
right click pop-up menu.

3.5.6 Undo Zoom All
Select [Undo Zoom All] to cancel all previous zooming operations on the Gel Image. The same operation is 
available on the Gel Image right click pop-up menu.

@NOTE
When the display range in Gel Image is changed, the display range of the horizontal axis of 
Electropherogram (Single) is rescaled to match. To return to the original display in Electropherogram 
(Single), select [Undo Zoom]/[Undo Zoom All] on the [Electropherogram] menu or Electropherogram (Single) 
right click pop-up menu.
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3.6  Electropherogram Menu

3.6.1 Peak Top
Select [Peak Top] to choose the information that is displayed at the top of the Electropherogram (Single) 
peak.

3.6.2 Font Size 

[V1.05] 
Select [Large], [Medium], or [Small] as the font size for peak-top text and the title (displayed on the upper 
right) on [Electropherogram]. 

3.6.3 Show Baseline
Select this menu item to show peak baseline and auxiliary vertical line partitioning on the 
Electropherogram (Single). 

Select the menu again and eliminate the check mark and hide baseline and auxiliary line (left graph below). 

Item Explanation

Peak No. Peak number on the Peak Table

Migration Index / Migration Time Value on the horizontal axis of Electropherogram

Size Predicted size (DNA analysis only) When size prediction is not completed, (---) 
is displayed.

Attribute Peak attribute of LM (lower marker), UM (upper marker), or 18S rRNA/28S 
rRNA (RNA analysis only)
[V1.05]
Reference values for size

Height Peak height measured from baseline to the top of the peak

Area Peak area

None None
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3.6.4 Horizontal Axis 

[V1.05] 
Select the display on the horizontal axis of the analyzed data from among [Migration Index], [Size], or 
[Migration Time]. 

• When a normal data file is opened, [Migration Index] is displayed on the horizontal axis. 

• When [Migration Index] is selected, data in terms of relative index values based on marker detection 
times is displayed. 

DNA Analysis: Detection time for the lower marker and upper marker are set to 0% and 100%, 
respectively. 

RNA Analysis: Detection time for the lower marker and end point for the electropherogram are set to 
0% and 100%, respectively. 

• When [Size] is selected, the data displayed is obtained by correcting the migration index based on the 
reference ladder size. The reference ladder is the ladder used for the first analysis. 

@NOTE
For raw data or data without a ladder, or if there is data from a failed analysis, size cannot be 
calculated. Consequently, [Size] cannot be selected. If this occurs, reanalyze or manually edit the 
data, or click [Show Selected] to display only data that has been successfully analyzed. 

• When [Manual Edit Mode] is selected on the [Reanalysis] pull-down menu, the horizontal axis is 
automatically set to [Migration Time]. 

• When raw data is displayed (see "3.4.5 Analyzed Data/Raw Data" P.166), only migration time can be 
displayed on the horizontal axis and this menu disabled. 

3.6.5 Overlaying Images

[V1.05] 
When displaying overlaid data, select either [Ascending Order] or [Descending Order]. 

^ Reference
"3.1.9 Electropherogram (Single)" P.140

3.6.6 Undo Zoom
Select [Undo Zoom] to cancel the previous zoom or pan operation on the Electropherogram. 

The same operation is available on the Electropherogram right click pop-up menu.

@NOTE
Display range on Gel Image does not change in conjunction with the Electropherogram display range. 

3.6.7 Undo Zoom All
Select [Undo Zoom All] to cancel all of the previous zoom or pan operations on the Electropherogram. 

The same operation is available on the Electropherogram right click pop-up menu.)

@NOTE
Display range on Gel Image does not change in conjunction with the Electropherogram display range. 
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3.7 Reanalysis Menu

@NOTE
Reanalysis is disabled in the following “read only” modes.

• Data currently being analyzed by the instrument is loaded and opened.

• The same file is open in another MultiNA Viewer iteration.

• Comparison view (see "3.4.7 Comparison" P.167) is displayed on MultiNA Viewer.

Imported ladders (see "3.7.3 Change Ladder and Analyze" P.189) cannot be manually edited.

3.7.1 Automatic
On the [Reanalysis] pull-down menu, point to [Automatic] and select [Fine], [Standard], or [Coarse] to 
automatically reanalyze all of the data in the data file. 

[Fine], [Standard], and [Coarse] represent standards for peak detection.
• [Standard]: Regular detection for automatic analysis
• [Fine]: Select this detection level to detect smaller peaks that are not detected in [Standard] detection level.
• [Coarse]: Select this detection level to detect only the necessary peaks if excessive peaks are detected 

using the [Standard] detection level. 
The difference in peak detection levels is shown below.

Fig.3-3 [Coarse]

Fig.3-4 [Standard]

Fig.3-5 [Fine]
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@NOTE
Selecting [Automatic] on the [Reanalysis] menu deletes all previous editing results from the procedures 
described in "3.7.2 Manual Edit Mode" P.184. (The following message is displayed.)

3.7.2 Manual Edit Mode
Select [Manual Edit Mode] to add or delete peaks, change the markers, or change the peak detection 
points.

1 Select [Manual Edit Mode] on the [Reanalysis] pull-down menu. 
(Or click the  [Manual Edit Mode] button on the upper right side of Electropherogram (Single).)
The peak detection points are displayed as shown below. 

2 Edit peaks manually.
Enlarge a target peak by zooming or panning on the Electropherogram.

Peak start (light blue triangle)

Peak top (yellow green rectangle)

Peak end (blue triangle)
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[Set to Lower Marker] / [Set to Upper Marker]

Select [Set to Lower Marker] or [Set to Upper Marker] to set the target peak to the lower maker or upper 
marker. 

1 Place the cursor near the correct marker peak on the Electropherogram. 
(It does not have to be a detected peak.)

2 Select [Set to Lower Marker] or [Set to Upper Marker] on the right click pop-up menu.

3 The marker is set to the new peak and the Peak Table is automatically updated. 

[Set to 18S rRNA] / [Set to 28S rRNA]

Select [Set to 18S rRNA] or [Set to 29S rRNA] to change the 18S rRNA or 28S rRNA peaks in total RNA 
analyzed data. 

1 Place the cursor near the peak of the correct rRNA peak on the Electropherogram. 
(It does not have to be a detected peak.)

2 Select [Set to 18S rRNA] or [Set to 28S rRNA] on the right click pop-up menu.

3 18S rRNA or 28S rRNA is set to the new peak position and recalculation is automatically performed. 
As a result, Peak Table and RNA Report are updated as well.



MultiNA Viewer Functions

186   MultiNA Instruction Manual

[Add Peak]

Select [Add Peak] to add a peak that has not been detected.

1 Place the cursor near the peak to be added on the Electropherogram. 

2 Select [Add Peak] on the right click pop-up menu.

3 The peak is added and the [Peak Table] is automatically updated.

[Delete Peak]

Select [Delete Peak] to delete an unnecessary peak.

1 Place the cursor near the peak to be deleted on the Electropherogram. 
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2 Select [Delete Peak] on the right click pop-up menu.

3 The peak is deleted and the [Peak Table] is automatically updated.

Changing the Peak Detection Position

The position of the peak start, top, and end can be changed.

1 Place the cursor at the peak mark (peak start, top, or end). The cursor becomes a “+.”
2 Drag the cursor to a desired peak position. 
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3 Release the mouse button. The peak detection point is changed and recalculation is automatically 
performed and the Peak Table is updated.

@NOTE
In vertical partitioning, the end mark of a peak goes over the start mark of the next peak. The start 
mark and end mark can be separated or overlapped again by dragging the peak detection point 
mark. 

3 Select [Manual Edit Mode] on the [Reanalysis] pull-down menu again. 

(Or click the  [Manual Edit Mode] button on the right side of Electropherogram (Single).)
The following message is displayed. Click [Yes] to end “Manual Edit mode and register the changes. 

• [Yes]: Register the changes.
• [No]: Cancel the changes.
• [Cancel]: Return to the [Manual Edit Mode].

@NOTE
Even after clicking [Yes] and registering the changes, they are not saved in the data file yet. Perform 
the procedure described in step 4 below to save the changes. 

@NOTE
The message shown above is displayed again as other data in the same data file is focused upon 
and edited in the [Manual Edit Mode]. 

@NOTE
The message shown below is displayed when an error is detected in the changes and the changes 
cannot be registered. The message shows the content of the error and the procedure to solve the 
problem. To solve the problem, click [Cancel] and continue editing. 

To cancel the changes, click [OK]. 



 Operating Procedure   189

3.7  Reanalysis Menu

3

@NOTE
The message shown below is displayed after editing ladder data. Click [Yes] to reanalyze all of the 
samples analyzed using this ladder.

Click [No] to discard the changes and make no changes to the sample data.

Click [Cancel] to return to the [Manual Edit Mode].

4 Select [Save] or [Save As] from the [File] pull-down menu.
Save the changes in the data file to the initial data file or to one with another name.

@NOTE
The message below is displayed when an attempt is made to close a data file without saving the 
changes. 

• Click [Yes] to save the changes in the initial data file.

• Click [No] to cancel the changes.

• Click [Cancel] to stop the closing process.

3.7.3 Change Ladder and Analyze
Select [Change Ladder and Analyze] to reanalyze sample data using a different ladder.

When a ladder is inappropriate or does not exist in the data file, ladder data from a different file can be 
loaded and the samples reanalyzed. 

• The new ladder data is called an “imported ladder.”
• To display a ladder and samples analyzed using the ladder, see "3.4.10 Select Ladder Used for Analysis" or 

"3.4.11 Select All Samples Analyzed Using This Ladder". 

@NOTE
The accuracy of the results may not meet the specification when analysis is performed with an imported 
ladder.

@NOTE
The imported ladder must be obtained using the same separation buffer and microchip (same ID) as the 
sample data.
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@NOTE
When [Change Ladder and Analyze] is selected for saved or registered data that has been changed through 
manual editing, the manual editing changes are deleted. The message below is displayed when [Change 
Ladder and Analyze] is selected for manually edited data. Click [OK] to delete the changes and [Cancel] to 
stop the ladder change process.

When the Ladder Used for Analysis is Inappropriate
When the ladder is inappropriate in automatically analyzed data (ex., the ladder’s electropherogram does 
not show fragment peak), change the ladder as described below and perform reanalysis.

1 Focus (click) the target ladder on Gel Image.

2 Select [Change Ladder and Analyze] on the [Reanalysis] pull-down menu. 
The message below is displayed. The ladder and samples analyzed using the ladder are selected with a 
check mark. 
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3 Review the selected Gel Image and click [OK]. 
A folder is opened. This folder contains ladder data that was obtained under the same conditions as 
the ladder being replaced. The “Chip ID,” “Separation buffer,” “Marker mixing mode,” and “Chip 
position” match that of the ladder being replaced.

@NOTE
The hierarchic structure of ladder data folders is shown below.

Folders are created according to the conditions where ladders are obtained as shown below and 
ladders are sorted and saved respectively.

[Data folder]

  -[Ladder]

     -[Chip ID] (ex., ND058-2)

        -[Separation buffer] (DNA-500/DNA-1000/DNA-2500/RNA)

           -[Ladder type ID] (regularly, “Standard” only)

              -[Marker mixing mode] (Premix/On-chip)

                 -[Chip position] (ChipPosition1/ChipPosition2/ChipPosition3/ChipPosition4)
 

• Ladder data names reflect the time the ladder data analysis was started. They include year, date, hour, 
minute and second and end with “.ldr”. For example, ladder data that started analysis at 18:53:00 on 
June 7, 2006 is named “20060607_185300.ldr”.

Example) C:\MultiNA\Ladder\ND058-2\DNA-2500\Standard\Premix\ChipPosition4\20060607_185300.ldr 
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• The lower windows of the ladder data folder displays a preview of the Electropherogram and Peak 
Table of the selected ladder data.

• When no appropriate ladder exists in the open folder, select ladder data from a ladder data folder 
where at least the “Chip ID” and “Separation buffer” match. Ladder data can be selected even if the 
“Marker mixing mode” and “Chip position” differ from ladder data being replaced. 

@NOTE
The error messages shown below may be displayed if an attempt is made to select ladder data in 
which the “Separation buffer” or “Chip ID” differ from that of the target ladder data.

4 Select an appropriate ladder data file and click [Open].
Data is reanalyzed and the results are displayed.
• “Imported ladder” is displayed on the right end of [Gel Image]. An asterisk mark (*) is put above the 

check box of the imported ladder. The asterisk mark is followed by # and the “chip position.” 
• The well name of the ladder initially used for analysis is displayed under the check box. All of the 

indications for the imported ladder are in italics.

• Clicking [Show All] displays all of the data in the data folder. The ladder used for analysis before ladder 
change (“X1-4” in this example) does not have the “#” mark, showing that it was not used for analysis. 
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5 Go back to step 1 to change other ladder data.
To change the imported ladder to a different ladder data, focus (click) on the imported ladder.

6 Save the analysis results in the data file.
Select [Save] on the [File] pull-down menu to overwrite the data file, and select [Save As] to save the 
results in a data file with a different name. 

When No Ladder Data Exists in the Data File
When no ladder data exists in the data file because no ladder was analyzed or for other reasons, perform 
reanalysis using the procedures described below.

1 Focus (click) the Gel Image of the sample to be analyzed.

2 Select [Change Ladder and Analyze] on the [Reanalysis] pull-down menu. 
selected with a check mark. 

3 Review the selected Gel Image and click [OK]. 
The [Select Ladder Data] window is displayed. (Procedures to select ladder data are the same as the 
procedures described in “When the Ladder Used for Analysis Is Inappropriate” (P.190).)
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4 Select an appropriate ladder data and click [Open].
Data is reanalyzed and the results are displayed.
• “Imported ladder” is displayed on the right end of [Gel Image]. An asterisk mark (*) is put above the 

check box of the imported ladder. The asterisk mark is followed by # and “chip position”.
• The area below the check box is blank. All of the indications for the imported ladder are in italics.

5 Go back to step 1 to analyze another sample.
Focus (click) the imported ladder to change the imported ladder to different ladder data.

6 Save the analysis results in the data file.
Select [Save] on the [File] pull-down menu to overwrite the data file and select [Save As] to save the 
results in a data file with a different name. 

3.8 Help Menu

3.8.1 Manual
Select a menu listed below to display a PDF file for the respective manual. 

• [Quick Start Manual]: Analysis operation flow (Operating Procedure P.2 to P.3)
• [Instrument Manual]: Instrument and System
• [Operation Manual]: Operating Procedure

@NOTE
Adobe® Reader® distributed by Adobe Systems Co. or other PDF file viewing software (provided free) is 
required to view the PDF file. Adobe® Reader® (Ver. 4 or later) can be downloaded from the following 
website: 

http://www.adobe.com/products/acrobat/readstep2.html

3.8.2 About MultiNA Viewer
Select [About MultiNA Viewer] to display the version of the MultiNA Viewer data analysis software. 
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4Appendix

Sections 4.1 to 4.7 briefly explain the preparation of each reagent kit. For preparation details, see the 
sections of this instruction manual listed below.

"1.6 Preparation for Analysis with the DNA-500 Kit" P.32

"1.7 Preparation for Analysis with the DNA-1000 Kit" P.40

"1.8 Preparation for Analysis with the DNA-2500 Kit" P.48

"1.9 Preparation for Analysis with the RNA Kit" P.56
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4.1 Preparation of the DNA-500 Kit (Premix)

Requirements

@NOTE
Confirm the caution item on "1.6.1 Requirements" P.33.

[V1.05] 
When using an optional ladder, see "4.10 Using Optional Ladders" P.205.

Protocol (Necessary time: 5 to 10 min.)

Reagent DNA-500 separation buffer (stored at 4°C to 8°C)

DNA-500 marker solution (stored at -20°C)

SYBR® Gold storage solution (diluted to 1/100 with 1xTE buffer) 

DNA ladder (Size marker: 25 bp DNA ladder diluted to 1/50, Concentration 20 ng/µL)

Containers and 
utensils

Sample containers (200-µL tube, 96-well plate + aluminum seal) 

Micro pipette (10 µL, 100 µL, 1000 µL)

1 Add SYBR® Gold storage solution to DNA-500 
separation buffer and mix them with a vortex 
mixer.

 

• Add the separation buffer into the buffer bottle so that 
SYBR® Gold storage solution is diluted to 1/100. (Final 
concentration is 1/10,000.)
* For 24 analyses: 1,000 µL of buffer
* For 96 analyses: 3,000 µL of buffer

2 Mix DNA ladder and DNA-500 marker solution 
in the 200-µL sample tube to a 1:2 volume 
ratio, and set the sample tube on the extra 
sample stand.

• When four chips are used for analysis, the DNA ladder is 
analyzed four times, once per chip.

* Mix 5 µL of DNA ladder and 10 µL of DNA-500 marker. 
• Multiple analyses can be performed on the extra sample 

stand.

3 Mix the sample and DNA-500 marker solution 
in the 96-well plate in a 1:2 volume ratio, seal 
with the aluminum seal, and place the plate on 
the sample stand. 

• Mix 2 µL of the sample and 4 µL of DNA-500 marker for 
each well.

• On the sample stand, only one analysis is performed per 
well. 

• For up to 12 samples, mix 3 µL of the sample and 6 µL of 
DNA-500 marker. Aluminum seal is unnecessary.

4 Uncap the buffer bottle, place it in the blue 
reagent holder position and install the sample 
holder on the sample stand. 

1 Separtion Buffer

Extra Sample Stand

2 Ladder / Sample

Sample Stand

!
!

Do NOT cap the 
bottle. Cover the sample tube and 

sample plate with the sample 
holder.
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4.2 Preparation of the DNA-500 Kit (On-Chip mix)

Requirements

@NOTE
Confirm the caution item on "1.6.1 Requirements" P.33.

[V1.05] 
When using an optional ladder, see "4.10 Using Optional Ladders" P.205.

Protocol (Necessary time: 5 to 10 min.)

Reagent DNA-500 separation buffer (stored at 4°C to 8°C)

DNA-500 marker solution (stored at -20°C)

SYBR® Gold storage solution (diluted to 1/100 with 1xTE buffer) 

DNA ladder (Size marker: 25 bp DNA ladder diluted to 1/50, Concentration 20 ng/µL)

Containers and 
utensils

Sample containers (200-µL tube, 96-well plate + aluminum seal) 

Micro pipette (10 µL, 100 µL, 1000 µL)

1 Add SYBR® Gold storage solution to DNA-500 
separation buffer and mix them with a vortex 
mixer.

 

• Add the separation buffer into the buffer bottle so that 
SYBR® Gold storage solution is diluted to 1/100. (Final 
concentration is 1/10,000.)
* For 24 analyses: 1,000 µL of buffer
* For 96 analyses: 3,000 µL of buffer

2 Pour the DNA ladder into a sample tube and 
set it on the extra sample stand.

• When four chips are used for analysis, the DNA ladder is 
analyzed four times, once per chip.

* For 4 analyses: 11 µL of DNA ladder
• Multiple analyses can be performed on the extra sample 

stand.
3 Pour the DNA-500 marker solution into a vial 

and place it in the blue reagent holder position.
• Necessary amount: 2 x (the number of analyses) + 40 µL

4 Put the sample into a 96-well plate, seal with 
the aluminum seal, and place it on the sample 
stand.

• On the sample stand, only one analysis is performed per 
well. 

• For up to 12 samples, put 9 µL of the sample in the tube. 
Aluminum seal is unnecessary.

5 Uncap the buffer bottle, place it in the blue 
reagent holder position and install the sample 
holder on the sample stand. 

1 Separation Buffer

Extra Sample Stand

3 Ladder / Sample

Sample Stand

!
!

2 Marker Solution

Do NOT cap the 
bottle. Cover the sample tube and 

sample plate with the sample 
holder.
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4.3 Preparation of the DNA-1000 Kit (Premix)

Requirements

@NOTE
Confirm the caution item on "1.7.1 Requirements" P.41.

[V1.05] 
When using an optional ladder, see "4.10 Using Optional Ladders" P.205.

Protocol (Necessary time: 5 to 10 min.)

Reagent DNA-1000 separation buffer (stored at 4°C to 8°C)

DNA-1000 marker solution (stored at -20°C)

SYBR® Gold storage solution (diluted to 1/100 with 1xTE buffer) 

DNA ladder (Size marker: φX174 DNA/Hae III Markers diluted to 1/100, Concentration: 
10 ng/µL)

Containers and 
utensils

Sample containers (200-µL tube, 96-well plate + aluminum seal) 

Micro pipette (10 µL, 100 µL, 1000 µL)

1 Add SYBR® Gold storage solution to DNA-
1000 separation buffer and mix them with a 
vortex mixer.

 

• Add the separation buffer into the buffer bottle so that 
SYBR® Gold storage solution is diluted to 1/100. (Final 
concentration is 1/10,000.)
* For 24 analyses: 1,000 µL of buffer
* For 96 analyses: 3,000 µL of buffer

2 Mix DNA ladder and DNA-1000 marker 
solution in the 200-µL sample tube to a 1:2 
volume ratio, and set the sample tube on the 
extra sample stand.

• When four chips are used for analysis, the DNA ladder is 
analyzed four times, once per chip.

* Mix 5 µL of DNA ladder and 10 µL of DNA-1000 
marker. 
• Multiple analyses can be performed on the extra sample 

stand.

3 Mix the sample and DNA-1000 marker 
solution in the 96-well plate to a 1:2 volume 
ratio, seal with the aluminum seal, and place 
the plate on the sample stand. 

• Mix 2 µL of the sample and 4 µL of DNA-1000 marker for 
each well.

• On the sample stand, only one analysis is performed per 
well. 

• For up to 12 samples, mix 3 µL of the sample and 6 µL of 
DNA-1000 marker. Aluminum seal is unnecessary.

4 Uncap the buffer bottle, place it in the green 
reagent holder position, and install the sample 
holder on the sample stand. 

1 Separation Buffer

Extra Sample Stand

2 Ladder / Sample

Sample Stand

!
!

Do NOT cap the 
bottle. Cover the sample tube and 

sample plate with the sample 
holder.
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4.4  Preparation of the DNA-1000 Kit (On-Chip mix)

4

4.4 Preparation of the DNA-1000 Kit (On-Chip mix)

Requirements

@NOTE
Confirm the caution item on "1.7.1 Requirements" P.41.

[V1.05] 
When using an optional ladder, see "4.10 Using Optional Ladders" P.205.

Protocol (Necessary time: 5 to 10 min.)

Reagent DNA-1000 separation buffer (stored at 4°C to 8°C)

DNA-1000 marker solution (stored at -20°C)

SYBR® Gold storage solution (diluted to 1/100 with 1xTE buffer) 

DNA ladder (Size marker: φX174 DNA/Hae III Markers diluted to 1/100, Concentration: 
10 ng/µL)

Containers and 
utensils

Sample containers (200-µL tube, 96-well plate + aluminum seal) 

Micro pipette (10 µL, 100 µL, 1000 µL)

1 Add SYBR® Gold storage solution to DNA-1000 
separation buffer and mix them with a vortex 
mixer.

 

• Add the separation buffer into the buffer bottle so that 
SYBR® Gold storage solution is diluted to 1/100. (Final 
concentration is 1/10,000.)
* For 24 analyses: 1,000 µL of buffer
* For 96 analyses: 3,000 µL of buffer

2 Pour the DNA ladder into a sample tube and set 
it on the extra sample stand.

• When four chips are used for analysis, the DNA ladder is 
analyzed four times, once per chip.

* For 4 analyses: 11 µL of DNA ladder
• Multiple analyses can be performed on the extra sample 

stand.
3 Pour the DNA-1000 marker solution into a vial 

and place it in the green reagent holder position.
• Necessary amount: 2 x (the number of analyses) + 40 µL

4 Put the sample into a 96-well plate, seal with the 
aluminum seal, and place it on the sample 
stand.

• On the sample stand, only one analysis is performed per 
well. 

• For up to 12 samples, put 9 µL of the sample in the tube. 
Aluminum seal is unnecessary.

5 Uncap the buffer bottle, place it in the green 
reagent holder position, and install the sample 
holder on the sample stand. 

1 Separation Buffer

Extra Sample Stand

3 Ladder / Sample

Sample Stand

!
!

2 Marker Solution

Do NOT cap the 
bottle. Cover the sample tube and 

sample plate with the sample 
holder.
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4.5 Preparation of the DNA-2500 Kit (Premix)

Requirements

@NOTE
Confirm the caution item on "1.8.1 Requirements" P.49.

Protocol (Necessary time: 5 to 10 min.)

Reagent DNA-2500 separation buffer (stored at 4°C to 8°C)

DNA-2500 marker solution (stored at -20°C)

SYBR® Gold storage solution (diluted to 1/100 with 1xTE buffer) 

DNA ladder (Size marker: pGEM® DNA Markers diluted to 1/100, Concentration: 10 ng/µL)

Containers and 
utensils

Sample containers (200-µL tube, 96-well plate + aluminum seal) 

Micro pipette (10 µL, 100 µL, 1000 µL)

1 Add SYBR® Gold storage solution to DNA-
2500 separation buffer and mix them with a 
vortex mixer.

 

• Add the separation buffer into the buffer bottle so that 
SYBR® Gold storage solution is diluted to 1/100. (Final 
concentration is 1/10,000.)
* For 24 analyses: 1,000 µL of buffer
* For 96 analyses: 3,000 µL of buffer

2 Mix DNA ladder and DNA-2500 marker 
solution in the 200-µL sample tube to a 1:2 
volume ratio, and set the sample tube on the 
extra sample stand.

• When four chips are used for analysis, the DNA ladder is 
analyzed four times, once per chip.

* Mix 5 µL of DNA ladder and 10 µL of DNA-2500 
marker. 
• Multiple analyses can be performed on the extra sample 

stand.

3 Mix the sample and DNA-2500 marker 
solution in the 96-well plate to a 1:2 volume 
ratio, seal with the aluminum seal, and place 
the plate on the sample stand. 

• Mix 2 µL of the sample and 4 µL of DNA-2500 marker for 
each well.

• On the sample stand, only one analysis is performed per 
well. 

• For up to 12 samples, mix 3 µL of the sample and 6 µL of 
DNA-2500 marker. Aluminum seal is unnecessary.

4 Uncap the buffer bottle, place it in the purple 
reagent holder position, and install the sample 
holder on the sample stand. 

1 Separation Buffer

Extra Sample Stand

2 Ladder / Sample

Sample Stand

!
!

Do NOT cap the 
bottle. Cover the sample tube and 

sample plate with the sample 
holder.
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4.6  Preparation of the DNA-2500 Kit (On-Chip mix)
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4.6 Preparation of the DNA-2500 Kit (On-Chip mix)

Requirements

@NOTE
Confirm the caution item on "1.8.1 Requirements" P.49.

Protocol (Necessary time: 5 to 10 min.)

Reagent DNA-2500 separation buffer (stored at 4°C to 8°C)

DNA-2500 marker solution (stored at -20°C)

SYBR® Gold storage solution (diluted to 1/100 with 1xTE buffer) 

DNA ladder (Size marker: pGEM® DNA Markers diluted to 1/100, Concentration: 10 ng/µL)

Containers and 
utensils

Sample containers (200-µL tube, 96-well plate + aluminum seal) 

Micro pipette (10 µL, 100 µL, 1000 µL)

1 Add SYBR® Gold storage solution to DNA-
2500 separation buffer and mix them with a 
vortex mixer.

 

• Add the separation buffer into the buffer bottle so that 
SYBR® Gold storage solution is diluted to 1/100. (Final 
concentration is 1/10,000.)
* For 24 analyses: 1,000 µL of buffer
* For 96 analyses: 3,000 µL of buffer

2 Pour the DNA ladder into a sample tube and 
set it on the extra sample stand.

• When four chips are used for analysis, the DNA ladder is 
analyzed four times, once per chip.

* For 4 analyses: 11 µL of DNA ladder 
• Multiple analyses can be performed on the extra sample 

stand.
3 Pour the DNA-2500 marker solution into a vial 

and place it in the purple reagent holder 
position.

• Necessary amount: 2 x (the number of analyses) + 40 µL

4 Put the sample into a 96-well plate, seal with 
the aluminum seal, and place it on the sample 
stand.

• On the sample stand, only one analysis is performed per 
well. 

• For up to 12 samples, put 9 µL of the sample in the tube. 
Aluminum seal is unnecessary.

5 Uncap the buffer bottle, place it in the purple 
reagent holder position, and install the sample 
holder on the sample stand. 

1 Separation Buffer

Extra Sample Stand

3 Ladder / Sample

Sample Stand

!
!

2 Marker Solution

Do NOT cap the 
bottle. Cover the sample tube and 

sample plate with the sample 
holder.
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4.7 Preparation of the RNA Kit

Requirements

@NOTE
Confirm the caution item on "1.9.1 Requirements" P.57.

Protocol (Necessary time: 5 to 10 min.)

Reagent RNA separation buffer (stored at 4°C to 8°C)

RNA marker solution (stored at -20°C)

SYBR® Green II storage solution (diluted to 1/100 with 1xTE buffer) 

RNA ladder (RNA6000 ladder diluted to 1/6, concentration: 25 ng/µL)

Formamide

THE RNA Storage Solution (Applied Biosystems)

Containers and 
utensils

Sample containers (200-µL tube, 96-well plate + aluminum seal) 

Micro pipette (10 µL, 100 µL, 1000 µL)

1 Add SYBR® Green II storage solution and 
formamide to RNA separation buffer and mix 
them with a vortex mixer.

 

•  For 22 analyses, put 790 µL of separation buffer, 10 µL 
of SYBR® Green II storage solution, and 200 µL of 
formamide in the buffer bottle. 

2 Mix the RNA ladder and RNA marker solution in 
the 200-µL sample tube to a 1:1 volume ratio.

• When four chips are used for analysis, the RNA ladder is 
analyzed four times, once per chip.

* Mix 7.5 µL of RNA ladder and 7.5 µL of RNA marker. 
• Multiple analyses can be performed on the extra sample 

stand.
3 Mix the sample and RNA marker solution them 

in the 96-well plate to a 1:1 volume ratio, and 
seal with the aluminum seal.

• Blank (THE RNA Storage Solution) is analyzed first 
(before the ladder) per microchip.

• Mix 3 µL of the sample and 3 µL of RNA marker for each 
well.

• On the sample stand, only one analysis is performed per 
well. 

4 Heat-denature the RNA ladder and sample. • Cap the sample tube.
• Temperature condition: 65°C for 5 min. -> 4°C for 5 min. 

5 Uncap the buffer bottle and place it in the pink 
reagent holder position. Do NOT cap the 
sample tube. Install the sample holder on the 
sample stand.

1 Separation Buffer

Extra Sample Stand

2 Ladder / Sample

Sample Stand

!
!

Do NOT cap the 
bottle. Cover the sample tube and 

sample plate with the sample 
holder.
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4.8  Using a Chip for RNA Analysis after Using It for DNA Analysis

4

4.8 Using a Chip for RNA Analysis after Using It for DNA 
Analysis 

• Since different dyes are used for DNA analysis and RNA analysis, performing RNA analysis immediately 
after performing DNA analysis using the same microchip may negatively influence analysis results.

• Rinse the microchip using the procedure below before using it for a different type of analysis.

1 Install the microchip in the instrument.

^ Reference
"1.5.4 Microchip Registration" P.13

"1.5.5 Microchip Installation" P.16

2 From the MultiNA Instrument Control [Instrument] pull-down menu, point to [Wash], and 
select the target chip.

^ Reference
"2.5.8 Wash" P.126

3 Prepare the RNA separation buffer (for three analyses per chip).
Do not add diluted dye solution. Add formaldehyde only.

^ Reference
"1.9.5 Separation Buffer Preparation" P.60

4 Prepare a sample by mixing the same amounts of THE RNA storage solution and marker 
solution (for three analyses per chip). 

^ Reference
"1.9.6 Ladder, Sample and Marker Solution Usage" P.62

5 Perform analysis three times on the target chip.

^ Reference
"1.10 Analysis" P.64
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4.9 Using a Chip for DNA Analysis after Using It for RNA 
Analysis 

• Since different dyes are used for DNA analysis and RNA analysis, performing DNA analysis immediately 
after performing RNA analysis using the same microchip may negatively influence analysis results.

• Rinse the microchip using the procedure below before using it for a different type of analysis.
• The following procedure describes rinsing of the microchips in the premix mode using DNA separation 

buffer. Rinsing can also be performed in the on-chip mixing mode.

1 Install the microchip in the instrument.

^ Reference
"1.5.4 Microchip Registration" P.13

"1.5.5 Microchip Installation" P.16

2 From the MultiNA Instrument Control [Instrument] pull-down menu, point to [Wash], and 
select the target chip.

^ Reference
"2.5.8 Wash" P.126

3 Prepare the DNA separation buffer (for three analyses per chip).
Separation buffer can be selected from among DNA-500, DNA-1000, and DNA-2500. Add a diluted dye 
solution and mix.

^ Reference
DNA-500: "1.6.5 Separation Buffer Preparation" P.36

DNA-1000: "1.7.5 Separation Buffer Preparation" P.44

DNA-2500: "1.8.5 Separation Buffer Preparation" P.52

4 To prepare a sample, add the marker solution and TE buffer (1:2 volume ration) and mix 
(for three analyses per chip). 

^ Reference
DNA-500: "1.6.6 Ladder, Sample and Marker Solution Usage" P.38

DNA-1000: "1.7.6 Ladder, Sample, and Marker Solution Usage" P.46

DNA-2500: "1.8.6 Ladder, Sample and Marker Solution Usage" P.54

5 Perform analysis three times on the target chip in the premix mode.

^ Reference
"1.10 Analysis" P.64
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4.10  Using Optional Ladders

4

4.10 Using Optional Ladders
Optional ladders are available for use with DNA-500, and DNA-1000 kits. The optional ladders and dilution 
conditions that can be used with respective kits are indicated below. 

Type and Dilution Conditions for Optional Ladders 

The Ladder Type ID is used by the software to differentiate between ladder types. The ID for standard 
ladders is "Standard (STD)".

@NOTE
If an optional ladder is used, analytical performance (size accuracy, etc.) may be different than what is 
indicated in the MCE-202 MultiNA Analysis Performance Specifications (using a standard ladder, 
see -Instrument and System- "8 Specifications").

The following describes how to prepare optional ladder solutions. 

Requirements 
• Optional ladder to be used (see the "Type and Dilution Conditions for Optional Ladders" table above) 
• TE buffer
• Microtube (volumes from 200 µL to 1.5 mL) 
• Micro pipettes
• Vortex Mixer 

Procedures 

1 Use a micropipette to dispense TE buffer in the microtube. 
For 1/100 dilutions, dispense 99 µL in the tube, for 1/50 dilutions, dispense 49 µL, and for 1/20 dilutions, 
dispense 19 µL. (Confirm dilution conditions in the "Type and Dilution Conditions for Optional Ladders" 
table above.) 

2 Add 1 µL of optional ladder to the microtube and agitate the solution with a vortex mixer 
for at least 10 seconds. 

Applicable Kit Ladder Type ID 
(abbreviated name) Supplier Name Catalog No. Dilution

DNA-500 Ladder1 (LD1) Applied Biosystems pUC19Hpa II UDigest AM7770 1/50 dilution

DNA-1000 Ladder1 (LD1) Takara Bio 100bp DNA Ladder 3407A 1/10 dilution
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